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Chapter 1

Introduction to CombiStats

1.1 The software

CombiStats is a calculation program for the statistical analysis of data from
biological dilution assays. It includes parallel line analysis, slope ratio anal-
ysis, probit analysis, ED50 determination, 4- and 5-parameter logistic curve
fitting, limit testing of single dose assays and combination of assays. This
chapter provides a brief introduction to the software. More detailed infor-
mation can be found in chapters 2 to 8. A large set of examples is given
in appendix A. It is recommended to study these examples because they
show most of the features available in the program. A tutorial is provided
in appendix B. Before reading this manual, it is strongly recommended to
get acquainted with the software by performing the exercises in the tutorial.

1.2 About the name

During the beta testing phase of CombiStats version 1.0, the software had
been given the temporary working title OMCL BioStat. It appeared that the
name BioStat was already in use by at least two other existing programs, so
it was decided to rename the software. Additionally, the prefix OMCL was
considered restrictive, since it could not be excluded that the software would
also be made available outside the network of European Official Medicines
Control Laboratories. The name CombiStats contains the letters OM as
a reminder that it was initiated by the OMCLs, and the letters Bl as a
reference to the fact that it is intended for biological assays. The first part
‘Combi’ indicates that the software combines several types of analysis in
one consistent interface and also that it offers the possibility to combine the
results of several assays. The second part ‘Stats’ is self explanatory.

The concept for the CombiStats logo (2z%%) was to express somehow
parallel lines or sigmoid curves in a legible representation of its name. The
name is slanted to the right, so the two t’s give an impression of two parallel

7
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Pl Combistats EI@

File Edit Tools Options Window 7

DhzEs oemhee BELs MEM ¢ ?@

Figure 1.1: The menu bar and the toolbar

lines. The two s’s are extended to the left and the right to give an impression
of 2 sigmoid curves (admittedly, they don’t have equal ‘upper asymptotes’).
The colour blue is the same shade of blue as the background of the European
flag to express its relation with the European Pharmacopoeia.

1.3 Running CombiStats

Once the software is installed on your computer, you can run it from the
Start menu of Windows. If you have created a shortcut on your desktop,
you can click on the icon ¥ depicting the European stars with two parallel
lines. An empty window will appear with on top the menus and the toolbar.
You can either create a new template, open an existing template or open
an existing data sheet. Although most operations can be performed from
the keyboard, the software has primarily been designed to be used with a
mouse.

1.4 The interface

The menu bar and the toolbar look as shown in figure 1.1. Most menu
options can be accessed more quickly by using the icons on the toolbar. The
meaning of each of the icons is as follows:

. D Create a new template. You have to specify all definitions.

m

o [BH Open the library of templates. Templates contain all definitions
necessary for a particular type of assay.

al
. Ii' Open a data sheet. Data sheets contain all data of a particular
assay.

. ﬁ Save data sheet. You can save a completed data sheet (*.epa) or
an empty template with definitions (*.epm).

. Print data sheet. Use FilerPrint all from the menu to print all
open data sheets.
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! Undo last action. Use this when you have made a mistake and
want to revert to the previous situation.

Redo last action. Use this to revert the effect of the undo actions.

I% Copy selection. Use this to copy a group of cells, so as to avoid
retyping the same information.

Bl Copy all. Use this to copy the complete contents of a data sheet
to the clipboard.

% Paste clipboard. The contents of the clipboard are pasted into
the selected cells.

Tl
. Protect data sheet. You can specify 4 different levels of protec-
tion with passwords.

Options wizard. Use the options wizard to modify the definitions
of a template or data sheet.

l Calculate. Click on this button to perform the calculations.

Vi

=== Show full page graph. Click on this button to view a full page
representation of the graph.

-

L
Combine assays. Click on this button to combine results from

independent assays.

m Data sheets are shown in cascade, i.e. one in front of another.

Data sheets are shown in horizontal tiles.

Data sheets are shown in vertical tiles.

Q Examples. Gives direct access to the folder with example data
sheets.
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e @ Access the user manual.

° . Click on this button to access the official CombiStats internet
site.

1.5 Creating a template

For routine assays you will probably like to create an empty standard data
sheet (template) in which all options are predefined, and in which you only
have to enter the observed data. You can do this by clicking on the leftmost
button [ depicting an empty data sheet. The options wizard dialogue box
appears in which you can distinguish eight groups of options. You can walk
through the groups by clicking on the NEXT button. Click on OK to confirm
your choices after having selected an option in each of the groups. Otherwise
click on CANCEL. You can also click on PREVIOUS to go back a group or
on the tab strips to go directly to a specific group. It is recommended to
use the NEXT button rather than the tab strips, because the selection of
some options may modify the options in next groups, but never in previous
groups. Refer to chapter 2 for more detailed information on the selection
of options. When you have clicked on the OK button, an empty data sheet
will be created. You can still modify the options by clicking on the Options
wizard button & depicting a magic wand in front of a data sheet. You can
also enter the fields which you know to be always the same in routine, such
as the assigned potency of the standard, the name of the substance, or the
doses. When you have finished, you can save the template by clicking on
the SAVE button B depicting a disk. Select the directory where you want to
store it and select Template (*.epm) as the type of file. Choose an instructive
name for your template and save it by clicking on the OK button. You may
also add this template to a library of templates for easy access.

1.6 Entering assay data

If you want to enter assay data you can either open an existing template
or use the options wizard to create an ad hoc data sheet. The first table
contains assay related information, for example the date of assay, the name
of the operator, the assay method. This information is automatically re-
peated on each page. The information in this table is not necessary for the
calculations, but is intended to identify the assay and to provide additional
information. The tables that follow contain sample related information, for
example the batch number, the expiry date, the assumed or assigned po-
tency and of course the observed data. In case you have enabled the option
to show the design, the data are also presented in the layout of the design.
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Finally, you can add any remarks in the text box at the top of the first page.
You can save the data by clicking on the SAVE button & depicting a disk.
Select the directory where you want to store it and select Assay (*.epa) as
the type of file. Choose an instructive name for your assay and save it by
clicking on the OK button. Refer to chapter 3 for more detailed information
on entering the data.

1.7 The calculations

You can start the calculations by clicking on the button B depicting a pocket
calculator. The following information is provided: the analysis of variance
(ANOVA), some additional statistics which may be useful for quality con-
trol, the estimated potencies and the 95 per cent confidence intervals, and
a graphical presentation of the observed data and the calculated regres-
sion. Redundant tables will be removed, provided they are not followed by
non-redundant tables. Avoid empty tables because they slow down the cal-
culation process. Refer to chapter 4 for some guidelines on the interpretation
of the output.

1.8 Printing

You can make a printout of the data sheets by clicking on the button & de-
picting a printer. As you may have noticed, the presentation on your screen
is exactly as it would appear on paper (the software detects automatically
the paper format of your current default printer. If no printer can be de-
tected, an A4 format is assumed). On the top of each page, you will find the
date and time of printing, which should avoid mixing up pages that were
printed at different times.

1.9 Combining assays

You can combine the results of assays by opening all assays you want to
combine and clicking on the button & depicting a cauldron. The resulting
combination can be saved as a file with the extension *.epc. More details
can be found in chapter 5.
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Chapter 2

Creating a template

2.1 Introduction

A template is a standard data sheet with the extension *.epm in which all
options are predefined. Templates are useful if you regularly perform similar
assays. Instead of each time creating a new data sheet and specifying all
options, you can simply open a template and start entering the data. The
creation of a new template is not difficult, but it is important that you know
exactly which options are appropriate for the type of assay concerned. It
is anticipated that templates are only prepared by qualified staff, or on the
basis of directives from qualified staff. To create a template you start by
clicking on the leftmost button depicting an empty page [J. Alternatively
you can select File> New from the menu or press CTRL+N. The options
wizard will appear in which eight groups of options can be distinguished.
This chapter explains which options are available for each of the groups and
what their properties are.

2.2 Size

The group ‘Size’ (see figure 2.1) enables you to specify how many tables
you need and how many rows and columns each table should have. The
number of tables is normally equal to the number of samples included in
the assay (including the Standard). However, it is possible to specify more
tables than needed. When the calculations are performed, empty tables are
considered to be redundant and automatically removed. You should avoid
empty tables followed by non-empty tables because they cannot be removed
and will slow down the calculations. A data sheet must contain at least one
table. The maximum number of tables is 99, but in practice this will only
be limited by the memory and speed of your computer. In multiple assays,
the inclusion or exclusion of test samples will generally affect the estimated
potency of the other samples. This is because the software can make a more

13
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il Options wizard 52
Doses | Transformation \ Variance | ANOVA \
Size | Orientation | Madel |  Design |

Size of tables
Kumbet of tables: 1
MNurnber of information lines: 1
Kurmbe of pre-diutions o
Numnber of doses: [3
Kumber of replicates 3

‘ Mext >» ‘

oK Lancel | Help ‘

Figure 2.1: The ‘Size’ group of the Options wizard

accurate estimate of the potency if more observations are included.

e The number of information lines is determined by the amount of sam-
ple related information you want to include in the tables. These lines
are not necessary for the calculations, but are intended to provide ad-
ditional information about the samples. For example, if you want to
include the name, the batch number and the expiry date of each sam-
ple, you need 3 information lines. If you do not want to include sample
related information, you can specify 0 information line.

e The number of pre-dilutions is almost self explanatory. You need a
line for each step in the preparation of the stock solution. You can
specify 0 if there is no pre-dilution. The reconstitution of a sample and
the injection or inoculation volume are also counted as pre-dilutions.

e The number of doses is the number of doses included for each sample.
If the samples have unequal numbers of doses, you will have to specify
the maximum amount of doses needed and leave the superfluous cells
empty when entering the data. It is not possible to specify different
sizes for each table.

e The number of replicates indicates how many times each treatment is
included in the assay. If unequal numbers of replicates are included
for the different treatments, you will have to specify the maximum
number of replicates needed and leave the superfluous cells empty when
entering the data.

2.3 Orientation

The orientation of the tables depends on the most convenient presentation.
For some assays, it may be more convenient to position the doses vertically
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Standard

Preparation | 5 Standard

Ags. pot. 39 pgidose Preparation |5

Pre-dil. 1 1 doze/0.5 ml Ags. pot. 39 pgddoze

Pre-dil. 2 1 ml#39 ml Pre-dil. 1 1 doze/0.5 ml

Dosges 1] [2] Pre-dil. 2 1 ml#39 ml
51 18.0 | 180 Doses S1 ] 52[ 53| 54
52 228 | 245 (1] 18.0) 228|304 | 367
53 304 | 304 2) 18.0) 245|304 | 366
54 35.7 | 366

Figure 2.2: Same data with different orientations

"B Options wizard @'
Doses | Trarsfomation | Varance | aMOva |
Sze | Oientation [ Model | Design |
hodel
Parallel lines (In dose] o
Slope ratio [dose] C
Sigmaid curves (In dose) i
Quantal responses (In dose) C
ED W determination [In doge)
[~ Usefisedslope: [

<< Previous ‘ Mest > ‘

1] LCancel | Help ‘

Figure 2.3: The ‘Model’ group of the Options wizard

on the left side of the tables, and for other assays to place them horizontally
on top of the tables. The choice is purely a matter of page layout and will
usually be chosen so as to save paper. You can always change this option at
a later stage if you change your mind. Figure 2.2 shows an example of the
same data presented with the doses positioned vertically and horizontally,
respectively.

2.4 Model

You can select five different models: Parallel lines, Slope ratio, Sigmoid
curves, Quantal responses, and EDxx determination (see figure 2.3). For
each model, it is possible to specify a fixed common parameter. For slope
ratio models, this is the common intercept, and for other models, this is the
common slope. If you want to analyse a single dose assay, you can select
Parallel lines for quantitative responses and Quantal responses if the data
are quantal.

o Parallel lines: This model assumes that response y depends on dose
x according to the relationship f(y) = ¢; + b - loge(x) + ¢ where f
is some type of transformation (see section 2.7), ¢; is the intercept
of preparation ¢, b is the common slope and ¢ is a statistical error
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following a normal distribution with expectation 0. Since the exact
dose of the test samples is not known, the intercepts are usually not
the same for each sample. The horizontal distance between the parallel
lines is the correction that has to be applied to the assumed potency
to find an estimate of the true potency.

Slope ratio: This model assumes that response y depends on dose x
according to the relationship f(y) = ¢ + b;j(xz) + ¢ where f is some
type of transformation (see section 2.7), ¢ is the common intercept,
b; is the slope of preparation ¢ and ¢ is a statistical error following a
normal distribution with expectation 0. Since the exact dose of the
test samples is not known, the slopes are usually not the same for each
sample. The ratio between the slopes of the lines is the correction that
has to be applied to the assumed potency to find an estimate of the
true potency.

Sigmoid curves: This model is often called a 4- or 5-parameter model
because the sigmoid curves are characterised by 4 or 5 parameters.
The model assumes that response y depends on dose x according to
the relationship f(y) =d+a-h(c; + b-loge(x))? + € where f is some
type of transformation (see section 2.7), ¢; is the intercept of sample i,
b is the common slope factor, a is a factor of vertical scale, d is a term
of vertical location, h is a function describing the general shape of the
curve, g is the optional fifth parameter to model asymmetry, and ¢ is
a statistical error following a normal distribution with expectation 0.

Quantal responses: This model is similar to the model for sigmoid
curves, with the exception that responses y do not follow a continuous
scale, but are fractions of units that can either respond or not respond
to a certain stimulus, e.g. dead or alive. For example, if a group
of 10 mice have received a certain dose and you count the number
of surviving animals, you may expect the fractions 0/10, 1/10, 2/10,
..., 9/10 and 10/10, but you cannot expect a fraction of 0.324. The
responses are said to be quantal following a binomial error distribution.
This model includes probit analysis and logit analysis (see section 2.7).

EDxx determination: This is also a model depending upon quantal
responses, but instead of measuring the horizontal distance between
test samples and a standard, the dose that induces a response in xx per
cent of the units (usually 50 per cent) is estimated. If you specify this
option, you will also have to specify xx. This value is 50 by default,
but it can have any value between 0 and 100 (exclusive). However, in
the extreme parts of the curve, the outcome becomes highly dependant
on model assumptions. Estimates above the ED90 or below the ED10
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"B Options wizard ==

Doses | Transformation | Wariance | awove |

Size 1 Oriertation I Model | Design

Design
Completely randomised O
Frandamized block (@]

[Latin) square (o

[~ Show design

<< Previous | Mest > |

ok | Cancel | Help |

Figure 2.4: The ‘Design’ group of the Options wizard

are therefore seldom very meaningful, unless you have large amounts
of data. The ED50 is usually the most robust option.

¢ In slope ratio assays, the intercept can be kept fixed, typically to force
the lines through the origin. In other assays, the slope can be kept
fixed. On the computer output, the fixed parameter is shown on the
right-hand side of the model specifications together with a p-value for
the hypothesis that the fixed slope (or intercept) is identical to the
estimated slope (or intercept). A fixed slope can be useful in the cal-
culation of plaque forming units (PFU) where the slope is theoretically
exactly 1 (i.e. a 10-fold dilution is expected to give a factor 10 less
plaques). Another situation in which a fixed slope can be useful is in
ED50 calculations where not enough non-extreme responses are avail-
able to calculate a slope. In such cases, a slope based on historical
data may be used.

In case of a single dose assay, you should specify Parallel lines if the data
are quantitative and Quantal responses in other cases.

2.5 Design

You can choose between three different types of design (see figure 2.4). Data
from cross-over designs cannot be analysed with CombiStats.

e Completely randomised: This design is appropriate if no experimen-
tal factor can be identified that could influence a specific group of
treatments in the same way.

e Randomised blocks: If it is possible to identify an experimental factor
that could influence the response of specific groups of units in the same
way, the randomised block design may be appropriate. For example, a
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group of different treatments in a Petri dish might, on average, give a
lower response than an identical group of treatments in another Petri
dish. Hence, it is important that the treatments be equally distributed
over the Petri dishes (the blocks). Applying the same treatment in
only one block should absolutely be avoided, as this would confound
the effect of the treatment with the block effect, and thus lead to
erroneous results. For example, if animals receiving the low dose of a
sample are all kept in the same cage and animals receiving the high
dose are kept in another cage, it is not possible to distinguish between
the effect of the treatment and the effect of the position of the cage
(should there be any).

e (Latin) square: If it is possible to identify two possible factors that
could influence the response of specific groups of units in the same
way, the (Latin) square design may be appropriate. For example,
treatments that are positioned in the same row of a plate may give a
higher average response than identical treatments in another row, and
the same could be true for the columns. If rows and columns can be
expected to affect the response, it is important to distribute the treat-
ments equally over the rows and columns and to specify the (Latin)
square option. The word Latin is put between parentheses because the
software does not necessarily require a Latin square distribution of the
treatments, but just some kind of rectangular distribution in which it
is possible to distinguish between rows and columns or any other pair
of experimental factors that are not confounded with the treatments
or with each other.

o If the option ‘Show design’ is enabled, rectangular tables are shown
in which you can specify the design (e.g. plate layout) and enter the
responses as positioned in the design (e.g. from an automated plate
reader). You can specify the number of rows and columns your de-
sign has and whether the rows should be labelled with letters or with
numbers.

2.6 Doses

You can choose between explicit notation and symbolic notation (see figure
2.5).

o Explicit notation: In general, this option is recommended because
it has the advantage that the tables are more instructive for later
reference. It forces you to specify the doses explicitly in the tables.
For more details see section 3.4.5.
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Figure 2.5: The ‘Doses’ group of the Options wizard

¢ Symbolic notation: In some cases, it may be convenient to use symbolic
notation. If this option is selected you do not have to indicate the doses
explicitly in the tables but you can use symbolic notation instead. For
example, you can specify S1, S2 and S3 for the low dose, middle dose,
and high dose of the standard, respectively, or you can use descriptions
like Low and High. It is even possible to specify nothing at all, but
this is not recommended. The software calculates the doses on the
basis of the pre-dilutions and the dilution step. Hence, it is necessary
to indicate the dilution step and whether the doses are increasing or
decreasing. If this option is selected and a dose is given explicitly, the
explicit dose overrules the implicit dose. A dose is only recognised as
implicit if it starts with a letter (A to Z or a to z, no special characters,
no accents) or if it is empty. If the assay has unequal dilution steps,
you have to use explicit notation.

Important: If symbolic notation is used for slope ratio assays, the num-
ber of non-zero doses has to be indicated. If blanks are
included in the assay, they have to appear as the last dose,
which should be explicitly indicated as the zero dose.

2.7 Transformation

The transformations that can be selected depend on the model. For parallel
line and slope ratio assays, you can choose between four predefined trans-
formations or you can specify any other transformation (see figure 2.6). For
sigmoid curves, quantal responses and EDxx determination, five transfor-
mations are available (see figure 2.7).

e Parallel line and slope ratio assays: By default, no transformation is se-
lected (y' = y). The other predefined options are the square root trans-
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Figure 2.6: The ‘Transformation’ group for parallel lines and slope ratio
models

formation (y' = /y), the logarithmic transformation (y" = log(y)) and
the square transformation (y' = y?). It is also possible to specify any
other transformation by simply selecting the last option and typing
the required transformation. You can use the standard arithmetic op-
erators such as multiplication (*), division (/), addition (+), subtrac-
tion (=) and exponentiation (~). The normal priority rules apply, e.g.
3+4xy is interpreted as 3+(4x*y). Use parentheses to overrule the or-
der of priority, e.g. (3+4)*y. Available functions are, amongst others:
log(), In(), sqrt() and exp() which denote the common logarithm,
the natural logarithm, the square root and the natural antilogarithm,
respectively. See section 7.10 for a complete list of available functions.
Use the keyword pi to indicate the constant w. The variable y has
to be used to indicate the original observation that has to be trans-
formed. In case the observations are bivariate, you have to use the
variable z to indicate the second part of the observation. If the pro-
gram encounters an invalid operation, e.g. division by 0 or logarithm
of a negative number, an error message is displayed. Examples of valid
transformations are:

y’=sqrt(y-10)
y’=log((y+2.75)*1000)
yi=(y+z)/2

y’=(y*z) /4*pi

Quantal responses and EDxx determination: By default, the probit
transformation is selected (also called the normit transformation af-
ter the normal distribution). The other options available are the
logit transformation (named after the logistic distribution), the an-
gular transformation (called after the angle distribution), the rectan-
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Figure 2.7: The ‘Transformation’ group for quantal responses, EDxx deter-
mination and sigmoid curves

gular transformation (also called the linear transformation, after the
uniform distribution) and the gompit transformation (called after the
Gompertz distribution, also called the complementary log-log distri-
bution). The choice should depend on experience or publications from
research. Select the probit transformation if you have no idea what to
choose. Tick the checkbox to include an asymmetry parameter in the
model. CombiStats will automatically invoke the Spearman-Kérber
method in cases where it is impossible to estimate the slope from the
data. The output shows a message to inform the user of this fact.
Note that the Spearman-K&rber method requires that the doses are
equidistant. It is the responsibility of the user to make sure that this
is indeed the case. If the doses are not equidistant, CombiStats will
use the smallest distance d between adjacent doses giving unequal re-
sponses. The common slope of the rectangular curves is then fixed at

1/log,(d).

2.8 Variance

For parallel lines, slope ratio assays and sigmoid curves, the observed residu-
als are selected by default. For quantal responses and EDxx determination,
a theoretical variance of 1 is selected by default. Normally you should not
change these default settings (see figure 2.8). However, in some cases it may
be desirable to use another option.

o If there is only one observation per treatment, it is not possible to cal-

culate the residual error in the usual way. However, if there are reasons
to assume that all model assumptions such as linearity and parallelism
are fulfilled, it is possible to use the deviations from model as an alter-
native residual error. Since this option excludes the possibility to check
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Figure 2.8: The ‘Variance’ group of the Options wizard

for features like non-parallelism and non-linearity, it can only be used
for routine assays that are very well controlled. This option can also
be used if there are reasons to assume that the observed residual error
systematically underestimates the true residual error and there is no
possibility to remedy this with better randomisation of the treatments.

In the same situations, another alternative could be to use the devia-
tions from linearity. With this option, it is still possible to check for
non-parallelism, or intersection and blanks. This option should also
be selected if a heterogeneity factor is desired for quantal responses
(see section 4.2.4 of chapter 5.3 of the European Pharmacopoeia).

In some routine situations, there may be insufficient data to compute
a meaningful variance from the observed residuals, but there may be
sufficient historical data to assume a theoretical variance. The theoret-
ical variance has the advantage that all validity tests like parallelism
and linearity can still be carried out, and also that the observed resid-
ual error can be compared with the theoretical variance. A significant
F-ratio for the observed residuals indicates a problem with the assay
consistency. This should also be apparent from control charts. The
number of degrees of freedom of the theoretical variance is set to co.
For quantal responses and EDxx determinations, a theoretical variance
of 1 is used. Do not change this value unless you know what you are
doing.
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Figure 2.9: The ‘ANOVA’ group of the Options wizard

2.9 Analysis of variance

ANOVA is an abbreviation of ‘analysis of variance’. The option by default
is the normal ANOVA (see figure 2.9).

No ANOVA: If there is no need to check the validity of the assay, you
may specify this option. The analysis of variance is then omitted. For
single dose assays, this option is usually selected to avoid confusion
with the Wilcoxon-Mann-Whitney test.

Reduced ANOVA: With this option specified, the total sum of squares
is subdivided in only three sources of variation: The variation that
is explained from the model (which should be highly significant), the
variation due to deviations from the model (which should not be sig-
nificant) and the residual error.

Normal ANOVA: This option allows you to check the usual statis-
tics such as regression, non-parallelism and non-linearity (regression,
intersection and blanks for slope ratio assays). The deviations from
linearity are further partitioned for each sample individually.

Extended ANOVA: In addition to the normal ANOVA, this option
allows you to check for quadratic curvature and lack of quadratic fit.
In some cases, a slight quadratic curvature does not necessarily mean
that the assay is invalid. Provided that the lack of quadratic fit is not
significant, a quadratic curvature may indicate that a transformation
of the data is appropriate. In three-dose assays, the lack of quadratic
fit is also known as the difference of quadratics.

Complete ANOVA: In addition to the extended ANOVA, this option
also displays the statistics of the reduced ANOVA.
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e Equivalence testing: Tick the checkbox to include a table with statis-
tics for equivalence testing.

2.10 Customising the template

Once you have defined all the options, you can still modify them by clicking
on the Options wizard button &= depicting a magic wand in front of a data
sheet or from the Tools menu on the menu bar. When all options are set,
you may wish to further customise the template. For example, the first
column of the assay related information contains five entries by default:
Substance, Method, Assay number, Technician and Date of assay. These
are only suggestions and can be modified. You can reduce the table by
deleting the last entry, or you can extend the table by moving down the
cursor while the focus is on the last row. For many routine assays, you will
always use the same dilution series and assumed potencies, so it is convenient
if this information is already entered into the template. See chapter 3 for
more detailed information on entering assay data. You can save a template
by clicking on the button B depicting a disk and save the data sheet as a
model with the extension *.epm. CombiStats will ask you if you want to add
this template to the library. This library offers quick access to all available
templates you have created. See chapter 3 for more details on using the
library.



Chapter 3

Entering assay data

3.1 Introduction

If you want to enter data from an assay, you can either create an ad hoc
data sheet (see chapter 2) or use an existing template. To open an existing
template, click on the button depicting a folder &, select the extension *.epm
and browse to the location where the template it stored. If the template was
added to the library, you can access the template more quickly by clicking
on the button b depicting an empty template. The software constructs data
sheets according to a standard format. A data sheet can extend over several
pages. Each page starts with information on the date and time of printing,
which should avoid mixing up pages that are printed at different times. The
assay related information is also repeated on each page, which should help
identify the assay if you find a lost page. The subsequent sections are:

e Any remarks.

e The tables with sample related information, containing dilutions and
observations.

e In case the option ‘show design’ is enabled, the design and the obser-
vations as positioned in the design.

e All necessary information on the model used.

o Additional statistics which are useful for control charts, such as the
slope of the regression.

e The analysis of variance (ANOVA).

e In case the option ‘equivalence testing’ is enabled, a table with 90 per
cent equivalence intervals.

e The estimated potencies and their 95 per cent confidence intervals.

25
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Figure 3.1: The library of templates

e Graphical representations of the observed data and the calculated re-
gression.

e Names of responsible persons.

This chapter describes in detail how to complete a data sheet.

3.2 Using the library of templates

The library of templates is an optional feature, which enables you to access
the available templates more quickly. Instead of searching manually for the
*.epm, files you can open the library by clicking on the button & depicting
a template. The first time you use CombiStats, the library is empty. But
once you have created a set of templates, it might look like shown in figure
3.1.

A template can be opened by double clicking on it, or by selecting it
and clicking on OK. If a template does not appear in the library, but you
are sure there is an *.epm file with the correct template, you can add it to
the library by clicking on Add and searching for that file. You can delete
a template from the library by selecting it and clicking Remove. Deleting
a template from the library does not automatically delete the file from the
disk. The library is in fact a collection of links to files which can be located
in different directories. If such a file is moved or deleted, the link is lost. To
restore a lost link, you have to remove the template from the library and
add it in again as described above.

3.3 Assay related information

It is important to distinguish between assay related information and sample
related information. For example, the date of assay is not specific for one
sample, but for the whole assay. The assumed potency of a sample or a batch
number is not assay related, but sample related. Assay related information
is never necessary for the calculations. The 5 standard entries suggested
by CombiStats are typical examples of assay related information. You can
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Standard + Header

Preparation | Ph. Eur. BRP Batch 2 [+ Sample related information
Agz. pot. [8901U/mg + Agsigned potency
Pre-dil. 1 28.0 mg/25.0 ml «— Pre-dilutions
Dioses 51 52 53 [+ Doses

il 161 | 171 | 187

[2] 150 | 172 [ 192

[3) 161 | 174 [ 185

4] 163 | 164 | 194

[5) 151 | 176 | 201

[E] 166 | 182 [ 198

T T

Replicates Chservations

Figure 3.2: The layout of sample tables

enter all assay related information that you consider to be relevant into the
first table. Move down with the cursor keys to add more rows. Empty
rows that are not followed by non-empty rows are automatically removed.
This table is repeated on each page, which should help identify an assay,
should you find a lost page. Use the INSERT or F2 key to modify parts
of existing entries. You should never put sample related information in this
table. Sample related information should be entered in the information lines
of the specific sample to which it applies.

3.4 Sample related information

The tables consisting of sample related information can be subdivided into
several parts (see figure 3.2). Each of the parts will be discussed in a separate
paragraph.

3.4.1 Header

The header appears at the top of each table. It either contains the word
“Standard” or the word “Sample x” where x runs from 1 to the number of
samples included. The first table is the standard by default, but it is possible
to select another standard by double clicking on the header of the table that
you want to be the standard. In EDxx determinations, it is not always
necessary to include a standard. You can toggle off the word “Standard” by
double clicking on it.

3.4.2 Sample related information

Sample related information is optional and never necessary for the calcula-
tions. The information lines appear after the header and before the assigned
or assumed potency. The number of information lines can be modified with
the Options wizard. Examples of additional information are: Trademark,
Manufacturer, Batch number, Expiry date.
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3.4.3 Assigned or assumed potency

The abbreviation “Ass. Pot.” means “assigned potency” in the case of the

standard, and “assumed potency” in the case of the other preparations. An
assumed potency is simply a temporarily assigned potency. The CombiStats
software allows you to specify the potency in a variety of different formats.
The syntax is NUMBERI [ log [ BASE | | UNiTl / [ NUMBER2 | UNIT2. The
information between brackets is optional. NUMBER1 can be replaced by a
question mark (7) except for the standard for which always a real number is
required. If the keyword log is used, the potency is assumed to be specified
in logarithms to the base BASE. If BASE is omitted, it is assumed to be
to the base 10. UNIT1 has to be the same for all samples, including the
standard. If NUMBER2 is omitted it is assumed to be 1. Examples of valid
potencies are:

5600 IU / vial

15 IU / dose

15 IU / 0.5 ml

20 pg protein / ml
3.5 log CCID50 / ml
3.5 logl0 CCID50 / ml
7 AU / ampoule

In the above examples, spaces are used in the notation for readability, but
they are not necessary. A full stop has to be used as the decimal separa-
tor even if your regional settings specify a comma. This is to guarantee a
common format for all users of the software and to facilitate the exchange
of data files between different users. If you type a comma, it is automati-
cally converted to a decimal point. When you copy-paste from and to other
software, numbers are automatically converted to the regional settings.

3.4.4 Predilutions

The number of lines for pre-dilutions can be modified with the Options
wizard. If there are no pre-dilution steps, you can specify 0 line. The
pre-dilutions appear after the assigned or assumed potency. The syntax is
NuMBER1 UNITl / [ NUMBER2 | UNIT2. The information between brackets
is optional and is assumed to be 1 if it is omitted. Furthermore, UNIT1 must
be equal to UNIT2 of the preceding step. For example, an assigned potency
of 5600IU/vial can be followed by a dilution step of 0.5vial/25ml, but
it cannot be followed by a dilution step of 10mg/25ml. Reconstitution of a
sample and the volume administered per experimental unit are also counted
as pre-dilutions as well as the conversion to other units. The example in
figure 3.3, therefore, has 3 pre-dilution steps, even though none of them
are real pre-dilutions. Use CTRL+m to type the Greek symbol p. It is
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Sample 1
gz pot. ?log TCIDSO / vial
Feconstitution |1 vial £ 0.5 ml
Conversion 0.5 ml /500 pl
Inoculation 100 pl # well
Dosges 1]
-2.01ag 8/8
-2 log /8
3.2 log 78
3.8 6/8
-4.4 log 248
-5.0log 1/8
5.6 log 1/8
-B.2 log 0/8

Figure 3.3: The reconstitution, conversion and inoculation are counted as
pre-dilutions

highly recommended to express the last step in terms of the actual dose
administered to the experimental units, e.g. 0.5ml/animal or 100111/well.

3.4.5 Doses

The doses appear either on top or to the left of the observations, depending
on the option selected for the orientation of doses. You can modify this
with the Options wizard. If you have specified symbolic notation in the
options, you can use symbolic notation for the doses (see paragraph 2.6).
The doses are then calculated by the software on the basis of the assigned
or assumed potency, the pre-dilutions and the dilution steps, and their rank
of appearance in the table. Otherwise, you must specify the doses explicitly.
The word “Dose” is used for a variety of different concepts. It can mean
“Content”, “Volume”, “Dilution” or even literally a “Dose”. Each of these
concepts has its own notational format.

e A content is a number followed by a unit. The unit has to be equal
to UNIT1 of the assigned or assumed potency. The pre-dilutions are
ignored in this case. This format can also be regarded as literally
meaning a dose, if you think of it as the number of units per volume
administered. This notation is in general not recommended, because
it is likely to be used incorrectly if standard and test samples are
not prepared in exactly the same way. However, it can be useful in
situations where samples are compared to a standard that is assumed
to be identical.

e A volume is also a number followed by a unit, but in this case the unit
has to be equal to UNIT2 of the last pre-dilution step. Usually, this
is a measure of volume, e.g. ml or pl. This volume is considered to
be expressed in terms of the stock solution. For example, consider the
case of a preparation with assumed potency of 100 IU/ml and a pre-
dilution of 1ml/10ml. A dose of 0.5 ml will in this case be interpreted
as b IU per experimental unit.
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Sample 1 Sample 1
Sample | T Sample | T
Ags. pot. | 20 pg protein / ml Az, pot. | 20 pg protein / ml
Doses (1] (2] (3 Pre-dil. 1 {1 ml /1000 ml
141000 | 1.1401 1.386 ) 1.051 Doses (1] [2) (3
142000 | 0.501 | 0.6ES | 0.576 141 1.140( 1.386 | 1.081
144000 | 0.327 | 0.355) 0.345 1/2 | 0.501 | 0.665 | 0.576
1/8000 | 0167 0157 0178 144 | 0327 0355 0.345
1/16000 | 0.057 | 0.057 | 0.054 1/8 | 0167|0157 | 0178
116 | 0.097 | 0.097 | 0.034

Figure 3.4: The working dilutions can be simplified by specifying a pre-
dilution

e A dilution can be given in two formats: as a ratio NUMBER] / NuM-
BER2 or as a logarithm NUMBER1 log | NUMBER2 |. The information
between brackets is optional and is assumed to be 10 if omitted. Di-
lutions are assumed to be expressed in terms of the stock solution.
Hence, the tables in figure 3.4 are equivalent. In this example, the
dilution of 1/1000 in the left table is interpreted as 0.02 pg per experi-
mental unit and the dilution of 1/1 in the right table is also interpreted
as 0.02 pg per experimental unit.

Valid series of doses are

Symbolic notation: S4 S3 S2 S1
Content: 0.1IU 0.01IU 0.001IU 0.0001IU
Volumes: 100l 10pl 1pul 0.1l
Dilutions (ratios): 1/10  1/100  1/1000  1/10000
Dilutions (logs): -llog  -2log -3 log -4 log

It is important to be aware that these series of doses do not necessar-
ily have to be equivalent. The symbolic notation in this example is only
equivalent to the explicit dilutions if a decreasing dilution step of 10 has
been specified. The explicit contents are only equivalent to the explicit di-
lutions if the stock solution contains 1 TU/unit. If this confuses you, it is
recommended to examine the examples in appendix A and to compare the
different notations.

3.4.6 Replicates

The replicates are indicated between parentheses. In case of randomised
blocks, they indicate the blocks unless the design is shown. The blocks are
numbered across the samples, i.e. (1) for the standard indicates the same
block, row or column as (1) for the other samples. The numbers do not refer
to blocks if ‘show design’ is enabled because, in that case, the numbers in
the design take on that role.
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Figure 3.5: An example of a Latin Square design

3.4.7 Observations

The syntax of the observations is NUMBER1 [ / NUMBER2 ]. In addition, you
can specify + instead of 1/1, and — instead of 0/1. The information between
brackets is optional and is in general only used to specify the size of a group
for quantal observations, or bivariate data for quantitative observations. For
example, some assays may require the measurement of the horizontal and
the vertical diameter of the inhibition zones. You can use a transformation
to compute the area of the zones, where y refers to NUMBER] and z refers
to NUMBER2. If you refer to z, but NUMBER2 was omitted, it is assumed
to be 1. If you omit z for quantal observations, it is also assumed to be 1,
which allows you to use 0 or 1 as short notations for 0/1 and 1/1.

Observations can easily be excluded from the analysis by double clicking
on them. They are still visible, but barred. Double click once more to
include them again. Double click on the dose, or on the replicate number to
exclude a whole row or column. Double click on the word ‘Dose’ to exclude
all observations of one sample.

3.5 Layout of the design

The design is only visible in case this option is selected in the options wizard.
The first table contains the positions of treatments, e.g. doses on a plate or
animals in cages. The second table contains the observations as positioned
on the template. When entering the data, you have to enter the design of
the template first. The template is described with 2 or 3 numbers separated
by a vertical line (the pipe symbol | ). Instead of the pipe symbol, you can
type the forward or backward slash (/ or \) which will automatically be
transformed to the pipe symbol. The first number refers to the preparation,
the second number to the dose and the optional third number to the repli-
cate. If the third number is omitted, it is assumed to be equal to the number
between brackets to the left or top of the table. For example, consider the
template in figure 3.5. The ‘1|1’ in row (1) and column (A) indicates that,
on this position of the template, the first replicate of the first dose of the
first sample is applied. The ‘2|3’ in row (5) and column (D) indicates that
the fifth replicate of the third dose of the second sample is applied.

The design can be entered more conveniently by selecting a cell or a group
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Design | (10| (2) | (3] [ (41 | (5] [ (6) | (F) [ (8) | (3) [ (00| (1] | (1]
(A | Pas [ T 1217 [ T13T) 11401 ) 1151 | 5512 | 51412 | 51312 | BI22 | G112 Neg
(B) | Pas [ 210011 [ 21211 [ 2131 ) 2411 | 2051 | 61512 | 61412 | 61312 | 2|2 | E[1]2 ) Neg
C) | Pas [ 3101 [ 31211 [ 31307 3401 ) 350 | 7512| 7142 | 7312 | 71202 | 7112) Neg
(D) | Pas [ 4107 [ 41217 [ 37| 41411 | 4151 | 81512 | 81412 | 81312 | BI22 | 8112 Neg
[E] | Pas [ ST [ BI211 [ G131 ) G141 ) S50 10512 | 142 | 1312 [ 11202 ] 1112 ) Neg
(F1 [ Pos | BN | Bl201 | G131 [ 6411 | 650 | 21512 ) 20412 21312 | 21212 | 2112 | Meg
[G) | Pas [ 710 [ 71211 [ 7137 71401 ) 7151 | 3512 | 31412 | 31312 | 31202 | 3112 Neg
[H] | Pas [ BT [ 81211 [ 8131 8401 ] 8151 | 40512 | 4142 | 4312 | 4202 | 4112 ] Neg

Figure 3.6: An example of a plate design with colour identification

of cells in a preparation table and then double-clicking on the position in
the design where the observation(s) is (are) located. If you select a group
of cells, the selection gets a blue background colour, except the active cell
which stays white. A reference to the active cell is inserted on the place
where you double-clicked. References to the blue cells are inserted to the
left and bottom, possibly in reverse order if the active cell is not the top-left
cell of the selection.

It is possible to use labels such as ‘Neg’ or ‘Pos’ in the design. La-
bels must not start with a number. Cells which are labelled this way, may
have an observed value on the plate, but do not correspond with one of the
tabled values included in the calculations. By default, the referenced cells
are shaded in a colour (up to a maximum of 12 colours) as a visual aid in
assessing the plate layout. The colour indicates the preparation. Labelled
cells are shaded in grey. An example of a coloured plate design using ref-
erences and labels is shown in figure 3.6. Use of colours can be enabled
or disabled independently for screen and printer via the menu Options>
Advanced &> Preferences.

Observations can be entered directly into the tables, or they can be en-
tered into the template. You cannot enter observations if the corresponding
template is missing. If you enter the data into the tables, the observations
will automatically be copied to their corresponding place on the template,
and vice versa.

3.6 Remarks

You can enter any remarks into the box at the top of the first page. Remarks
cannot contain double quotes (7). Double quotes are automatically replaced
by single quotes (°).

3.7 Signatures
At the end of each data sheet, three entries are provided for the names or

initials of the persons who are responsible for the assay-results. Typed names
in these fields are optional only and should not be regarded as replacement
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of signatures. Depending on the procedures applicable in your organisation,
handwritten signatures should nonetheless be applied to the paper print-
outs or certified digital signatures to digital renderings of the output. See
section 9.8 for more details on digital signatures.
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Chapter 4

Interpretation of the output

4.1 Introduction

This chapter attempts to give some guidelines for the interpretation of the
output. Reference should also be made to chapter 5.3 of the European
Pharmacopoeia. When the calculations are performed by clicking on &, the
first step is to interpret the analysis of variance. The graphs should also be
inspected. If the assay passes the validity criteria, the estimated potency
can be taken into consideration.

4.2 Inspecting the mean responses

It is possible to inspect the mean responses by selecting Options > Mean re-
sponses from the menu or CTRL+R on the keyboard. This option adds a row
or column to the tables with the arithmetic mean response for each dose, not
taking into account a possible transformation. Barred observations are not
included in the average. In the case of bivariate or binomial data, the part
before the slash and the part behind the slash are averaged independently.
The additional row can be removed with the same menu or by repeating
CTRL+R on the keyboard.

The additional row or column is only intended for quick on-screen in-
spection and will disappear when further actions are performed. The mean
is shown in the same format (i.e. with the same number of decimals) as the
first observation in the table, which may result in a slight rounding. If you
want the average to show more decimals, you have to add redundant zero’s
to the first observation in the table so as to represent the format in which
the average will appear.
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4.3 Analysis of variance (ANOVA)

The first step is to check the validity criteria in the analysis of variance, which
depend on the statistical model and the option selected for the ANOVA.
The probabilities (p-values) are flagged with stars to indicate the level of
significance. They have the following meaning:

(*) probability less than 0.05 (i.e. significant)
(**) probability less than 0.01 (i.e. highly significant)
(<) probability less than 0.001 (i.e. even more significant)

A p-value is not flagged if it is greater than or equal to 0.05. The p-value
is printed with 3 decimals, but the internal representation has a higher
precision. Hence, a value of 0.0499 is rounded to 0.050 and flagged, whereas
a value of 0.0501 is also rounded to 0.050 but not flagged. The stars are only
shown for the levels of significance that are most commonly used. However,
validity of an assay depends on the requirements specified for the type of
assay and may involve other levels of significance.

The usual validity criteria for parallel line assays and assays with quantal
responses are:

e The p-value for regression is significant (at least one star). If this
criterion is not fulfilled, it is impossible to compute confidence limits.
In most assays you will find two or three stars. In the case of only one
star, the criterion is fulfilled but the confidence limits are usually too
wide to be acceptable, depending on the type of assay.

e The p-value for non-parallelism is not significant (no stars).
e The p-value for non-linearity is not significant (no stars).

In the case of significant non-linearity, it may be instructive to examine
the quadratic curvature (only available if the extended ANOVA has been
selected). If the quadratic curvature is significant and the lack of quadratic
fit is not significant, this could indicate that a transformation of the data
is appropriate. The choice of transformation should never depend on only
one assay, but should depend on a series of independent assays in which the
same type of curvature has been observed.
The usual validity criteria for slope ratio assays are:

e The p-value for regression is significant (at least one star). If this
criterion is not fulfilled, it is impossible to compute confidence limits.
In most assays you will find two or three stars. In the case of only one
star, the criterion is fulfilled but the confidence limits are usually too
wide to be acceptable, depending on the type of assay.
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e The p-value for blanks is not significant (no stars). This criterion is
only applicable if blanks or zero doses have been included. In many
assays, the dose response relationship is not linear down to zero dose,
and it may be necessary to exclude the blanks from the calculations.
Blanks should not be excluded only because the p-value is significant in
a single assay. The decision should depend on a series of independent
assays in which a similar deviation of the blanks has been observed.

e The p-value for intersection is not significant (no stars).
e The p-value for non-linearity is not significant (no stars).

In routine assays, the residual error should also be inspected and compared
with historical data. It is recommended to keep control charts of the residual
error. An exceptionally high residual error may indicate a problem with the
assay procedure. In such a case, the assay should be rejected even if the
criteria in the analysis of variance are fulfilled. An exceptionally low residual
error may once in a while occur and cause the p-values to be significant. In
such a case, it may be justified to replace the observed residual error by an
average residual error based on historical data (select Theoretical variance).

4.4 Graphs

Unusual features are often more obvious in a graphical representation than
from statistical parameters. Therefore, you should always inspect the graphs.
They show for each sample the observed data (indicated with dots) and the
calculated regression line. This has been demonstrated to be a very efficient
way to detect experimental outliers and keying errors. Consider, for exam-
ple, the following series of observations: 0.354; 0.369; 0341; 0.348 (note the
missing point in the third observation). This keying error would immediately
be obvious in a plot, but would be less obvious in a table.

Remark: The figures do not have scaled axes, since they are not necessary
for the purpose of detecting unusual features and were difficult to implement
on such a small scale. If more detailed plots are required, with scaled axis, a
page sized plot can be generated by clicking on the button depicting a graph
7

The full size plot can be viewed (and printed) in colour (%) or in black
and white (#). The samples in the plot can be identified by their colour
and/or the shape of the symbols for the observations. There are 13 colours
and 12 symbols which are recycled when the series is exhausted, thus making
up for a large amount of combinations: @* &-7H+#s as¥a

The orientation of the plot can be changed from landscape (i) to por-
trait () and back again. The fontsize in the figure can be increased (A) or

decreased (Av). The Options menu provides several other ways to customize
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Figure 4.1: An example of 3 different scalings shown simultaneously

the plot. The legend can be excluded, the scale of the y-axis can be hidden,
and there are 3 types of scaling for the z-axis:

e Scaling by notation: The notation of the dose labels in the sample
tables are shown above the z-axis.

e Scaling by dose: The dose levels (in potency units) are shown in small
print below the z-axis (maximum 6 significant digits).

e Scaling by x: The transformed doses are shown in normal print below
the z-axis.

By default the scaling by notation and by z are shown, but any combination
of these 3 types of scaling can be selected in the options menu. Figure 4.1 is
an example where all 3 types are shown simultaneously. The values on the
axis are based on the standard. The test preparations necessarily have to be
plotted on a meta-axis based on the (implicitly) assumed potency, which is
only an approximation. It should also be noted that the scaling below the
axis only has a meaning if you have fully specified all steps to prepare the
doses.

It is possible to generate a plot of curves connecting the average response
per dose group. First click on I to generate a page sized plot of the graph,
then click on ¥ to generate the plot of averages.

CombiStats can generate a residual plot as a visual aid for assessing
model fit. To generate a residual plot, first click on ¥ to generate a page
sized plot of the graph, then click on &= to generate the residual plot. By
default, the standardised residuals are plotted against the expected (fitted)
response. The standardised residuals are corrected for leverage as obtained
from the hat-matrix and the weighting function, so that the residuals should
be equally distributed about 0 over the whole range of responses. If the scat-
ter about 0 is not homogeneous over the whole range of responses, you may
have to use a different weight function. A good example is ‘PlateDesign.epa’
where the residual plot can be seen to improve when a weighted regression
is done with weights w=1/m"2 instead of an unweighted regression (w=1).
Note that the residuals are not studentised. You can choose from different
quantities on both axes via the menu Options > Residual Plot. The raw resid-
uals are the difference between the observed response and the fitted response
without any correction for leverage.
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4.5 Additional statistics

In routine assays, it is recommended to keep a record of the additional
statistics, just as for the residual error as explained in section 4.2. For
parallel lines and quantal responses, the common slope should be recorded.
For slope ratio assays, the common intercept should be recorded. The 90
per cent confidence limits of the common slope or common intercept may
also be recorded.

The correlation coefficient |r| is a measure of quality of the assay. Its
square is the proportion of the total variance that is explained by the model.
The closer this value is to 1, the better the model explains the observations.
For a single sample to which a straight line is fitted, this value coincides with
Pearson’s product moment correlation coefficient. The unweighted correla-
tion coefficient is only calculated for linear regressions with homogeneous
error variance, because it has no meaningful interpretation in other cases.
The weighted correlation coefficient is always calculated. If the weighted
and unweighted correlation coefficients are identical, it is printed only once.
For sigmoid response models with homogeneous error variance both are cal-
culated. The weighted correlation is theoretically to be preferred, but un-
fortunately many protocols prescribe the unweighted correlation coefficient
as validity criterion.

For sigmoid models, the estimated lower and upper asymptote are printed.
For 4-parameter models, the lower asymptote is always printed before the
upper asymptote. For 5-parameter models, the order depends on the sign of
the multiplication factor a. For positive values of a, the lower asymptote is
shown first, whereas, for negative values of a, the upper asymptote is shown
first.

It is not possible to copy and paste these statistics directly to other
software, but you can do it indirectly by copying and pasting the complete
data sheet (Edit> Copy All) or by simply typing them over.

4.6 Potency estimates

If an assay has passed the validity criteria, the estimated potency can be
considered. The potency is expressed in the same units as the assumed
potency. The lower and upper limits are the 95 per cent confidence limits.
Some assays prescribe a maximal permitted width of the confidence interval,
e.g. not wider than 80 per cent to 125 per cent of the estimated potency,
and a maximal permitted deviation of the estimated potency from the as-
sumed potency. For that reason, the potencies and confidence limits are
also expressed as a percentage of the assumed potency (Rel. To Ass.) and
the estimated potency (Rel. To Est.). Question marks are returned if the
assumed potency was indicated with question marks.
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Remark: The relative potencies are expressed by default on log-scale if
the potencies are also expressed on a log-scale. However, the Options menu
allows you to force percentages. If a standard is included in EDxx assays,
the potency is expressed both as EDxx and relative to the standard.

4.7 Single dose assays

In the case of a single dose assay, CombiStats calculates the limit that you
are testing and the probability that the test sample is equal to this limit. If
the limit test is significant at the chosen significance level, it can be concluded
that the test sample differs significantly from the limit tested. Whether the
potency is higher or lower than the limit tested depends on the nature of
the dose/response relationship. In order to draw the correct conclusion,
you should therefore know this relationship. The probability is calculated
with the Wilcoxon-Mann-Whitney test (pairwise, one-sided). The one-sided
p-value is printed as the right-sided p-value when the statistic is greater
than its mean. Otherwise it is printed as the left-sided p-value. The test is
exact in principle, but for larger problems the calculations can take a very
long time. An approximate p-value, based on a normal approximation with
correction for ties, is shown in the status bar during the calculations. Press
the BREAK key (or SHIFT 4+ ESC) to stop the exact calculations, and use
the approximation instead.

4.8 Equivalence testing

Some protocols may call for equivalence testing of slopes instead of the more
traditional F-test for non-parallelism or intersection. If the checkbox for
equivalence testing is selected in the options, an extra table with equivalence
statistics is shown. The table shows the slopes (or intercepts in case of
slope-ratio models) of the individual preparations together with 90 per cent
confidence intervals. If a standard is included, the difference and ratio of
the individual slopes with that of the standard is also shown, again with
90 per cent confidence intervals. For slope ratio assays, only the difference
between intercepts is shown because ratios of intercepts have no meaningful
interpretation. The assay protocol should specify ‘goal-posts’ within which
the 90 per cent confidence intervals have to be entirely contained.
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Combining assays

5.1 Introduction

CombiStats offers the possibility to combine potency estimates from different
assays. In order to combine a set of assays, you should open all the assays
you want to be included and then click on the button depicting a cauldron
or melting pot &. The sheet will be constructed automatically. The table
with assay related information contains all information that is common to
all assays. The table with the confidence intervals will contain in addition
the entries that are not common to all assays, but which have only the first
column in common. For example: The first column may contain an entry
‘Assay number’ in each assay, but the second column may differ from assay
to assay, e.g. the numbers 1 to 6 if you have performed 6 assays. CombiStats
calculates three types of combinations. Which combination you should use
depends on whether the potency estimates are homogeneous. There are no
strict rules as to which of the three should be used, but the following rule
of thumb can be of use.

e If the p-value for homogeneity is more than 0.10, potency estimates
are sufficiently homogeneous to use the weighted combination.

o If the p-value is less than 0.10, potency estimates tend to be heteroge-
neous and it would be better to use the semi-weighted combination.

e The unweighted combination should only be used if there are enough
assays, say, at least 6.
5.2 Editing the combination sheet

The possibilities for editing the combination sheet are limited. It is not
possible to enter data directly into the sheet. Basically, there are only four
possibilities to edit the contents:
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e Use a filter from the dropdown boxes at the top of each column. You
can visualise the dropdown boxes by moving the cursor over the right
part of the cells of the first assay. Only assays that correspond with
the selected filter will be included in the table. If you specify No filter,
all potency estimates from all samples in all assays are included.

e Excluding a particular assay by double clicking on it. The numbers
are then barred, and the figure shows an empty dot for the excluded
intervals.

e Changing the order of the assays by double clicking on the top row of
the column that you wish to be sorted. Numbers are sorted in increas-
ing order and text is sorted in alphabetical order. By default, the first
column is sorted. Dates are also sorted in alphabetical order, which
does not necessarily correspond with the chronological order. Use the
format yyyy/mm/dd if you want dates to be sorted in chronological
order.

e Hide an entire column. The dropdown boxes (see above) also include
a possibility to Hide a column. Alternatively you can press CTRL+H
while the column you want to hide is selected, or use the menu bar
(Edit> Hide column). Use CTRL+U or Edit> Unhide from the menu bar
to unhide all hidden columns.

5.3 Available options

Potencies are combined on a log-scale by default. This corresponds with a
geometric combination if the potencies are not expressed on a log-scale and
with an arithmetic combination if the potencies are already expressed on
a log-scale. However, the options menu allows you to force an arithmetic
combination if potencies are not expressed on a log-scale. It is not possible to
force a geometric combination of potencies that are expressed on a log-scale.

The relative potencies are expressed on log-scale by default if the poten-
cies are also expressed on a log-scale. However, the options menu allows you
to force percentages.

By default, the figures are presented with the option Zoom in selected.
This means that the confidence intervals extend over the whole area of the
figure. If you remove this option, the bottom of the figures will correspond
with zero potency.



Chapter 6

Importing, exporting,
protecting data

6.1 Introduction

The software is not intended to replace a database. It is anticipated that you
have a database and that you may want to import or export data between
CombiStats and this database or to other software for further manipulations.
Because of the large diversity of existing databases and programs, it is prac-
tically impossible for CombiStats to recognise all these formats. If you want
to import or export data, it is your responsibility to create a conversion
program that serves as an interface between the programs. This chapter
describes in detail the format of input and output files of CombiStats.

6.2 Copy and paste

This is the easiest and most straightforward way to import and export data
between programs. For example, you can select a group of cells in a spread-
sheet and copy it to the clipboard of Windows (Edit> Copy, or CTRL+C),
after which you can select a group of cells in CombiStats and paste the data
from the clipboard to the data sheet (Edit>Paste, or CTRL+V). Use the
same method to copy data from CombiStats to, for example, a spreadsheet.
It is possible to copy the complete contents of a data sheet to the clipboard
(Edit > Copy All), but you can paste only one group of cells at a time into the
tables. An exception are the sample tables: If the clipboard contains more
data than can fit into the selected table, the remaining contents are pasted
to the adjacent sample tables. This allows you to paste assay data to all
tables in one single action.
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6.3 Creating input files

This section describes in detail the format of CombiStats input files. This is
the same format in which the software stores data that have been entered by
hand. If you are in charge of creating a conversion program that generates
input files for CombiStats, it is recommended to print an existing input file
(extension *.epa) using a text editor. This will facilitate understanding the
format. The files are in ASCII format. Each entry starts on a new line. The
three existing data types are strings, numerical values and boolean values.
Strings are enclosed in double quotes. Numerical values use a full stop as
decimal separator. Boolean values are entered as #TRUE# and #FALSE#.

Line Type Description for files with the extension
*.epa and *.epm
1 String "CombiStats v7.0"

Boolean | #FALSE#=COrientation of doses horizontal,
#TRUE#=Orientation of doses vertical.

3 Num. The number of information lines in the
tables.

4 Num. The number of pre-dilution steps including
the assigned potency.

5 Num. The number of rows for the observations (i.e.

the number of replicates in case of horizontal
doses or the number of doses in case of
vertical doses).

6 Num. The number of columns for the observations
(i.e. the number of doses in case of vertical
doses or the number of replicates in case of
horizontal doses).

7 Num. The number of preparations.

8 Num. 1=Parallel lines, 2=Slope ratio, 3=Quantal
responses, 4=EDxx determination,
5=Sigmoid curves.

9 Boolean | #FALSE#=FEstimate common parameter from
data, #TRUE#=Use a fixed common
parameter.

10 String Value of the fixed common parameter.
Empty string if not applicable.

11 Num. 1=Completely randomised, 2=Randomised

blocks, 3=(Latin) square.
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Line

Type

Description for files with the extension
* epa and *.epm

12

Num.

1=No transformation, 2=Square root,
3=Logarithmic, 4=Square, 5=0Other,
6=Probit, 7=Logit, 8=Angular,
9=Rectangular, 10=Gompertz. Add 16 to
the values 6 to 10 in case a 5-parameter
model is used.

13

Num.

1=0Observed residuals, 2=Theoretical
residuals, 3=Residuals from deviations from
model, 4=Residuals from deviations from
linearity.

14

Num.

1=No ANOVA, 2=Reduced ANOVA,
3=Normal ANOVA, 4=Extended ANOVA,
5=Complete ANOVA. Add 8 to the value if
the option for equivalence testing is selected.

15

Boolean

#TRUE#=Explicit doses, #FALSE#=Implicit
doses.

16

Num.

1=Increasing doses, -1=Decreasing doses,
Anything if not applicable.

17

String

Encrypted string for password protection.
Empty string in case default protection as
specified in the preferences has to be used.

18

String

Value between 0 and 100 (between double
quotes) to indicate xx in case of EDxx
determination. Empty string if not
applicable.

19

String

Transformation, e.g. y or log(y) or
((y*z)-(3%3))*pi/4.

20

String

Number of non-zero doses in case of a slope
ratio model. Dilution step in other models.
Empty string if not applicable.

21

String

Theoretical residual (between double
quotes). Empty string if not applicable.

22

String

Remarks. May contain embedded returns,
but no embedded double quotes. Empty
string if not applicable.

23

Num.

Number of rows for the table with assay
related information (at least 1).
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Line Type Description for files with the extension
*.epa and *.epm

24 and Strings The information to be displayed in the table

following for assay related information. One line for
(say K each cell, starting from left to right and from
lines) top to bottom. The number of lines K must

exactly match twice the number stated on
line 21 (hence, at least 2).

K +24 Boolean | #FALSE#=Ilide design.

#TRUE#=Show design.

K +25 Boolean | #FALSE#=Letters horizontal (columns).
#TRUE#=Letters vertical (rows).

K +26 Num. Number of rows of the design.

K +27 Num. Number of columns of the design.

L lines Strings In case the design is displayed, the layout of
the template, starting from left to right and
from top to bottom. The cells with (1), (2),
etc., and (A), (B), etc., are not output to the
file. Hence, the number of lines L necessary
for the template equals Rows x Columns. If
the design is not displayed, this section is not
output to the file.

M lines | Strings The information to be displayed in the tables
and for sample related information. One line for
Booleans | each cell, starting from left to right and from
the top down to the last pre-dilution. The
cell with the word Doses and the cells with
(1), (2), etc., are not output to the file. Then
follows the first dose (as a string), the first
replicate of that dose (also as a string) and
whether that observation is excluded
(#FALSE#=included, #TRUE#=excluded).
Then follows the second replicate and
whether or not it is excluded, and so on until
the last replicate of the first dose. Then
follows the second dose (as a string), and so
on until the last dose. Hence, the number of
lines necessary for one table equals

1 4+ 2 x Information lines + 2 + 2 x
Predilutions 4+ Doses + 2 x Replicates x Doses.
Continue until all tables are filled.
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Line Type Description for files with the extension
* epa and *.epm

L lines Strings In case the design is displayed, the
observations as positioned on the design,
starting from left to right and from top to
bottom. These values should be consistent
with the corresponding values in the
preparation tables, but will overrule them in
case they are not consistent.

3 lines Strings The names or initials of persons responsible.
Empty strings if not applicable.

1 line* String The power transformation A of the doses.

1 line* String The a priori transformation of the
observations.

1 line* String The inverse link function h.

1 line* String The first derivative h'of the inverse link
function h.

1 line* String The weight function w.

1 line* String The starting value of the non-linear term for
addition. Empty string if not specified.

1 line* Boolean | #TRUE# if the non-linear addition is fixed.
#FALSE# otherwise.

1 line* String The starting value of the non-linear factor for
multiplication. Empty string if not specified.

1 line* Boolean | #TRUE# if the non-linear multiplication is
fixed. #FALSE# otherwise.

1 line* String The response level for which an effective dose
is needed. Empty string if not specified.

1 line* Boolean | #TRUE# if the EDxx has to be expressed with
inverted units. #FALSE# otherwise.

1 line* String The minimum number of iterations
requested. Empty string if not specified.

1 line* String The maximum number of iterations
requested. Empty string if not specified.

last line | Boolean | #TRUE# if advanced options where used (see
remark below). #FALSE# otherwise.

Line Type Description for files with the extension
*.epc

1 line String "CombiStats v3.0 comb"
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Line Type Description for files with the extension
*.epc
1 line Num. Number of rows for the table with general

information, not counting the row with the
assumed potency (last row of the table).

Strings The information to be displayed in the table
for assay related information excluding the
row with the assumed potency (last row).
One line for each cell, starting from left to
right and from top to bottom. The number
of lines must exactly match twice the
number stated on line 2 (can be zero).

1 line Num. The assumed potency (not on log-scale). Use
0 if no assumed potency is specified.

1 line Num. The log-base on which the assumed potency
is expressed. Use 0 if no log-scale is used.

1 line String The unit before the slash of the assumed
potency. Empty string if not specified.

1 line String The unit after the slash of the assumed
potency. Empty string if not specified.

1 line Num. Number of intervals in the table (including
the filtered and barred intervals).

1 line Num. Number of columns in the table increased by

6. The 6 extra columns are never shown in
the table, but are only used to store specific
information on the format of the table. The
minimum number is 6 + 6 = 12.

... lines Strings The header of columns before the column
with the header Sample. These are the
columns for which the header name was
chosen by the user. The number of lines is
equal to the number specified above minus
12 (so can be 0).
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Line Type Description for files with the extension
*.epc

12 lines Strings _SAMPLE_ (the underscores are necessary to
indicate that these columns are system
columns)

_INFO_

_LOWER LIMIT_

_ESTIMATE_

_UPPER LIMIT_

_DF_

_ASSUMED_ (this is the first of 6 invisible
columns with formatting information)
_LOGBASE_

_UNIT1_

_UNIT2_

_STRIKETHROUGH_

_FILTER_

... lines Strings The content of the cells of the first assay.
Only the cells in non-system columns. The
number of lines is equal to the number
specified above minus 12 (so can be 0).

1 line String The sample number.

1 line String The sample information. Empty string if not
used.

1 line Num. The lower limit of the potency estimate, not
on log-scale.

1 line Num. The potency estimate, not on log-scale.

1 line Num. The upper limit of the potency estimate, not
on log-scale.

1 line Num. The number of degrees of freedom.

1 line Num. The assumed potency. 0 if not specified.

1 line Num. The log-base on which the assumed potency
is expressed. 0 of not on log-scale.

1 line String The unit before the slash of the estimated
potency.

1 line String The unit after the slash of the estimated
potency.

1 line Boolean | #TRUE# if the interval is struck through.
#FALSE# otherwise.

1 line Boolean | #TRUE# if the interval is visible. #FALSE# if it
is filtered out.

(repeat the above for each of the intervals).
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Line Type Description for files with the extension
*.epc

1 line Boolean | #TRUE#=Geometric combination.
#FALSE#=Arithmetic combination.

1 line String The remarks. May contain embedded

returns, but no embedded double quotes.
Empty string if not applicable.

1 line Boolean | #TRUE#=Force percentage. #FALSE#=Do not
force percentages (default).

1 line Boolean | #TRUE#=Zoom in on figures (default).
#FALSE#=Do not Zoom in on figures.

Last 3 Strings The names or initials of persons responsible.

lines Empty strings if not applicable.

6.4 Creating output files

You can create an output file by saving a data sheet or combination sheet
with the extension *.txt. All information contained in the sheet is then out-
put to the file, including results from calculations (which is not the case for
input files). This file is identical to the information that would be contained
in the clipboard if Edit> Copy All is used. Each section is separated by an
empty line. Columns are separated by tabs, and rows are separated by re-
turns. If the remarks contain embedded returns, one line will be used for
each embedded return.

6.5 Exporting matrices

It is possible to export the estimated parameters and covariance matrices cal-
culated for each of the various models. It is also possible to export the input
dataset together with its linear structure matrix and vectors of observed
and predicted observations. You can do this from the menu (Options>
Advanced > Export matrices) or with CTRL4E. The matrices are copied to
the clipboard and can be pasted in a suitable external program (e.g. Excel).
The exported matrices allow you to obtain extra information on parameter
estimates that would otherwise not be available from the standard interface
of CombiStats. This enables you, for example, to perform custom hypothesis
tests or to obtain individual slopes of the preparations.

The dataset contains, in addition to the linear structure matrix of the
fitted model, a column with the linearised weights, observations and pre-
dictors, the non-linearised weights, observations and predictors (after the
a priori transformation), the diagonal elements of the hat-matrix, the raw
residuals and the standardised residuals.
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The estimated parameters and covariance matrices for 7 different mod-
els (each relaxing some of the model assumptions) are also output. Non
estimable parameters are not shown. The 7 models are:

1. The fitted model with fixed common parameter, if applicable.

2. The fitted model with common parameter estimated from the data.
3. Linear lines, each with their own intercept.

4. Quadratic curve.

5. Only intercepts and no slope.

6. Allowing an extra parameter for blanks.

7. The full parametrised model.

6.6 Protecting templates and data sheets

It is possible to protect templates and data sheets from accidental editing.
This can be done by clicking on the button & depicting a padlock, from the
menu (Edit > Protect sheet) or with CTRL+T. There are 4 levels of protection
possible:

1. Unprotected: This is the default level allowing full access for editing
the data sheet;

2. Protect options: This blocks access to the options wizard and the
advanced options so that table sizes and model specifications cannot
be modified unless the protection level is first brought back to level 1;

3. Protect options and non-empty cells: This is the same as level 2 plus
protection of pre-filled cells from editing, so that only empty cells can
be edited. The protection status of individual cells is determined at
the moment level 3 protection is installed. This status is permanently
retained unless the protection level is brought back to level 1 or 2.

4. Fully protected (read only): The data sheet cannot be modified unless
the protection level is brought back to level 1, 2 or 3.

Levels 2 and 3 are particularly useful for protecting templates. After all data
are entered, the level can be increased to 4 to protect the final sheet from
further editing. The level of protection can be increased with or without
a password. Select the new level and optionally specify a password. You
can leave it blank for simple protection without password. If you specify a
password, you will be asked to retype it to avoid typing errors. The level of
protection can be decreased by selecting the new level and typing the correct
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EmASIEE Version B.1. Sunday, 1 March 2020, 12:00:00 [+071:00). Page 1 of 1
m Protect sheet =2

Frotection level
" Level 1 Unprotected
~
(+ Level 3 Pratect options and nor-empty cells

" Level 4: Fully protected [read only)

Pazzword: |

LCancel | ok |

Figure 6.1: The four levels of protection

password for that level. If no password was used to increase the level, the
protection can be removed without a password.

Passwords can be stacked. For example, if you first increase the level
from 1 to 3 with password “Hello” and then from 3 to 4 with password
“Goodbye”, the level can only be decreased to level 1 by first going back to
level 3 with “Goodbye” and then back to level 1 with “Hello”. The Combi-
Stats logo in the upper-left corner of each page changes colour to indicate
the level of protection: 1=black, 2=blue, 3=green, 4=red.

Because files created with older versions of CombiStats do not contain
any information about protection levels, you can specify how CombiStats
should behave in case an old file is opened. By default, such a file is opened
at level 1. In the preferences, you can specify that such files should be
opened at level 4, with or without password protection. If you place the file
with preferences in a read-only location, the user cannot change the default
password that is needed to remove the protection from these data sheets.

IMPORTANT REMARK: Password protection of data sheets is intended
as a light-weight protection against accidental editing. It is not designed as
a bullet-proof protection against intentional tampering with the file. In fact,
it is quite easy to edit a file using a text editor unless there is some external
protection by a document management system. The only protection offered
by CombiStats is that you cannot accidentally modify protected files during
normal use of the program.
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Advanced options

7.1 Introduction

The advanced options form allows the more advanced user to gain maximum
control over CombiStats’ core engine which fits the generalized linear models.
The average user is not expected to use this form, but only the options wizard
(see chapter 2). Only users with a clear understanding of the theory behind
generalized linear models and with a clear view of what they want to achieve
should be using the advanced options. Using the advanced options slightly
changes the output on the data sheet because a full equation of the model
appears, as well as the weight function. If you use advanced options, you
must assume full responsibility for the validity of the output.

With the advanced options, you can analyse a very broad class of dilution
assays. A few examples are the possibility to use any power transformation
of the z-axis, any mathematical function of the regression curve and any
weighting function. However, there is no check of the data that CombiStats
normally performs when the normal options wizard is used. For example, in
probit analysis, CombiStats requires that observations are ratios of integers
and that the integer before the slash is not greater or smaller than the integer
after the slash. This check is not performed if the advanced options are used.

To illustrate the possibilities of the advanced options, it is perhaps in-
structive to examine the example shown in figure 7.1. These settings are
equivalent with the standard probit analysis in the options wizard.

The power transformation of the doses is set to 0, meaning a log,-
transformation. The a priori transformation of the responses is r/n express-
ing the ratio of positive respounses in a group. The inverse link function is
phi(x), expressing the standard normal distribution curve. Its first deriva-
tive phider(x) expresses the standard normal density function. The weight
function n/(m*(1-m)) expresses that the weights are proportional to the
group size n and inversely proportional to the variance of the expected re-
sponse m. The starting value for addition and multiplication are fixed at 0

93
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Hodel

Transtormation doses: K=dUSEA,[|7
Trarstormation responses:  y'= ,”‘”7
Inverse link function: hix] = ,ph‘[ﬂi
First derivative: hifx) = W
Weight functior: welmim)

Start value for addition d=[n Fized W
Start walue for multiplication: a =[4 Fired b
Effective Dose: m= Inv. [T Peic.

Slopelfactor] or intercept: b= Fired [~

Include asymmetry factor (5-parameter model): r

Figure 7.1: The advanced options

and 1, because the asymptotes are not supposed to be estimated from the
data. Each of the various fields will be discussed in detail in the following
sections.

7.2 Transformation doses

Let us write z = dose® to denote the power transformation of the doses. In
classical slope ratio assays, the doses are not transformed (A = 1) and it
can be shown that the log,-transformation as used in parallel line models
is equivalent to limy|o dose®. We therefore use A\ = 0 to denote the log,-
transformation. Apart from these two classical transformations, it is possible
to specify any other positive value, for example A = 0.5 for the square root
transformation. Very large values should not be used to avoid computer over-

flow, as well as values close to 0. Typical values are A € {0, %./ %, %, 1, %, 2, 3}.

7.3 Transformation responses

This is the a priori transformation to be applied to the observations in order
to construct the observation vector y’. It is applied unconditionally before
the fitting of the model starts. The following variables can be used in the
expression:

e y or r to refer to the part of the observation before the slash. If there
is no slash, the observation is taken as is.

e z or n to refer to the part of the observation after the slash. If there
is no slash, it is assumed to be 1.

y and z are typical for quantitative data, and r and n are typical for quan-
tal data, although a bizarre notation like exp(z)/sin(r) would not upset
CombiStats (as long as you think it has a meaning). For a list of available
functions, see section 7.10.
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7.4 Inverse link function

The link function is in the literature usually denoted as g. It is the mono-
tonic differentiable function that relates the expected responses p to the
linear predictors 7. For example, g is the probit function in probit analysis.
Rather than the link function, CombiStats uses the inverse link function A,
which can be thought of as a normalised regression curve. For example, h
is the standard normal distribution function in probit analysis, and h is the
identity function in parallel line or slope ratio analysis. For a list of available
functions, see section 7.10. When you specify a link function, do it in such
a way that 0 is located in a central part of the function because this is used
as a starting point for the iterations. The following variables can be used in
the expression:

e i to refer to the number of the current iteration. The first iteration
has number 0.

e x to refer to the linear predictor n in the current iteration.

7.5 First derivative

This is the first derivative dh/dn of the inverse link function. CombiStats
does not check if you specify the first derivative correctly. If you make a
mistake in specifying the function, the output will be flawed. For a list of
available functions, see section 7.10. The following variables can be used in
the expression:

e i to refer to the number of the current iteration. The first iteration
has number 0.

e x to refer to the linear predictor n in the current iteration.

7.6 Weight function

This is a function that specifies the weights to be given to the observations.
For a list of available functions, see section 7.10. For unbiased estimates,
the weight function is taken to be inversely proportional to the theoretical
variance. Some examples of frequently used weight functions are:

e 1 for homoscedastic data (unweighted regression).

e n/(m*(1-m)) for quantal data with binomial responses, such as en-
countered in probit analysis.

e 1/m for data where the responses follow a Poisson distribution.
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e 1/(m*m) for data with constant coefficient of variation.

The analysis of variance will only display F-ratios with their corresponding
p-values if, and only if, the weighting function is exactly 1 and no theoretical
variance is used. In all other cases, the x?-values and their corresponding p-
values are displayed, the reason being that the residual error has no obvious
interpretation in weighted regression. It is important to be aware that p-
values are based on the Normal error distribution. Non-normal distributions
may fail to have properties similar to those of a Normal theory residual, if
no adjustment is made to normalise the distribution, for example by using
Anscombe residuals or deviance residuals. The following variables can be
used in the expression:

e a to refer to the non-linear multiplier ¢ in the current iteration.
e d to refer to the non-linear addition d in the current iteration.

e to refer to the difference e = y' — i1 between the observed (possibly
transformed) response y’ and the expected response y in the current
iteration.

e h to refer to Huber’s weight at the current iteration with winsorisation
factor 1.5. This valueis 1 if |e|] < 1.701 xs and is 1.701 x s/ |e| otherwise.

e i to refer to the number of the current iteration. The first iteration
has number 0.

e m to refer to the expected response y in the current iteration.

e n to refer to the part of the observation after the slash (usually the
group size, or frequency of an observation).

e s to refer to the residual error at the current iteration. This residual is
not the same as that used in the ANOVA because it takes on the full
number of degrees of freedom (number of observations minus number
of parameters estimated) instead of the within-treatments residual.

x to refer to the linear predictor 7 in the current iteration.

y to refer to the observed (possibly transformed) response y'.

7.7 Start value for non-linear parameters

For most models, these values do not really play a role and hence are fixed
at 0 and 1, respectively. However, for some models, you cannot fully specify
the inverse link function without the use of additional non-linear parame-
ters. Examples of such parameters are the upper and lower asymptote in
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4-parameter sigmoid models, or the rate of natural mortality in probit anal-
ysis. The non-linear parameter for addition can be thought of as the lower
asymptote and the non-linear parameter for multiplication can be thought
of as the difference between the upper and lower asymptote. The use of
the terms non-linear addition and non-linear multiplication are more gen-
eral than the term asymptote because not all regression models calling for
non-linear parameters have asymptotes. When non-linear parameters are
used, they are multiplied and added to the inverse link function. If they are
not kept fixed, an improved estimate of these parameters is made after each
iteration. If they are not specified, CombiStats will initialize the addition
at the minimum observed response, and the multiplication at the difference
between the maximum and minimum response.

7.8 Effective dose

The effective dose is generally abbreviated to ED followed by a percentage,
usually the ED50. It will give you the amount of doses in your test sample
capable of inducing the response you specify. For example, if a dose of 21U
is estimated to induce a positive response in 50 per cent of the experimental
units and your test sample contains 1000IU/vial, the ED50/vial is 500. It
means that the vial is estimated to contain 500 doses to induce a response in
50 per cent of the experimental units. In the case of a 4-parameter logistic
curve model, the ED50 will give you the point of inflexion of the sigmoid
curve, translated to the number of doses contained in the test sample to
induce the response at the point of inflexion.

By default, the percentage option is checked. 0 per cent will then cor-
respond to the dose inducing a response of d, where d is the non-linear
parameter for addition (usually the lower asymptote) and 100 per cent will
correspond to the dose inducing a response of d+a, where @ is the non-linear
parameter for multiplication, d 4+ a usually being the upper asymptote.

If the percentage option is unchecked, the effective dose is taken as such.
For example, it might be a very specific absorbance level you are interested
in, or a very specific diameter of an inhibition zone. In this case, the soft-
ware returns the dose that induces a specific response after the a priori
transformation. For example, if you used a logarithmic transformation of
the response level, you should also specify the log-transformed level of re-
sponse. You cannot use notation like 1log(1.5), but you have to calculate
that level of response yourself, in this case 0.1761.

If the inverse option is checked, the result will be expressed with the
units inverted. In the above example, you would get 2 TU/ED50 instead of
500 ED50/vial.
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7.9 Minimum and maximum number of iterations

In some cases, it may be desirable to put a maximum on the number of
iterations. By default, no value is specified, which makes CombiStats carry
out a practically unlimited amount of 23! — 1 = 2147483647 iterations. It
is always possible to interrupt the iterations by pressing the BREAK key
(or SHIFT + ESC), but if you want CombiStats to stop iterating at a well
defined maximum, you can specify a number.

It can also occur that you want to force CombiStats to carry out a fixed
minimum number of iterations, even if convergence has been reached at
earlier iterations. An example would be a weighting function depending on
the number of iterations like w=(i<100)+(i>=100)*(abs(e)<0.2), which
performs 100 unweighted iterations, but rejects values with a residual error
of more than 0.2 after 100 iterations.

7.10 Expressions

Expressions can contain the standard arithmetic operators such as multi-
plication (*), division (/), addition (+), subtraction (-) and exponentiation
(). In addition, you can use comparison operators, which evaluate to either
0, if the comparison is false, or to 1 if the comparison is true. The following
comparison operators are available:

> (greater than).

< (less than).

>= (greater than or equal to).
<= (less than or equal to).

= (equal to).

<> (not equal to).

The normal priority rules apply to the arithmetic operators. The comparison
operators have lower priority than any of the arithmetic operators and are
evaluated from left to right in case of equal priority. For example: The
expression 2+3<4x%5<>0 is interpreted as ((2+3)<(4%5))<>0 and evaluates
to 1. Use parentheses to overrule the priority rules. The constant 7 is
available as the keyword pi. For example, pi*y~2.

The following functions are available. They are always followed by one
argument between parentheses, which itself may again be a valid expression,
e.g. sqrt(abs(x)).

—z if z<0

abs The absolute value x = {  if £>0°
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acs

ang

angder

anginv
asn
atn
cos
exp
gmp
gmpder

gmpinv

lgt
lgtder
lgtinv
In

log
phi

phider

The arc cosine.

0 if <5
The angular distribution F(z) ={ 1+ isinz if -2 <z<Z
1 if >3
The first derivative of the angular distribution
0 if z<-3
Fl(z) =} Zcosz if -Z2<z<Z
0 if z>7%

The inverse of the angular distribution.
The arc sine.

The arc tangent.

The cosine.

The natural antilogarithm.

e®

The gompertz distribution F(z) =1 —e~
The first derivative of the gompertz distribution F'(z) = e*~¢".
The inverse of the gompertz distribution, also known as the gom-
pit .

The logistic distribution F'(x) = H—% .

-z

The first derivative of the logistic distribution F'(z) = (1-5@771‘)2

The inverse of the logistic distribution, also known as the logit .
The natural logarithm! log,.
The logarithm to base 10.

The standard normal distribution F(x):%ﬂ I e V' 2dy.

The first derivative of the standard normal distribution F'(z) =
2
1 —z°/2

(&
V2w

!The notation of logarithms is a notorious source of confusion. Mathematicians use
“log” to denote the natural logarithm whereas in many other scientific disciplines the
natural logarithm is written as “In”. To avoid confusion in this manual, we have adopted
the convention that the natural logarithm is written as “log,”. The logarithm to base 10
is written as “log” or “log,;,”. The notation “In” is not used in this manual, but a function
“In” can be used in CombiStats expressions.
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phiinv The inverse of the standard normal distribution, also known as
the normit or probit .

0 if z<—1
rec The rectangular distribution F(z) = ¢ 1 +2 if -3 <z <%
1 if x> %
recder The first derivative of the rectangular distribution
0 if z< -1
Flizy=q 1 if —3<z<3.
0 if z> %
recinv The inverse of the rectangular distribution.
sin The sine.
sqrt The square root.
tan The tangent.

To avoid computer overflow, the following bounds are used for distribution
functions F' and their first derivatives F’:

o F(z)>10"1,
o F(z)<1-10"1

o F'(z) > 1071,



Chapter 8

Computational detalils

8.1 Computational details

This chapter describes in detail the computational procedures that Combi-
Stats uses to perform the calculations. Let p denote the number of prepa-
rations (=number of tables), ¢ the number of doses per preparation and r
the number of replicates per preparation. CombiStats collects the data from
the tables in a design matrix X and an observation vector y’. The number
of rows of X and y’ is equal to pgr. The number of columns of X is equal
to p+ 1+ r + pg. If an observation is missing (i.e. cell is empty) or if it is
excluded (i.e. barred), the corresponding row of X is filled with 0’s as well
as the corresponding row of y’. For each observation, the first p columns
contain only 0’s except the column that relates to the corresponding sam-
ple, which is set to 1 if A = 0, or to dose® if A > 0. Column p + 1 contains
log,(dose) if A = 0, or 1 if A > 0. The next r columns contain only 0’s except
the column that relates to a specific block effect (of the replications), which
is set to 1. The last pg columns contain only 0’s except the column that
relates to a specific block effect (row or column in Latin squares). It should
be noted that all observations are considered to belong to the same block
(the first), in case of a completely randomised design, and that a similar
statement holds true for randomised block designs. Hence, the last r + pq
columns are only fully used in case of a (Latin) square design. The vector y’
is filled with the observations after applying the selected transformation (i.e.
y = f(y,z)), where f denotes the transformation, y the value before the
slash, and z the optional part after the slash). A vector of linear predictors
n, with the same size as y’, is initialised with only 0’s.

The iterations start here. A vector p of non-linear predictors is calculated
as u = d+ah(n), a vector  is calculated as ah’(n) where h denotes the inverse
link function, A’ its first derivative and d and a the non-linear parameters for
addition and multiplication respectively. A vector Y of linearized responses
is calculated as Y = n + (y' — p)¢~!. A diagonal matrix W* of weights
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is constructed on the basis of the specified weight function w. A diagonal
matrix W is calculated with W*(? on the diagonal. Negative weights are
set to 0 in both matrices.

When X, W, and Y are constructed, CombiStats continues with the
following steps:

e Calculation of the cross product X*WX, where X* denotes the trans-
posed matrix X.

e Calculation of the covariance matrix (X*WX)~, where — denotes the
generalized inverse matrix that contains 0’s in rows, which are linearly
dependent of the preceding set of rows, and similarly for the columns.

e Calculation of the vector of parameter estimates b = (X*WX) ™ (X*WY).

e Calculation of a new vector of linear predictors n = Xb. If ¢ and/or
d are not fixed, new values are calculated by performing a suitable
regression using weight W*.

The iterations are repeated until max; | i | < 1078, where 5} denotes 7;

[ni]+10—5
of the preceding cycle.

For each test sample T', the potency m relative to the standard S is
calculated as bTb§1 if A\ > 0 and as (by — bS)b;Jh if A = 0, where bg
and by denote the parameter estimates that relate to the standard and the
test preparation respectively, and b1 denotes the parameter estimate that
relates to the common parameter.

Tn the case of EDxx determinations, m is calculated as (h~!(xx) — by41) by!
if A > 0 and as (h=!(xx) — br) b];_i}l if A = 0. The relative confidence limits

my, and my are calculated using Fieller’s theorem:

v ts 2
mr, my = lm _9n2 \l v11 — 2mug + m2v9g — g <U11 - 12)] +(1—g)

V22 b V22

where b is the denominator used in the calculation of m, s is the square
root of the selected variance, ¢ is Student’s two-sided value (p=0.95) for the
number of degrees of freedom of the selected variance (oo if theoretical), v11,
v99 and vq9 are the variance multipliers of the numerator in the calculation
of m, the denominator and their covariance multiplier, and g = t?s2v99b~ 2.
The estimated potency is now found as /m if A > 0 and as e™ if A = 0.
Similar so for the confidence limits.

For the analysis of variance, the design matrix X, the final diagonal
matrix W and the linearized responses Y are now treated as a classical
weighted general linear model on which the linear hypotheses are tested. No
additional iterations are carried out. The non-linear parameters a and d are,
a posteriori, considered to be known and fixed and do no longer play a role
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in the analysis. The hat-matrix is calculated as W1/2X(Xt*WX)~ XtW1/2,
The analysis of variance is constructed as follows: For each of the hypotheses
to be tested, an appropriate design matrix X and a hypothesis matrix L
is constructed. The number of columns of L is equal to the number of
parameters fitted, and the number of rows of L is equal to the number of
degrees of freedom of the hypothesis. The sum of squares is then calculated
as S = (Lb)*(L(X*WX) Lt) " (Lb) where b = (X*WX) (X*WY) and
W is the final diagonal matrix as calculated above (the transformation is
supposed to be fixed, so that W and Y are taken as they appeared in the
final cycle. No new cycles are performed).

Seven types of matrices are constructed. Each matrix also takes account
of the block constraints in the last r + pg columns:

1. Xfixed: Assuming linear and parallel (if A = 0) or intersecting (if A > 0)
lines with a specified fixed common slope or intercept. This matrix has
p~+ 7+ pqg columns and is used to test for deviations from the common
parameter.

2. Xmodel: Assuming linear and parallel (if A = 0) or intersecting (if
A > 0) lines. This matrix has p+ 147+ pg columns and is used to test
for regression and deviations from model assumptions. It is identical
to the matrix used above.

3. Xiin: Assuming linear, but not necessarily parallel or intersecting lines.
This matrix has 2p + r + pg columns and is used to test for non-
parallelism or intersection.

4. Xquad: Assuming a common quadratic curvature. This matrix has
2p+ 1 4+ r + pq columns and is used to test for quadratic curvature.

5. Xprep: Assuming a dose independent response per sample. This matrix
has p + r + pg columns and is used to test for differences between
preparations.

6. Xplank: Assuming intersecting linear lines, allowing for an extra pa-
rameter for the blanks. This matrix has p + 2 + r + pq columns and is
used to test for blanks.

7. Xp: Assuming a full factorial model. This matrix has pg+ 1+ + pq
columns and is used to test for linearity, treatments, blocks, columns
and the full factorial hypothesis.

The hypothesis matrices are in general constructed in such a way that the
column of the first estimable parameter of interest is set to 1 and the other
columns are set in such a way as to express a meaningful hypothesis. For
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example, to test for parallelism in an assay with 1 standard and 2 test
samples, the hypothesis matrix would be constructed as:

I 0001 -1 0
0001 0 -1
where the first 3 columns relate to the 3 intercepts (unimportant for the
test), the next 3 columns relate to the 3 slopes (these are the parameters of
interest) and the subsequent columns relate to the block effects (unimportant
for the test, so they are all set to 0). The matrix expresses the simultaneous
hypothesis that bg — by = 0 and bg — by = 0. It should be noted that
the test for linearity is constructed from the distance between 3 doses where
the first 2 doses are taken to be fixed. For example, to test for linearity
of one sample with 4 equally spaced doses, the hypothesis matrix would be
constructed as:
-1 2 -1 0

L=1_93 o 1

where the first 4 columns relate to the treatments (the parameters of interest)
and the remaining columns relate to the block effects (unimportant for the
test, so set to 0). The matrix expresses the simultaneous hypothesis that
—dy 4+ 2d3 —d3 = 0 and —2d; + 3dy — d4 = 0.

Equivalence statistics are based on Xj;,. For models with A = 0, let
b7 denote the slope of any preparation and veo its variance multiplier. The
equivalence limits of the individual slopes are then calculated as by +ts,/v22,
where s is the square root of the selected variance and ¢ is Student’s two-
sided value (p = 0.90) for the number of degrees of freedom of the selected
variance (oo if theoretical). If a standard is included, let bg denote the slope
of the standard, vy its variance multiplier and vy the covariance multiplier,
then the equivalence limits of the difference between slopes is calculated as
by — bg & tsy/v11 + v — 2v15. The equivalence limits of the ratio of slopes
is calculated with Fieller’s theorem (see above) with m = E—g and b = bg.
For models with A > 0, the intercepts are used instead of the slopes but the
equations are the same. No ratio between intercepts is calculated because
this has no meaningful interpretation. It should be noted that equivalence
limits use the 2-sided probability level p = 0.90 instead of p = 0.95 as is
used for the confidence limits of potency. This is because equivalence tests
are intended to be used as 1-sided tests.
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Preferences

9.1 Introduction

You can configure several aspects of the global behaviour of CombiStats
through the ‘Preferences’ dialogue box (see figure 9.1). You can access the
preferences via the menu Options> Advanced > Preferences. You can modify
the location of your licence authorisation file, the location of your library of
templates, the default Internet address of the CombiStats website, several
features required in some quality controlled environments and miscellaneous
other options.

9.2 Location of passwords

By default, the file with information about your CombiStats licence is lo-
cated in the program directory. If your organisation owns multiple licences,
you may find it cumbersome to have to enter the licence details such as ex-
piry date, contact person and password on each individual computer. Even
though you are not allowed to install the CombiStats program on a central
server, you are allowed to store the licence details on a server, provided
this file is only accessed from within your organisation. You can do this by
moving the file ‘Authorisation’ from the program directory to a location of
your choice on a server. Typically you would make the file read-only for all
users except personnel responsible for updating the licence details. After
moving the file you have to tell CombiStats where to find it. You do this by
browsing to the new location of the passwords via the preferences dialogue
box. You have to do this only once on each computer.

9.3 Location of library of templates

Similar to the location of passwords, you may find it undesirable that indi-
vidual users have to maintain their own library of templates. Instead, you
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m Preferences @

Locations

Location of pazswords: | C:\Progiam Files (86 CombiStatsB0hAuthorizat _ Browse

Location of librany: |C:\F'rog|am Files [x36\CombiStatsE0MT emplates _Browse
URL of CombiStats site: |http:fz’combistats.edqm " Default
(A contials

I aximurn length of path of filename printed on each page: | Default
[ Print file zize on each page [~ Print file hash on each page (RIPEMD-160)
Use of colours in designs Protection of v4.0 and earlier files

" Mever use colours {+ Open files in read/write mode [Lv. 1]
(' Only in plate design ¢ Open files in read-only mode [Lv. 4]
" In all tables Paszword:

Use of colours on graphical devices Mizcellaneous

(* Only on screen W Show meszage for slow convergence
" Dn screen and printer W Enable UNDO functionality

Figure 9.1: The ‘Preferences’ dialogue box

can instruct CombiStats to look for the library on a central server. Typically
you would make that location read-only for all users except those who are
responsible for maintaining the library. If, in addition, you make sure that
the templates to which the library links are located on a read-only location,
you can be sure that nobody can accidentally alter a template and you can
be sure that everybody is always using the same and most recent version of
any given template.

It should be noted that this does not prevent users from modifying a tem-
plate once it is loaded into CombiStats, unless you use password protection
of the data sheet as described in sections 6.6 and 9.11.

9.4 The official CombiStats website

Although the EDQM has no intention to change the internet address of
the official CombiStats website, it cannot be excluded that this will never
happen. If it should happen, you can change the URL of the CombiStats
website via the Preferences. CombiStats will open this address in your de-
fault browser whenever you click on @ or the menu Help > Internet Homepage
or the shortcut CTRL+I.
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9.5 Print file name on each page

You can instruct CombiStats to print the file name at the bottom of each
page of the output. This way, it is easier to locate the original file on the
basis of archived print-outs. The number you put in the preferences indicates
the maximum path length you want to appear. Valid numbers are:

-1 Print full path.

0 Print nothing.

1 Print file name only.

>1 Print file name and parent directories up to the specified path
length.

9.6 Print file size on each page

You can instruct CombiStats to print the file size in bytes on each page of the
output by checking this option in the preferences. It should be noted that the
possibility exists that the output is printed after modifications were made to
the data without saving these modifications. In that case, it is impossible for
CombiStats to determine the file size and it will issue a warning that the file
size will not be printed, giving you the option to cancel the print command
so you can save the file first. If you ignore the warning and print the output
without saving, CombiStats will print the following message at the bottom
of each page: “Document was printed without saving modifications to disk.”

9.7 Print hash code of the file on each page

You can also instruct CombiStats to print a hash code on each page. The
hash code serves as a ‘fingerprint’ of the file. Even the smallest modification
to the file will result in a different hash code. It is therefore a very reliable
way to determine whether a file has not been altered after it was printed.
CombiStats uses a publicly available algorithm known as RIPEMD-160. To
check whether the hash code of a given CombiStats file is the same as the
hash code printed on a page, simply open the file in CombiStats and click
on the menu File>Hash RIPEMD-160 or use the shortcut CTRL+H. Alterna-
tively you can use third party software to generate the hash code without
having to open it in CombiStats. Suitable programs are abundantly available
from the Internet.

CombiStats generates a warning if you attempt to print the output with-
out first saving modifications to disk, giving you the option to cancel the
print command or print the file without hash code.



68 CHAPTER 9. PREFERENCES

9.8 Title 21 CFR Part 11

Title 21 CFR Part 11 defines the criteria under which electronic records and
electronic signatures are considered to be trustworthy, reliable and equiva-
lent to paper records. In case you want to send electronic records to regu-
lators, such as the FDA, you have to comply with Part 11 of the Code of
Federal Regulations of the United States of America. Inspectors, accredi-
tors and auditors, on other markets, may also require that you comply with
this rule. CombiStats offers the required technical controls of a compliant
system. However, it should be noted that Part 11 requires both procedural
controls (i.e. notification, training, SOPs, administration) and administra-
tive controls to be put in place by the user, in addition to the technical
controls that CombiStats can offer.

One of the easiest and most universally applicable ways to comply with
Part 11 is to use third party software such as Acrobat Distiller to transform
the CombiStats output to Portable Document Format (PDF) and to apply
your certified digital signature to the document using the Adobe product
suite. A popular standard in the bio-pharmaceutical industry is Signatures
and Authentication For Everyone (SAFE). This standard is supported by
Adobe Acrobat and certified digital signatures can be acquired from SAFE
BioPharma and other vendors.

In practice, you will probably not only archive the (digitally signed) PDF
version of the computer output, but also the original CombiStats file (the
master-file), and perhaps also a paper version. The link between the PDF
version, the paper version, and the master-file is made by the file name, the
file size and the hash code printed on each page. See sections 9.5 to 9.7 for
more details. An example of a hybrid configuration (i.e. a system in which
both electronic versions and paper versions are used) is illustrated in figure
9.2.

9.9 Use of colours in designs

CombiStats offers the possibility to display designs with colours as a visual
aid to assess the position of preparations in the layout. Up to a maximum of
12 preparations can be distinguished this way. Additional preparations will
be shaded in grey, as well as the cells containing labels instead of references.
The use of colours can be extended to all tables, be limited to the design
only, or be completely disabled. Furthermore, it is possible to enable or
disable the use of colours independently for screen and printer.



9.10. MISCELLANEOUS OTHER PREFERENCES 69

CombiStats master-file (EPA format)
001001011010101100010001001011
001011110100010110100110001011
000100101000000000011011000100
10000001110000

Apply public

———» algorithm
RIPEMD-160 to
produce hash

CombiStats output (PDF format) CombiStats output (Paper version)

Hash printed on each page Hash printed on each page

! !

Apply certified digital signature to PDF file
(e.g. Signatures and Authentication For Apply hand-written signature to paper
Everyone) output

Figure 9.2: Three document formats in a Part 11 compliant configuration

9.10 Miscellaneous other preferences

For non-linear models, convergence is not guaranteed or convergence may be
very slow. By default, a message is displayed after 1000 iterations, informing
the user of possible reasons for slow convergence. This message can be
disabled in the preferences.

The ‘Undo’ functionality, which can be accessed via the button ®, the
menu Edit>Undo or the shortcut CTRL+Z, are enabled by default. How-
ever, on some (older) computers, this functionality can noticeably slow down
respounsiveness of the software during data entry. If this happens to be the
case on your computer, you can disable the ‘Undo’ functionality in the pref-
erences to improve speed of data entry.

9.11 Protection of version 4.0 and earlier files

Data sheets and templates created with older versions of CombiStats are,
by default, opened in unprotected mode, because these files contain no in-
formation on data sheet protection. However, you can force CombiStats to
open these files in read-only mode (level 4 protection) by ticking the corre-
sponding box in the preferences and optionally specify a password. If you
place the preferences in a read-only location for your users, you can be sure
that they cannot alter the preferences and can only remove the protection
from legacy files using the default password you specified in the preferences.
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Appendix A

Examples

This appendix provides a large set of examples, which can be used to validate
the software in your hardware configuration or as inspiration to create your
own templates. They break down into three categories:

e Section A.l contains all examples published in the European Phar-
macopoeia, chapter 5.3 ‘Statistical Analysis of Results of Biological
Assays and Tests’.

e Section A.2 contains almost all numerical examples given by D.J.
Finney in his standard work ‘Statistical Method in Biological Assay,
3rd Edition, Griffin, London (1978)’.

e Section A.3 contains an additional multitude of examples taken from
practice or to illustrate different approaches and configurations.

The examples are not primarily intended to illustrate how a specific type of
assay or substance should be analysed. Indeed, some types of assays may
be obsolete or alternative statistical approaches may have come into use.
Instead, the examples are intended to provide a source of inspiration of how
templates can be configured to accommodate different types of data and
models.

All examples are installed on the hard-disk of your computer and can be
accessed by clicking on the button % depicting a light bulb.
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A.1 Examples from the European Pharmacopoeia

A.1.1 Example 5.1.1. (Including all samples)

(Gm851T; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
‘Project ‘Validation CombiStats version 7.0 ‘ ‘Remarks: Including all preparations. ‘ * *
‘Assay ‘Example 5.1.1 from the Ph. Eur. ‘ * *
* p X
Standard Sample 1 Sample 2
Id. S Id. T Id. u
Ass. pot. |1 unit/mg Ass. pot. |1 unit/mg Ass. pot. |1 unit/mg
Doses 0.25 unit | 1.0 unit Doses 0.25 unit | 1.0 unit Doses 0.25 unit | 1.0 unit
1) 300 289 1) 310 230 (1) 250 236
) 310 221 ) 290 210 (2) 268 213
(3) 330 267 (3) 360 280 (3) 273 283
(4) 290 236 (4) 341 261 (4) 240 269
(5) 364 250 (5) 321 241 (5) 307 251
(6) 328 231 (6) 370 290 (6) 270 294
7) 390 229 @) 303 223 (7) 317 223
(8) 360 269 (8) 334 254 8) 312 250
9) 342 233 9) 295 216 9) 320 216
(10) 306 259 (10) 315 235 (10) 265 265
Model: Parallel lines Common slope(factor) = -47.0559 (-55.6804 to -38.4314)
Design: Completely randomised Correlation | r |: 0.765367

Transformation: y' =y
Variance: Observed residuals

Source of variation Degrees of freedom | Sum of squares | Mean square F-ratio Probability
Preparations 2 6256.63 3128.32 4.086 0.022 (%)
Regression 1 63830.8 63830.8 83.377 0.000  (***)
Non-parallelism 2 8218.23 4109.12 5.367 0.007  (**)
Treatments 5 78305.7 15661.1 20.457 0.000  (***)
Residual error 54 41340.9 765.572
Total 59 119647 2027.91

Sample 1 Sample 2

Id. T Id. U
(unit/mg) Lower limit | Estimate | Upper limit (unit/mg) Lower limit | Estimate | Upper limit
Potency 0.783648 | 1.14205 1.68690 Potency 1.14813 1.66889 2.55503
Rel. to Ass. 78.4% 114.2% 168.7% Rel. to Ass. 114.8% 166.9% 255.5%
Rel. to Est. 68.6% 100.0% 147.7% Rel. to Est. 68.8% 100.0% 153.1%

All samples Standard Sample 1 Sample 2

S T U

Executed by: Calculated by: Approved by:

Filename: ...\A101 PhEur Ex 511 PLA 3 Sples.epa. ID: EDQM/DBO/FRA




.
A.1.2 Example 5.1.1. (Excluding sample U)
(G851t \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
‘Project ‘Validation CombiStats version 7.0 ‘ ‘Remarks: Including only preparation T and the Standard. * *
Assa Example 5.1.1 from the Ph. Eur. * *
[Assay [Examp * 4 Kk
Standard Sample 1 Sample 2

Id. S Id. T Id. U
Ass. pot. |1 unit/mg Ass. pot. |1 unit/mg Ass. pot. |1 unit/mg
Doses 0.25 unit | 1.0 unit Doses 0.25 unit | 1.0 unit Doses 0.25 unit | 1.0 unit

(1) 300 289 (1) 310 230 (1) 250 236

2) 310 221 2) 290 210 2) 268 213

(3) 330 267 (3) 360 280 (3) 273 283

(4) 290 236 (4) 341 261 (4) 240 269

(5) 364 250 (5) 321 241 (5) 307 251

(6) 328 231 (6) 370 290 (6) 270 294

) 390 229 (7) 303 223 ) 317 223

(8) 360 269 (8) 334 254 (8) 312 250

(9) 342 233 (9) 295 216 (9) 320 216

(10) 306 259 (10) 315 235 (10) 265 265
Model: Parallel lines Common slope(factor) = -58.9702 (-69.4361 to -48.5042)

Design: Completely randomised
Transformation: y' =y
Variance: Observed residuals

Correlation | r |: 0.846356

All samples Standard Sample 1
S T

Executed by: Calculated by: Approved by:

Filename: ...\A102 PhEur Ex 511 PLA 2 Sples.epa. ID: EDQM/DBO/FRA

Source of variation Degrees of freedom | Sum of squares Mean square F-ratio Probability
Preparations 1 390.625 390.625 0.529 0472
Regression 1 66830.6 66830.6 90.491 0.000 (***)
Non-parallelism 1 34.2250 34.2250 0.046 0.831
Treatments 3 67255.5 22418.5 30.355 0.000 (***)
Residual error 36 26587.3 738.536
Total 39 93842.8 2406.23

Sample 1
Id. T
(unit/mg) Lower limit | Estimate | Upper limit
Potency 0.824973 1.11181 1.51357
Rel. to Ass. 82.5% 111.2% 151.4%
Rel. to Est. 74.2% 100.0% 136.1%
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A.1.3 Example 5.1.2.

[omE5Iat; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 2 * * *
*
‘Project ‘Validation CombiStats version 7.0 ‘ ‘Remarks: ‘ ** *
‘Assay ‘Example 5.1.2 from the Ph. Eur. ‘ * N "
Standard Sample 1
Id. S Id. T
Ass. pot. 4855 1U/mg Ass. pot. 5600 IU/mg
Reconsitution |25.2 mg/24.5 ml Reconsitution |21.4 mg/23.95 ml
Doses 1/45 | 1/30 | 1/20 Doses 1/45 | 1/30 | 1/20
(1) 161 | 171 | 187 1) 160 | 178 | 194
B 150 | 172 | 192 2) 151 | 170 | 192
3) 161 | 174 | 195 (3) 151 | 162 | 193
(4) 163 | 184 | 194 (4) 160 | 171 | 199
(5) 151 | 176 | 201 (5) 154 | 181 | 202
(6) 166 | 182 | 198 (6) 161 | 186 | 193
Design | (A) | (B) | (C) | (D) | (E) | (F) Observ. | (A) | (B) | (C) | (D) | (E) | (F)
(1) 1] 211]212]13] 12|23 (1) 161 | 160 | 178 | 187 | 171 | 194
(2 |211]213]11]12]2]2]1]3 (2) 151 ] 192 | 150 | 172 | 170 | 192
(3) |22[13[ 12 11]2]3]2/1 (3) 162 | 195 | 174 | 161 | 193 | 151
4) 13112213 2[1]1]1] 22 4) 194 | 184 | 199 | 160 | 163 | 171
(65) [102]212[13] 213211 | 11 (5) | 176 [ 181|201 | 202 | 154 | 151
6) 21311 211]22]113] 12 (6) | 193|166 | 161 | 186 | 198 | 182

Model: Parallel lines Common slope(factor) = 46.3460 (42.3892 to 50.3027)

Design: (Latin) square Correlation | r |: 0.976750
Transformation: y' =y

Variance: Observed residuals

Filename: ..\A103 PhEur Ex 512 PLA Latin.epa. ID: EDQM/DBO/FRA

Source of variation Degrees of freedom Sum of squares Mean square F-ratio Probability
Preparations 1 111111 11.1111 0.535 0.473
Regression 1 8475.04 8475.04 408.108 0.000 (***)
Non-parallelism 1 18.3750 18.3750 0.885 0.358
Non-linearity 2 5.47222 2.73611 0.132 0.877

Standard 1 0.0277778 0.0277778 0.001 0.971

Sample 1 1 5.44444 5.44444 0.262 0.614
Treatments 5 8510.00 1702.00 81.958 0.000 (***)
Rows 5 412.000 82.4000 3.968 0.012 (1)
Columns 5 218.667 43.7333 2.106 0.107
Residual error 20 415.333 20.7667
Total 35 9556.00 273.029

Sample 1
Id. T
(IU/mg) Lower limit | Estimate | Upper limit
Potency 5092.37 | 5456.37 | 5843.36
Rel. to Ass. 90.9% 97.4% 104.3%
Rel. to Est. 93.3% 100.0% 107.1%
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[omE5Iat; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 2 of 2 * * *
*
‘Project ‘Validation CombiStats version 7.0 ‘ *
*
‘Assay ‘Example 5.1.2 from the Ph. Eur. ‘ * . *

All samples Standard Sample 1
S T

Executed by: Calculated by: Approved by:

Filename: ...\A103 PhEur Ex 512 PLA Latin.epa. ID: EDQM/DBO/FRA
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A.1.4 Example 5.1.3.

[omE5Iat; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
‘Project ‘Validation CombiStats version 7.0 ‘ ‘Remarks: ‘ * *
‘Assay ‘Example 5.1.3 from the Ph. Eur. ‘ * *
* ok
Standard Sample 1
Id. S Id. T
Ass. pot. 670 IU/mg Ass. pot. 20000 IU/vial
Reconsitution |16.7 mg/25ml Reconsitution |1 vial/40 ml
Pre-dilution 1 ml/40 mi Pre-dilution 1 ml/40 ml
Doses S1|S2 | 83| s4 Doses T | T2 | T3 | T4
(1) 252 | 207 | 168 | 113 1) 242|206 | 146 | 115
(2) 249 | 201 | 187 | 107 (2) 236 | 197 | 153 | 102
(3) 247|193 | 162 | 111 (3) 246 | 197 | 148 | 104
4) 250 | 207 | 155 | 108 (4) 231|191 | 159 | 106
(5) 235|207 | 140 | 98 (5) 232 | 186 | 146 | 95
Model: Parallel lines Common slope(factor) = -111.255 (-115.612 to -106.898)
Design: Randomised block Correlation | r |: 0.991424
Transformation: y' =y
Variance: Observed residuals
Dilution step (Increasing): 1.5
Source of variation Degrees of freedom | Sum of squares Mean square F-ratio Probability
Preparations 1 632.025 632.025 11.722 0.002  (*)
Regression 1 101746 101746 >1000 0.000  (***)
Non-parallelism 1 25.2050 25.2050 0.467 0.500
Non-linearity 4 259.140 64.7850 1.202 0.332
Standard 2 238.140 119.070 2.208 0.129
Sample 1 2 21.0000 10.5000 0.195 0.824
Treatments 7 102662 14666.0 272.015 0.000  (***)
Blocks 4 876.750 219.188 4.065 0.010 (%)
Residual error 28 1509.65 53.9161
Total 39 105048 2693.55
Sample 1
Id. T
(IUMvial) Lower limit | Estimate | Upper limit
Potency 18423.4 19228.5 20075.2
Rel. to Ass. 92.1% 96.1% 100.4%
Rel. to Est. 95.8% 100.0% 104.4%
All samples Standard Sample 1
S T
Executed by: Calculated by: Approved by:

Filename: ...\A104 PhEur Ex 513 PLA Blocks.epa. ID: EDQM/DBO/FRA
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A.1.5 Example 5.1.4.
[EmE5IaT; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 2 * * *
* *
‘Project ‘Validation CombiStats version 7.0 ‘ ‘Remarks: ‘ i :
‘Assay ‘Example 5.1.4 from the Ph. Eur. ‘ * . *
Standard Sample 1 Sample 2
Id. S Id. T Id. U
Ass. pot. |20 pg protein/ml Ass. pot. |20 pg protein/ml Ass. pot. |20 pg protein/ml
Doses 1) (2) 3) Doses (1) ) 3) Doses (1) (2) 3)
1/16000 | 0.043 | 0.045 | 0.051 1/16000 | 0.097 | 0.097 | 0.094 1/16000 | 0.086 | 0.071 | 0.073
1/8000 | 0.093 | 0.099 | 0.082 1/8000 | 0.167 | 0.157 | 0.178 1/8000 | 0.127 | 0.146 | 0.133
1/4000 | 0.159 | 0.154 | 0.166 1/4000 | 0.327 | 0.355 | 0.345 1/4000 | 0.277 | 0.268 | 0.269
1/2000 | 0.283 | 0.295 | 0.362 1/2000 | 0.501 | 0.665 | 0.576 1/2000 | 0.586 | 0.489 | 0.546
1/1000 | 0.514 | 0.531 | 0.545 1/1000 | 1.140 | 1.386 | 1.051 1/1000 | 0.957 | 0.866 | 1.045
Sample 3
Id. \4
Ass. pot. |20 pg protein/ml
Doses 1) 2) 3)
1/16000 | 0.082 | 0.082 | 0.086
1/8000 | 0.145 | 0.144 | 0.173
1/4000 | 0.318 | 0.306 | 0.316
1/2000 | 0.552 | 0.551 | 0.624
1/1000 | 1.037 | 1.039 | 1.068

Model: Parallel lines
Design: Completely randomised

Common slope(factor) = 0.908479 (0.890357 to 0.926601)

Transformation: y' = In(y)

Variance: Observed residuals

Correlation | r |: 0.996560

Filename: ...\A105 PhEur Ex 514 PLA LogY.epa. ID: EDQM/DBO/FRA

Source of variation Degrees of freedom Sum of squares Mean square F-ratio Probability
Preparations 3 4.47522 1.49174 223.392 0.000 (***)
Regression 1 47.5841 47.5841 >1000 0.000 (***)
Non-parallelism 3 0.0186856 0.00622854 0.933 0.434
Non-linearity 12 0.0742323 0.00618603 0.926 0.531

Standard 3 0.0170324 0.00567748 0.850 0.475

Sample 1 3 0.0282553 0.00941843 1.410 0.254

Sample 2 3 0.0177542 0.00591808 0.886 0.456

Sample 3 3 0.0111903 0.00373012 0.559 0.645
Treatments 19 52.1523 2.74486 411.049 0.000 (***)
Residual error 40 0.267107 0.00667768
Total 59 52.4194 0.888464

Sample 1 Sample 2
Id. T Id. U
(pg protein/ml) | Lower limit | Estimate | Upper limit (pg protein/ml) | Lower limit | Estimate | Upper limit
Potency 40.5448 | 43.4196 | 46.5397 Potency 32.8698 | 35.1630 | 37.6405
Rel. to Ass. 202.7% 217.1% 232.7% Rel. to Ass. 164.3% 175.8% 188.2%
Rel. to Est. 93.4% 100.0% 107.2% Rel. to Est. 93.5% 100.0% 107.0%
Sample 3
Id. Vv
(g protein/ml) | Lower limit | Estimate | Upper limit
Potency 36.8125 39.4017 42.2057
Rel. to Ass. 184.1% 197.0% 211.0%
Rel. to Est. 93.4% 100.0% 107.1%
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(Bms51al; Version 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 2 of 2

‘Project ‘Validation CombiStats version 7.0 ‘
‘Assay ‘Example 5.1.4 from the Ph. Eur. ‘

All samples Standard Sample 1 Sample 2
S T u

Sample 3
Vv

Executed by: Calculated by: Approved by:

Filename: ..\A105 PhEur Ex 514 PLA LogY.epa. ID: EDQM/DBO/FRA

* % %

* 4 %

* 4 Kk




Model: Slope ratio

Design: Completely randomised

Transformation: y' =y

Variance: Observed residuals
Number of non-zero doses (Increasing): 3

Common intercept = 0.0529792 (0.0517177 to 0.0542406)

Correlation | r |: 0.999518

Executed by:

Calculated by:

Approved by:

Filename: ...\A106 PhEur Ex 521 Slope Ratio.epa. ID: EDQM/DBO/FRA

Source of variation Degrees of freedom Sum of squares Mean square F-ratio Probability
Regression 2 0.191697 0.0958483 >1000 0.000  (***)
Intersection 1 2.97619E-09 2.97619E-09 0.001 0.978
Non-linearity 2 2.30208E-05 1.15104E-05 2.984 0.061

Standard 1 3.33333E-07 3.33333E-07 0.086 0.770

Sample 1 1 2.26875E-05 2.26875E-05 5.882 0.020 (%)
Treatments 5 0.191720 0.0383439 >1000 0.000  (***)
Residual error 42 0.000162000 3.85714E-06
Total 47 0.191882 0.00408259

Sample 1
Id. T
(RP/volume) | Lower limit| Estimate | Upper limit
Potency 0.817091 | 0.823146 | 0.829213
Rel. to Ass. ? ? ?
Rel. to Est. 99.3% 100.0% 100.7%
All samples Stargjard Sample 1
T

A.1.6 Example 5.2.1.
[6mE%1at; Version 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
‘Project ‘Validation CombiStats version 7.0 ‘ ‘Remarks: ‘ * *
Assay |Example 5.2.1 from the Ph. Eur. * *
[Assay [Examp * 5k
Standard Sample 1 Sample 2
Id. S Id. T Id. Blank
Ass. pot. |1 RP/volume Ass. pot. |? RP/volume Ass. pot. |0 RP/volume
Doses $1 S2 S3 Doses T T2 T3 Doses B
(1) 0.133 | 0.215 | 0.299 1) 0.120 | 0.188 | 0.254 (1) 0.022
(2) 0.133 | 0.215 | 0.299 2) 0.119 | 0.188 | 0.253 (2) 0.024
3) 0.131] 0.216 | 0.299 3) 0.118 | 0.190 | 0.255 (3) 0.024
(4) 0.136 | 0.218 | 0.297 4) 0.120 | 0.190 | 0.258 (4) 0.026
(5) 0.137 | 0.220 | 0.297 (5) 0.120 | 0.190 | 0.257 (5) 0.023
(6) 0.136 | 0.220 | 0.305 (6) 0.121 | 0.191 | 0.257 (6) 0.022
7) 0.138 | 0.219 | 0.299 @) 0.121 | 0.191 | 0.255 7) 0.022
(8) 0.137 | 0.218 | 0.302 (8) 0.121 | 0.190 | 0.254 (8) 0.023
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A.1.7 Example 5.2.2.
[omE5Iat; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
‘Project ‘Validation CombiStats version 7.0 ‘ ‘Remarks:
|Assay |Example 5.2.2 from the Ph. Eur. | N~
Standard Sample 1 Sample 2
Id. S Id. T Id. u
Ass. pot. 39 pg HA/ml Ass. pot. 15 ug HA/dose Ass. pot. 15 ug HA/dose
Doses (1) (2) Doses (1) (2) Doses (1) )
75ugHA | 180 | 18.0 75ugHA | 151 | 168 75ugHA | 154 | 157
15.0ygHA | 228 245 15.0 ygHA | 231 242 15.0ygHA | 20.2 18.6
225ugHA | 304 | 304 225ugHA | 289 | 274 225ugHA | 242 | 2341
300 ugHA | 357 | 366 300 uygHA | 344 | 378 300ugHA | 274 | 270
Model: Slope ratio Common intercept = 11.0417 (10.1208 to 11.9626)
Design: Completely randomised Correlation | r |: 0.990326
Transformation: y' =y
Variance: Observed residuals
Source of variation Degrees of freedom Sum of squares Mean square F-ratio Probability
Regression 3 1087.67 362.555 339.498 0.000  (***)
Intersection 2 3.47389 1.73694 1.626 0.237
Non-linearity 6 5.06550 0.844250 0.791 0.594
Standard 2 0.446000 0.223000 0.209 0.814
Sample 1 2 4.45350 2.22675 2.085 0.167
Sample 2 2 0.166000 0.0830000 0.078 0.926
Treatments 1 1096.20 99.6550 93.317 0.000  (***)
Residual error 12 12.8150 1.06792
Total 23 1109.02 48.2182
Sample 1 Sample 2
Id. T Id. U
(ug HA/dose) | Lower limit | Estimate | Upper limit (g HA/dose) | Lower limit | Estimate | Upper limit
Potency 13.3681 14.2920 15.2711 Potency 8.85416 9.72948 10.6088
Rel. to Ass. 89.1% 95.3% 101.8% Rel. to Ass. 59.0% 64.9% 70.7%
Rel. to Est. 93.5% 100.0% 106.9% Rel. to Est. 91.0% 100.0% 109.0%
All samples Standard Sample 1 Sample 2
S T V]

Executed by:

Filename: ..\A107 PhEur Ex 522 Slope Ratio.epa. ID: EDQM/DBO/FRA

Calculated by:

Approved by:
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A.1.8 Example 5.3.1. (Probits)
(8515t \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
‘Project ‘Validation CombiStats version 7.0 ‘ ‘Remarks: ‘ * *
‘Assay ‘Example 5.3.1 from the Ph. Eur. * *
* 4 x
Standard Sample 1
Id. S Id. T
Ass. pot. |132 IU/vial Ass. pot. | 140 IU/vial
Doses 1) Doses 1)
1.01U 0/12 1.01U 011
1.6 1U 3/12 1.6 1U 412
251U 6/12 251U 8/11
4.01U 10/11 4.01U 10/11
Model: Quantal responses Common slope(factor) = 2.40106 (1.72350 to 3.07863)
Design: Completely randomised Correlation | r |: 0.972904 (Weighted)
Transformation: y' = probit(y)
Theoretical variance: 1
Source of variation Degrees of freedom Sum of squares Mean square Chi-square Probability
Preparations 1 0.0662677 0.0662677 0.0662677 0.797
Regression 1 33.9751 33.9751 33.9751 0.000 (***)
Non-parallelism 1 0.00103833 0.00103833 0.00103833 0.974
Non-linearity 4 1.92149 0.480374 1.92149 0.750
Standard 2 0.851298 0.425649 0.851298 0.653
Sample 1 2 1.07020 0.535098 1.07020 0.586
Treatments 7 35.9639 5.13770 35.9639 0.000 (***)
Theoretical variance 1.00000
Total 7 35.9639 5.13770
Sample 1
Id. T
(IUMvial) Lower limit | Estimate | Upper limit
Potency 120.966 160.597 215.156
Rel. to Ass. 86.4% 114.7% 153.7%
Rel. to Est. 75.3% 100.0% 134.0%
All samples Standard Sample 1
S T
Executed by: Calculated by: Approved by:

Filename: ...\A108 PhEur Ex 531 Quantal Probit.epa. ID: EDQM/DBO/FRA




Standard Sample 1

Id. S Id. T

Ass. pot. |132 IU/vial Ass. pot. | 140 IU/vial

Doses (1) Doses (1)
1.01U 0/12 1.01U 0/11
1.6 1U 3/12 1.6 1U 4/12
251U 6/12 251U 8/11
4.01U 10/11 4.01U 10/11

Model: Quantal responses

Design: Completely randomised

Transformation: y* = logit(y)
Theoretical variance: 1

Common slope(factor) = 4.10143 (2.78838 to 5.41448)
Correlation | r |: 0.961543 (Weighted)

Executed by:

Calculated by:

Approved by:

Filename: ...\A109 PhEur Ex 532 Quantal Logit.epa. ID: EDQM/DBO/FRA

Source of variation Degrees of freedom Sum of squares Mean square Chi-square Probability
Preparations 1 0.0407131 0.0407131 0.0407131 0.840
Regression 1 26.3975 26.3975 26.3975 0.000 (***)
Non-parallelism 1 0.00662306 0.00662306 0.00662306 0.935
Non-linearity 4 2.15046 0.537614 2.15046 0.708

Standard 2 1.09388 0.546940 1.09388 0.579
Sample 1 2 1.05658 0.528288 1.05658 0.590
Treatments 7 28.5953 4.08504 28.5953 0.000 (***)
Theoretical variance 1.00000
Total 7 28.5953 4.08504
Sample 1
Id. T
(IUMvial) Lower limit | Estimate | Upper limit
Potency 121.131 162.859 221.106
Rel. to Ass. 86.5% 116.3% 157.9%
Rel. to Est. 74.4% 100.0% 135.8%
All samples Stavgjard Sam_IE)Ie 1

APPENDIX A. EXAMPLES
A.1.9 Example 5.3.2. (Logits)
(58515 \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
‘Project ‘Validation CombiStats version 7.0 ‘ ‘Remarks: Using the logit curve. ‘ * *
‘Assay ‘Example 5.3.2 from the Ph. Eur. ‘ * *
* x X
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A.1.10 Example 5.3.2. (Gompits)

(8515t \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
‘Project ‘Validation CombiStats version 7.0 ‘ ‘Remarks: Using the gompit curve. ‘ * *
Assa Example 5.3.2 from the Ph. Eur.
‘ y ‘ p * % *
Standard Sample 1
Id. S Id. T
Ass. pot. |132 IU/vial Ass. pot. | 140 IU/vial
Doses 1) Doses 1)
1.01U 0/12 1.01U 011
1.6 1U 3/12 1.6 1U 412
251U 6/12 251U 8/11
4.01U 10/11 4.01U 10/11
Model: Quantal responses Common slope(factor) = 2.58975 (1.84355 to 3.33595)
Design: Completely randomised Correlation | r |: 0.947395 (Weighted)

Transformation: y' = gompit(y)
Theoretical variance: 1

Source of variation Degrees of freedom Sum of squares Mean square Chi-square Probability
Preparations 1 0.0741711 0.0741711 0.0741711 0.785
Regression 1 32.5883 32.5883 32.5883 0.000 (***)
Non-parallelism 1 0.168073 0.168073 0.168073 0.682
Non-linearity 4 3.55983 0.889958 3.55983 0.469

Standard 2 0.935250 0.467625 0.935250 0.626
Sample 1 2 2.62458 1.31229 2.62458 0.269
Treatments 7 36.3904 5.19863 36.3904 0.000 (***)
Theoretical variance 1.00000
Total 7 36.3904 5.19863
Sample 1
Id. T
(IUMvial) Lower limit | Estimate | Upper limit
Potency 118.708 158.313 213.296
Rel. to Ass. 84.8% 113.1% 152.4%
Rel. to Est. 75.0% 100.0% 134.7%

All samples Standard Sample 1
S T

Executed by: Calculated by: Approved by:

Filename: ...\A110 PhEur Ex 532 Quantal Gompit.epa. ID: EDQM/DBO/FRA




Standard Sample 1

Id. S Id. T

Ass. pot. |132 IU/vial Ass. pot. | 140 IU/vial

Doses (1) Doses (1)
1.01U 0/12 1.01U 0/11
1.6 1U 3/12 1.6 1U 4/12
251U 6/12 251U 8/11
4.01U 10/11 4.01U 10/11

Model: Quantal responses

Design: Completely randomised

Transformation: y' = angle(y)

Theoretical variance: 1

Common slope(factor) = 1.71688 (1.38077 to 2.05299)
Correlation | r |: 0.989663 (Weighted)

Executed by:

Calculated by:

Approved by:

Filename: ...\A111 PhEur Ex 532 Quantal Angular.epa. ID: EDQM/DBO/FRA

Source of variation Degrees of freedom Sum of squares Mean square Chi-square Probability
Preparations 1 0.924441 0.924441 0.924441 0.336
Regression 1 70.5948 70.5948 70.5948 0.000 (***)
Non-parallelism 1 0.000995470 0.000995470 0.000995470 0.975
Non-linearity 4 1.50079 0.375196 1.50079 0.827

Standard 2 0.426808 0.213404 0.426808 0.808
Sample 1 2 1.07398 0.536989 1.07398 0.585
Treatments 7 73.0210 10.4316 73.0210 0.000 (***)
Theoretical variance 1.00000
Total 7 73.0210 10.4316
Sample 1
Id. T
(IUMvial) Lower limit | Estimate | Upper limit
Potency 122.589 155.812 200.720
Rel. to Ass. 87.6% 111.3% 143.4%
Rel. to Est. 78.7% 100.0% 128.8%
All samples Stavgjard Sam_IE)Ie 1

APPENDIX A. EXAMPLES
A.1.11 Example 5.3.2. (Angles)
(58515 \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
‘Project ‘Validation CombiStats version 7.0 ‘ ‘Remarks: Using the angle curve. ‘ * *
‘Assay ‘Example 5.3.2 from the Ph. Eur. ‘ * *
* x X




A.l1. EXAMPLES FROM THE EUROPEAN PHARMACOPOEIA 85

A.1.12 Example 5.3.3.

[6mE%1at; Version 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
*
[Project [Validation CombiStats version 7.0 |  [Remarks: | *
|Assay |Example 5.3.3 from the Ph. Eur. -
Sample 1

Ass. pot. ? log10 ED50/ml
Conversion 1ml/1000pl
Volume applied |50 pl/well
Doses -3.5log | -4.0log | -4.5log | -5.0log | -5.5log | -6.0 log | -6.5 log | -7.0 log | -7.5 log | -8.0 log

(1) + + + + - - - - - -

2) + + + - - - - - -

3) + + - - - - - - - -

4) + + + + - - - - - -

(5) + + + - - - - - -

(6) + + + + + - - - - -

(7) + + + + + - + - - -

8) + + + + - + - - - -
Model: Determination ED50 Common slope(factor) = 0.646230 (0.426197 to 0.866263)
Design: Completely randomised Correlation | r |: 0.549840 (Weighted)
Transformation: y' = probit(y)
Theoretical variance: 1

Source of variation Degrees of freedom Sum of squares Mean square Chi-square Probability
Regression 1 23.3374 23.3374 23.3374 0.000  (***)
Non-linearity 8 271119 0.338899 271119 0.951
Treatments 9 26.0486 2.89429 26.0486 0.002  (*)
Residual error 70 51.1447 0.730639 51.1447 0.956
Theoretical variance 1.00000
Total 79 77.1933 0.977130
Sample 1
(log10 ED50/ml) | Lower limit | Estimate | Upper limit
log10 ED50/ml 6.30328 6.63128 6.95780
Rel. to Ass. ? ? ?
Rel. to Est. -0.328001 0.00000 | +0.326519
Sample 1

Executed by: Calculated by: Approved by:

Filename: ..\A112 PhEur Ex 533 Quantal ED50.epa. ID: EDQM/DBO/FRA
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A.1.13 Example 5.3.3. (Alternative)

(Em8575%; Version 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1
*
‘Project ‘Validation CombiStats version 7.0 ‘ Remarks: This example uses the advanced options to convert the *
‘Assay ‘Example 5.3.3 from the Ph. Eur. ‘ rpeossy?tci)yes)es to their complements (i.e. reversing the role of negative and *
Sample 1

Ass. pot. ? log10 ED50/ml
Conversion 1ml/1000pl
Volume applied |50 pl/well
Doses -3.5log | -4.0log | -4.5log | -5.0log | -5.5log | -6.0 log | -6.5log | -7.0 log | -7.5 log | -8.0 log

1) + + + + - - - - - -

) + + + - - - - - -

(3) + + B B B B B B B

4) + + + + - - - - - -

(5) + + + - - - - -

(6) + + + + + - - - - -

(7) + + + + + - + - - -

(8) + + + + - + - - - -

Model: (n-r)/n=(phi(x)) where x=c.+b*In(dose)
Design: Completely randomised

Weight function: w=n/(m*(1-m))

Theoretical variance: 1

Common slope(factor): b = -0.646230 (-0.866263 to -0.426197)
Correlation | r |: 0.549840 (Weighted)

Source of variation Degrees of freedom Sum of squares Mean square Chi-square Probability
Regression 1 23.3374 23.3374 23.3374 0.000 (***)
Non-linearity 8 2.71119 0.338899 2.71119 0.951
Treatments 9 26.0486 2.89429 26.0486 0.002  (*)
Residual error 70 51.1447 0.730639 51.1447 0.956
Theoretical variance 1.00000
Total 79 77.1933 0.977130

Sample 1
(log10 ED50/ml) | Lower limit | Estimate | Upper limit
log10 ED50/ml 6.30328 6.63128 6.95780
Rel. to Ass. ? ? ?
Rel. to Est. -0.328001 0.00000 | +0.326519
Sample 1
Executed by: Calculated by: Approved by:

Filename: ...\A113 PhEur Ex 533 Quantal ED50 alt.epa. ID: EDQM/DBO/FRA




Model: Sigmoid curves

Design: Completely randomised

Transformation: y' = logit(y)

Variance: Observed residuals
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A.1.14 Example 5.4.1.
[6mE%1at; Version 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
‘Project ‘Validation CombiStats version 7.0 ‘ ‘Remarks: ‘ * *
|Assay |Example 5.4.1 from the Ph. Eur. ** . **
Standard Sample 1
Ass. pot. [0.4 1U/ml Ass. pot. |? IU/ml
Doses (1) (2) Doses 1) )
1/10 2912|2917 1/10 3.017 | 2.987
1/20 2.579 | 2.654 1/20 2.801 | 2.808
1/40 2.130 | 2.212 1/40 2.401 | 2.450
1/80 1.651 | 1.638 1/80 1.918 | 1.963
1/160 1.073 ] 0.973 1/160 1.364 | 1.299
1/320 | 0.585 | 0.666 1/320 | 0.861 | 0.854
1/640 | 0.463 | 0.356 1/640 | 0.497 | 0.496
1/1280 | 0.266 | 0.234 1/1280 | 0.340 | 0.344
1/2560 | 0.228 | 0.197 1/2560 | 0.242 | 0.217
1/5120 | 0.176 | 0.215 1/5120 | 0.178 | 0.125

Common slope(factor) = 1.12452 (1.10175 to 1.14729)
Correlation | r |: 0.997815 (Weighted), 0.999510 (Unweighted)
Asymptotes: 0.145458 and 3.19599

Executed by:

Calculated by:

Approved by:

Filename: ...\A114 PhEur Ex 541 4PL Sigmoid.epa. ID: EDQM/DBO/FRA

Source of variation Degrees of freedom Sum of squares Mean square Chi-square Probability
Preparations 1 0.000756861 0.000756861 0.529653 0.467
Regression 1 9.43054 9.43054 6599.51 0.000  (***)
Non-parallelism 1 6.55525E-05 6.55525E-05 0.0458738 0.830
Non-linearity 16 0.0127084 0.000794275 8.89337 0.918

Standard 8 0.00764179 0.000955224 5.34774 0.720
Sample 1 8 0.00506661 0.000633326 3.54562 0.896
Treatments 19 9.44407 0.497056 6608.98 0.000  (***)
Residual error 20 0.0285795 0.00142897
Total 39 9.47265 0.242888
Sample 1
(IU/ml) Lower limit | Estimate | Upper limit
Potency 0.556798 | 0.583544 | 0.611586
Rel. to Ass. ? ? ?
Rel. to Est. 95.4% 100.0% 104.8%
All samples Standard Sample 1
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A.1.15 Example 6.4.

[em857aT5 \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * X %

* *
Project | Validation CombiStats version 7.0 ‘Remarks: ‘ * *
Assay Example 6.4 from the Ph. Eur. * . « *
Ass. pot. |? IUMvial *

Assay | Sample | Info | Lower limit | Estimate | Upper limit | df
Test | 17755.0 18367.0 | 19002.0 |20
Test | 17415.0 18003.0 | 18610.0 |20
Test | 17319.0 18064.0 | 18838.0 |20
Test | 17253.0 17832.0 | 18429.0 |20
Test | 17959.0 18635.0 | 19339.0 |20
Test | 17722.0 18269.0 | 18834.0 |20

oa[sfw[Nn]=

Geometric combination
Homogeneity: p = 0.491

Weighted combination Semi-weighted combination
(IUMvial) Lower limit | Estimate | Upper limit (IU/vial) Lower limit | Estimate | Upper limit
Potency 17946.1 18186.9 18430.9 Potency 17943.7 18186.9 18433.4
Rel. to Ass. ? ? ? Rel. to Ass. ? ? ?
Rel. to Est. 98.7% 100.0% 101.3% Rel. to Est. 98.7% 100.0% 101.4%

Unweighted combination

(IUpvial) Lower limit | Estimate | Upper limit
Potency 178941 181931 18497.1
Rel. to Ass. ? ? ?

Rel. to Est. 98.4% 100.0% 101.7%

Executed by: Calculated by: Approved by:

Filename: ...\A115 PhEur Ex 604 Combination.epc. ID: EDQM/DBO/FRA
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A.2 Examples from D.J. Finney
A.2.1 Example 3.9.1. (Without transformation)
(85175 \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
Substance Vitamin B12 Remarks: Example taken from 'Statistical Method in Biological Assay' by * *
Method turbidimetric D.J. Fi_nney, Srq Editi_on_, 1978, Griffin. I_Z)ata as given on page 48. The * *
analysis of variance is in agreement with that given on page 50. * *
Micro-organism | Lactobacillus leichmannii *

Standard

Id.

Ass. pot. |1 unit/unit

Doses S1 | S2 | S3 | S4 | S5 | S6 | S7 | S8
(1) 0.15]0.28 | 0.36 | 0.51 | 0.68 | 0.85 | 1.06 | 1.21
(2) 0.14 | 0.20 | 0.36 | 0.53 | 0.63 | 0.80 | 0.91 | 1.22
(3) 0.19/0.23|0.34|0.54 | 0.64 | 0.71]1.09 | 1.29
4) 0.19 10.25]0.37 | 0.45 | 0.61 | 0.85 | 0.93 | 1.24
(5) 0.17 1 0.23 0.33 | 0.57 | 0.65 | 0.94 | 1.09 | 1.18
(6) 0.16 | 0.230.38 | 0.49 | 0.68 | 0.83 | 1.12 | 1.24

Model: Parallel lines

Design: Completely randomised

Transformation: y' =y

Variance: Observed residuals

Dilution step (Increasing): 1.5

Common slope(factor) = 0.381103 (0.368315 to 0.393890)
Correlation | r |: 0.983781

Executed by:

Calculated by:

Filename: ...\A201 Finney048 PLA.epa. ID: EDQM/DBO/FRA

Approved by:

Source of variation Degrees of freedom Sum of squares Mean square F-ratio Probability
Regression 1 6.01716 6.01716 >1000 0.000 (***)
Non-linearity 6 0.104468 0.0174113 7.288 0.000 (***)
Quadratic curvature 1 0.0996036 0.0996036 41.690 0.000 (***)
Lack of quadratic fit 5 0.00486429 0.000972857 0.407 0.841
Treatments 7 6.12163 0.874518 366.035 0.000 (***)
Model 1 6.01716 6.01716 >1000 0.000 (***)
Deviations from model 6 0.104468 0.0174113 7.288 0.000 (***)
Full factorial 7 6.12163 0.874518 366.035 0.000 (***)
Residual error 40 0.0955667 0.00238917
Total 47 6.21719 0.132281

Standard
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A.2.2 Example 3.9.1. (With exact transformation)

(585155 \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1

Substance

Vitamin B12

Method

turbidimetric

Micro-organism

Lactobacillus leichmannii

Remarks: Example taken from 'Statistical Method in Biological Assay' by
D.J. Finney, 3rd Edition, 1978, Griffin. Data as given on page 48 and
applying a square-root transformation as described on page 52. The
analysis of variance is in close agreement with that given on page 52.
The small differences can be explained because Finney used rounded
values after the transformation. If the rounded values as given on page
52 are used, the analysis of variance is in agreement with that on page
52. (See Example Finney052 PLA SqrtY rounded.epa)

Standard

Id.

Ass. pot. |1 unit/unit

Doses S1 S2 | S3 | S4 | S5 | S6 | S7 | S8
(1) 0.15|0.28 | 0.36 | 0.51 | 0.68 | 0.85 | 1.06 | 1.21
(2) 0.140.20 | 0.36 | 0.53 | 0.63 | 0.80 | 0.91 | 1.22
3) 0.19]0.23|0.34 | 0.54 | 0.64 | 0.71 ] 1.09 | 1.29
(4) 0.190.25|0.37 | 0.45| 0.61 | 0.85| 0.93 | 1.24
(5) 0.17 {0.23 | 0.33 | 0.57 | 0.65 | 0.94 | 1.09 | 1.18
(6) 0.16 | 0.23 | 0.38 | 0.49 | 0.68 | 0.83 | 1.12 | 1.24

Model: Parallel lines

Design: Completely randomised
Transformation: y' = sqrt(y)
Variance: Observed residuals
Dilution step (Increasing): 1.5

Common slope(factor) = 0.252100 (0.244475 to 0.259726)

Correlation | r |: 0.993019

Executed by:

Calculated by:

Filename: ...\A202 Finney052 PLA SqrtY.epa. ID: EDQM/DBO/FRA

Approved by:

Source of variation Degrees of freedom Sum of squares Mean square F-ratio Probability
Regression 1 2.63302 2.63302 >1000 0.000 (***)
Non-linearity 6 0.00316761 0.000527935 0.621 0.712
Quadratic curvature 1 8.46615E-06 8.46615E-06 0.010 0.921
Lack of quadratic fit 5 0.00315914 0.000631829 0.744 0.595
Treatments 7 2.63619 0.376598 443.270 0.000 (***)
Model 1 2.63302 2.63302 >1000 0.000 (***)
Deviations from model 6 0.00316761 0.000527935 0.621 0.712
Full factorial 7 2.63619 0.376598 443.270 0.000 (***)
Residual error 40 0.0339836 0.000849590
Total 47 2.67017 0.0568122

Standard




slope differs by a factor In(1.5) from that given by Finney because he

used dose-metameters instead of natural logarithms.

Standard

Id.

Ass. pot. |1 unit/unit

Doses S1 S2 | S3 | S4 | S5 | S6 | S7 | S8
(1) 0.39 [ 0.53 | 0.60 | 0.71 | 0.82 | 0.92 | 1.03 | 1.10
2) 0.37 {0.45|0.60 | 0.73 | 0.79 | 0.89 | 0.95 | 1.10
3) 044|048 |0.58|0.73 | 0.80 | 0.84 | 1.04 | 1.14
4) 0.440.50 | 0.61 | 0.67 | 0.78 | 0.92 | 0.96 | 1.11
(5) 0.41]0.48|0.57 | 0.75| 0.81 | 0.97 | 1.04 | 1.09
(6) 040|048 |0.62|0.70 | 0.82 | 0.91 | 1.06 | 1.11

Model: Parallel lines

Design: Completely randomised

Transformation: y' =y

Variance: Observed residuals
Dilution step (Increasing): 1.5

A.2. EXAMPLES FROM D.J. FINNEY 91
. .
A.2.3 Example 3.9.1. (With rounded transformation)
(G851t \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
Substance Vitamin B12 Rema!'ks: Example»t_aken from 'St_atistical Metho_d in Biological Assay' by * *
Method turbidimetric D.J. F|_nney, 3rq Edm_on_, 1978, Griffin. I_Z)ata as given on page 52. The * *
- - - - — analysis of variance is in agreement with that given on page 52. The * *
Micro-organism | Lactobacillus leichmannii *

Common slope(factor) = 0.251230 (0.243411 to 0.259049)

Correlation | r |: 0.992714

Executed by:

Calculated by:

Approved by:

Filename: ...\A203 Finney052 PLA SqrtY Rounded.epa. ID: EDQM/DBO/FRA

Source of variation Degrees of freedom Sum of squares Mean square F-ratio Probability
Regression 1 2.61488 2.61488 >1000 0.000 (***)
Non-linearity 6 0.00279008 0.000465013 0.521 0.789
Quadratic curvature 1 3.57143E-06 3.57143E-06 0.004 0.950
Lack of quadratic fit 5 0.00278651 0.000557302 0.624 0.682
Treatments 7 2.61767 0.373952 418.603 0.000 (***)
Model 1 2.61488 2.61488 >1000 0.000 (***)
Deviations from model 6 0.00279008 0.000465013 0.521 0.789
Full factorial 7 2.61767 0.373952 418.603 0.000 (***)
Residual error 40 0.0357333 0.000893333
Total 47 2.65340 0.0564553

Standard
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A.2.4 Example 4.2.1.

APPENDIX A. EXAMPLES

[ems’57aT; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 2

‘Substance ‘DS in cod-liver oil ‘ Remarks: Example taken from 'Statistical Method in Biological Assay'
‘ Method ‘Antirachitic activity in chickens ‘ %)_{] D.J. Finpey, 3rd 'Editioln, ‘1978, Griffin. D;ta as giyen on page 70.
e analysis of variance is in agreement with that given on page 73.
The small differences for non-parallelism can be explained from
rounding by Finney. The estimated potency is in agreement with that
given on page 80 and the 95% confidence limits are in agreement with
those given on page 87.
Standard Sample 1
Id. Id.
Ass. pot. |1 unit/mg Ass. pot. |? unit/mg
Pre-dil. 1 Pre-dil. 1
Doses 5.76 unit | 9.6 unit | 16 unit Doses 324mg | 54 mg 90 mg 150 mg
(1) 35 62 116 (1) 20 26 57 140
(2) 30 67 105 (2) 39 60 89 133
(3) 24 95 91 (3) 16 48 103 142
(4) 37 62 94 (4) 27 -8 129 118
(5) 28 54 130 (5) -12 46 139 137
(6) 73 56 79 (6) 2 77 128 84
(7) 31 48 120 (7) 31 89 101
(8) 21 70 124 (8) 86
9) -5 94 9)
(10) 42 (10)

Model: Parallel lines

Design: Completely randomised

Transformation: y' =y

Variance: Observed residuals

* % %

Common slope(factor) = 73.9443 (63.9860 to 83.9026)
Correlation | r |: 0.864621

Dilution step (Increasing): 1.666666
Source of variation Degrees of freedom | Sum of squares Mean square F-ratio Probability
Preparations 1 687.086 687.086 1.438 0.236
Regression 1 74088.4 74088.4 155.104 0.000  (***)
Non-parallelism 1 9.29015 9.29015 0.019 0.890
Non-linearity 3 2311.77 770.591 1.613 0.199
Standard 1 96.1211 96.1211 0.201 0.656
Sample 1 2 2215.65 1107.83 2.319 0.109
Treatments 6 77096.6 12849.4 26.900 0.000 (***)
Residual error 48 22928.2 477.670
Total 54 100025 1852.31
Sample 1
Id.
(unit/mg) Lower limit | Estimate | Upper limit
Potency 0.124330 | 0.145995 | 0.172315
Rel. to Ass. ? ? ?
Rel. to Est. 85.2% 100.0% 118.0%

Filename: ...\A204 Finney070 PLA.epa. ID: EDQM/DBO/FRA

* X %

* oy %
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[om857aT5 \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 2 of 2 * * *
*
‘Substance ‘DS in cod-liver oil ‘ *
‘Method ‘Antlrachltlc activity in chickens ‘ * . *
All samples Standard Sample 1

Executed by:

Calculated by:

Filename: ...\A204 Finney070 PLA.epa. ID: EDQM/DBO/FRA

Approved by:
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A.2.5 Example 4.15.1.

[omE5Iat; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1
‘Substance ‘Oestrone ‘ Remarks: Example taken from 'Statistical Method in Biological Assay' by D.J. *
‘Method ‘Ovariectomized rats ‘ Finney, 3rd Edition,l 1978, Qriffin.'Dlata as given on pagelsg exclu§ing the missing
values. The analysis of variance is in close agreement with that given on page
103. The difference for litters is due to the fact that Finney ignored doses, whereas
CombiStats does not ignore doses. Also, CombiStats computes separate values for
regression, parallelism and preparations even though they are not orthogonal and
not additive. This is described on page 103 but Finney does not give the actual
values. The estimated potency and 95% confidence limits are in close agreement
with those given on page 104. The difference, nobably in the upper limit, is again
caused by the fact that Finney ignored litters (i.e. he inverted a 3x3 matrix)
whereas CombiStats inverts a the full 9x9 matrix including the 6 (=7-1) parameters
for litters.
Standard Sample 1
Id. Id.
Ass. pot. |1 pg/unit Ass. pot. |? pg/ml
Doses 0.2 ug 0.4 ug Doses 0.0075ml | 0.015ml
(1) 54 152 (1) 61 92
(2) 49 71 (2) 74 63
3) 51 112 (3) 51
(4) 58 (4) 60 102
(5) 81 102 (5) 120
(6) 63 (6) 83 105
(7) 126 (7) 83 108
Model: Parallel lines Common slope(factor) = 45.5948 (19.5721 to 71.6175)
Design: Randomised block Correlation | r |: 0.760838
Transformation: y' =y
Variance: Observed residuals
Source of variation Degrees of freedom | Sum of squares Mean square F-ratio Probability
Preparations 1 2.52083 2.52083 0.005 0.947
Regression 1 5306.17 5306.17 9.628 0.008 (**)
Non-parallelism 1 178.847 178.847 0.325 0.579
Treatments 3 5487.54 1829.18 3.319 0.054
Blocks 6 5443.37 907.228 1.646 0.212
Residual error 13 7164.63 551.126
Total 22 17437.7 792.625
Sample 1
Id.
(pg/ml) Lower limit | Estimate | Upper limit
Potency 12.6734 25.1539 48.5286
Rel. to Ass. ? ? ?
Rel. to Est. 50.4% 100.0% 192.9%
All samples Standard Sample 1
Executed by: Calculated by: Approved by:

Filename: ...\A205 Finney089 PLA Blocks.epa. ID: EDQM/DBO/FRA
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A.2.6 Example 5.2.1.
[6mE%1at; Version 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
Substance | Vitamin B12 Remarks: Example taken from 'Statistical Method in Biological Assay' by D.J. Finney, 3rd * *
Edition, 1978, Griffin. Data as given on page 105. The analysis of variance is in * *
agreement with that given on page 107. The slope differs by a factor In(1.5) because * * *

Finney used dose metameters. The estimated potency and 95% confidence limits are in
agreement with those given on page 109.

Standard Sample 1

Id. Id.

Ass. pot. |1 ng/tube Ass. pot. |? ng/unit

Doses 0.8ng|1.2ng | 1.8ng Doses 4 unit | 6 unit | 9 unit
(1) 096 | 1.06 | 1.17 (1) 091 | 1.09 | 1.15
(2) 091 | 107 | 1.14 (2) 093 | 1.04 | 1.15
(3) 092 | 099 | 1.14 (3) 098 | 097 | 1.14
(4) 076 | 086 | 1.13 (4) 0.96 | 1.06 | 1.16
(5) 103 | 1.06 | 1.13 (5) 0.89 | 1.04 | 1.10
(6) 093 | 1.02 | 1.15 (6) 101 | 1.02 | 115

Model: Parallel lines

Design: Completely randomised

Transformation: y' =y

Variance: Observed residuals
Dilution step (Increasing): 1.5

Common slope(factor) = 0.258962 (0.211448 to 0.306476)

Correlation | r |: 0.857731

Executed by:

Calculated by:

Filename: ...\A206 Finney105 PLA.epa. ID: EDQM/DBO/FRA

Approved by:

Source of variation Degrees of freedom Sum of squares Mean square F-ratio Probability
Preparations 1 0.00284444 0.00284444 0.920 0.345
Regression 1 0.264600 0.264600 85.570 0.000 (***)
Non-parallelism 1 0.00135000 0.00135000 0.437 0.514
Non-linearity 2 0.00196111 0.000980556 0.317 0.731

Standard 1 0.00173611 0.00173611 0.561 0.460

Sample 1 1 0.000225000 0.000225000 0.073 0.789
Quadratic curvature 1 0.00160556 0.00160556 0.519 0.477
Lack of quadratic fit 1 0.000355556 0.000355556 0.115 0.737
Treatments 5 0.270756 0.0541511 17.512 0.000  (***)
Residual error 30 0.0927667 0.00309222
Total 35 0.363522 0.0103863

Sample 1

Id.
(ng/unit) Lower limit | Estimate | Upper limit
Potency 0.184890 | 0.214212 | 0.249937
Rel. to Ass. ? ? ?
Rel. to Est. 86.3% 100.0% 116.7%

All samples Standard Sample 1
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A.2.7 Example 5.4.2.

[em857aT5 \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1
Substance Penicillin Remarks: Example taken from 'Statistical Method in Biological Assay' by D.J.
Method Agar diffusion Fmpey, 3|.'d ‘Edmon, 1978, erﬁln. Da)ta as given on page 114. The analysis of o
- - - — variance is in agreement with that given on page 115. The estimated potency is in
Micro-organism | Bacillus subtilis agreement with that given on page 113 and the 95% confidence limits are in
agreement with those given on page 115.

Standard Sample 1

Id. Id.
Ass. pot. |1 unit/ml Ass. pot. |1 unit/ml
Doses 50 unit | 200 unit Doses 1/4 n

(1) 92 108 (1) 68 90

(2) 95 11 (2) 74 91

(3) 93 108 (3) 72 91

(4) 90 107 (4) 75 88
Model: Parallel lines Common slope(factor) = 12.1727 (10.9248 to 13.4206)
Design: Randomised block Correlation | r |: 0.993475

Transformation: y' =y
Variance: Observed residuals

Source of variation Degrees of freedom | Sum of squares Mean square F-ratio Probability
Preparations 1 1501.56 1501.56 421.491 0.000  (***)
Regression 1 1139.06 1139.06 319.737 0.000 (***)
Non-parallelism 1 3.06250 3.06250 0.860 0.378
Treatments 3 2643.69 881.229 247.363 0.000 (***)
Blocks 3 24.6875 8.22917 2.310 0.145
Residual error 9 32.0625 3.56250
Total 15 2700.44 180.029

Sample 1

Id.
(unit/ml) Lower limit | Estimate | Upper limit
Potency 30.2750 40.7170 51.9974
Rel. to Ass. | 3027.5% | 4071.7% | 5199.7%
Rel. to Est. 74.4% 100.0% 127.7%

All samples Standard Sample 1
Executed by: Calculated by: Approved by:

Filename: ...\A207 Finney114 PLA Blocks.epa. ID: EDQM/DBO/FRA
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A.2.8 Example 7.3.1. (Including blanks)
(G851t \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
Substance Nicotine acid Remarks: Exam_ple taken fromA'StatisticaI M_et_hod in Biological * *
Method Acidity by titration with N/14 NaOH Assay' by D.J. Finney, 3n_d Edmoq, 197&_3, _Grlffln. Data as given * *
- - - - on page 150. The analysis of variance is in agreement with * *
Micro-organism | Lactobacillus arabinosus *

that given on pages 152 and 154. The estimated potency is in
agreement with that given on page 113 and the 95%
confidence limits are in agreement with those given on page

115.
Standard Sample 1

Id. Id.
Ass. pot. |1 pg/tube Ass. pot. |? pg/ml
Doses 0.05 ug | 0.10 pg | 0.15 ug | 0.20 pg | 0.25 pg Doses 1.0ml | 1.5ml | 2.0ml 0ml

(1) 35 5.0 6.2 8.0 9.4 1) 49 6.3 7.7 1.5

(2) 3.2 47 6.1 7.7 9.5 2) 48 6.5 7.7 1.4
Model: Slope ratio Common intercept = 1.64533 (1.52108 to 1.76959)
Design: Completely randomised Correlation | r |: 0.997657
Transformation: y' =y
Variance: Observed residuals

Source of variation Degrees of freedom Sum of squares Mean square F-ratio Probability
Regression 2 96.4116 48.2058 >1000 0.000 (***)
Blanks 1 0.144689 0.144689 7.441 0.023 (%)
Intersection 1 0.0248773 0.0248773 1.279 0.287
Non-linearity 4 0.108833 0.0272083 1.399 0.309

Standard 3 0.0880000 0.0293333 1.509 0.278

Sample 1 1 0.0208333 0.0208333 1.071 0.328
Treatments 8 96.6900 12.0863 621.579 0.000  (***)
Model 2 96.4116 48.2058 >1000 0.000 (***)
Deviations from model 6 0.278400 0.0464000 2.386 0.116
Full factorial 8 96.6900 12.0863 621.579 0.000 (***)
Residual error 9 0.175000 0.0194444
Total 17 96.8650 5.69794

Sample 1

Id.
(pg/ml) Lower limit | Estimate | Upper limit
Potency 0.0963274 | 0.0996139 | 0.102955
Rel. to Ass. ? ? ?
Rel. to Est. 96.7% 100.0% 103.4%

All samples Standard Sample 1

/

Executed by:

Calculated by:

Approved by:

Filename: ...\A208 Finney150 Slope Ratio Blanks incl.epa. ID: EDQM/DBO/FRA
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A.2.9 Example 7.3.1. (Excluding blanks)

(585155 \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1

Substance Nicotine acid

Method Acidity by titration with N/14 NaOH

Micro-organism |Lactobacillus arabinosus

Remarks: Example taken from 'Statistical Method in Biological
Assay' by D.J. Finney, 3rd Edition, 1978, Griffin. Data as given
on page 150. The blank have been excluded due to
anomalous behaviour. For the analysis including blanks see
example Finney150 Slope Ratio Blanks incl.epa The estimated
potency is in agreement with that on page 155 and 95%
confidence limits are in close agreement with those given on
page 156. The very small difference is due to the fact that
Finney chose to estimate the residual error including the blanks
(see remark before equation 7.6.4). CombiStats never uses
excluded values to compute the residual error.

Standard Sample 1
Id. Id.
Ass. pot. |1 pg/tube Ass. pot. |? pg/ml
Doses 0.05ug | 0.10 pg | 0.15 pug | 0.20 pg | 0.25 ug Doses 1.0ml | 1.5ml | 2.0ml oml
(1) 35 5.0 6.2 8.0 9.4 (1) 49 6.3 7.7 15
(2) 3.2 47 6.1 7.7 9.5 (2) 48 6.5 7.7 14
Model: Slope ratio Common intercept = 1.82037 (1.63892 to 2.00181)
Design: Completely randomised Correlation | r |: 0.997215
Transformation: y' =y
Variance: Observed residuals
Source of variation Degrees of freedom Sum of squares Mean square F-ratio Probability
Regression 2 54.3063 27.1531 >1000 0.000 (***)
Intersection 1 0.0248773 0.0248773 1.171 0.311
Non-linearity 4 0.108833 0.0272083 1.280 0.354
Standard 3 0.0880000 0.0293333 1.380 0.317
Sample 1 1 0.0208333 0.0208333 0.980 0.351
Treatments 7 54.4400 7.77714 365.983 0.000 (***)
Model 2 54.3063 27.1531 >1000 0.000 (***)
Deviations from model 5 0.133711 0.0267421 1.258 0.367
Full factorial 7 54.4400 7.77714 365.983 0.000 (***)
Residual error 8 0.170000 0.0212500
Total 15 54.6100 3.64067
Sample 1
Id.
(ug/ml) Lower limit | Estimate | Upper limit
Potency 0.0955214 | 0.0991645 | 0.102849
Rel. to Ass. ? ? ?
Rel. to Est. 96.3% 100.0% 103.7%
All samples Standard Sample 1
—
Executed by: Calculated by: Approved by:

Filename: ...\A209 Finney150 Slope Ratio Blanks excl.epa. ID: EDQM/DBO/FRA
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A.2.10 Example 7.10.2.
[6mE%1at; Version 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
*
Substance Riboflavin in Malt Remarks: Example taken from 'Statistical Method in Biological Assay' *
e o " by D.J. Finney, 3rd Edition, 1978, Griffin. Data as given on page *
Method Acidity by fitration with NaOH 161. The analysis of variance is in agreement with that given on * *
L i i *
actobacillus helveticus

Micro-organism

page 162. The estimated potency and the 95% confidence limits are

in agreement with those given on page 162.

Standard Sample 1

Id. Id.

Ass. pot. |0.2 pug/unit Ass. pot. |? pg/g

Doses 0 ug 0.1ug | 0.2 pg Doses 0.025g | 0.05¢g
(1) 38 97 167 (1) 80 121
(2) 45 100 164 (2) 88 124
(3) 40 105 159 (3) 90 122
(4) 44 98 156 (4) 82 122

Model: Slope ra

Transformation:

tio

Design: Completely randomised

y=y

Variance: Observed residuals

Common intercept = 42.1429 (39.3285 to 44.9572)
Correlation | r |: 0.996005

Source of variation Degrees of freedom | Sum of squares Mean square F-ratio Probability
Regression 2 31456.9 15728.5 >1000 0.000 (***)
Blanks 1 2.16071 2.16071 0.150 0.704
Intersection 1 34.2250 34.2250 2.371 0.144
Treatments 4 31493.3 7873.33 545.496 0.000 (***)
Residual error 15 216.500 14.4333
Total 19 31709.8 1668.94

Sample 1
Id.
(Mg/g) Lower limit | Estimate | Upper limit
Potency 2.58550 2.73892 2.89443
Rel. to Ass. ? ? ?
Rel. to Est. 94.4% 100.0% 105.7%
All samples Standard Sample 1
o

Executed by:

Calculated by:

Approved by:

Filename: ...\A210 Finney161 Slope Ratio.epa. ID: EDQM/DBO/FRA
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Example 9.5.1.

APPENDIX A. EXAMPLES

[omE5Iat; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 2
*
Substance |Atrtifical data Remarks: Example taken from 'Statistical Method in Biological Assay' by D.J. Finney, 3rd *
Edition, 1978, Griffin. Data as given on page 184. The analysis of variance is in *
agreement with the 2nd part of the table given on page 186. CombiStats does not

automatically generate the 1st part of the table. The estimated potency and the 95%
confidence limits are in agreement with those given on page 187. For an alternative way
of entering these data see example Finney184 PLA Blocks Table.epa.

Standard Sample 1
Id. Id.
Ass. pot. |1 unit/unit Ass. pot. |? unit/mg
Doses 0.9 unit | 1.5 unit | 2.5 unit Doses 0.45mg | 0.75mg | 1.25 mg
(1) 20 33 (1)
(2) 18 36 (2)
(3) 16 44 (3)
(4) 22 33 (4)
(5) 29 (5) 35
(6) 26 (6) 14
(7) 47 7) 48
(8) 30 (8) 30
9) 16 9) 38
(10) 30 (10) 41
(11) 40 47 (11)
(12) 40 59 (12)
(13) 35 (13) 4
(14) 47 (14) 16
(15) 27 (15) 35
(16) 43 (16) 35
(17) 43 (17) 50
(18) 37 (18) 33
(19) 44 (19) 26
(20) 48 (20) 28
(21) 35 (21) 43
(22) 43 (22) 33
(23) 46 (23) 23
(24) 51 (24) 51
(25) (25) 20 37
(26) (26) 12 30
(27) (27) 21 33
(28) (28) 25 40
(29) (29) 39 43
(30) (30) 18 27

Model: Parallel lines

Design: Randomised block

Transformation: y' =y

Variance: Observed residuals

Filename: ...\A211 Finney184 PLA Blocks.epa. ID: EDQM/DBO/FRA

Common slope(factor) = 18.2303 (13.8330 to 22.6276)
Correlation | r |: 0.915154

* X %

* oy %
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[om857aT5 \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 2 of 2 * * *
* *
* *
* *
* oy Kk

Executed by:

Calculated by:

Filename: ...\A211 Finney184 PLA Blocks.epa. ID: EDQM/DBO/FRA

Approved by:

Source of variation Degrees of freedom Sum of squares Mean square F-ratio Probability
Preparations 1 245.444 245.444 5914 0.023 (%)
Regression 1 2081.34 2081.34 50.149 0.000  (***)
Non-parallelism 1 0.260417 0.260417 0.006 0.937
Non-linearity 2 237.868 118.934 2.866 0.076

Standard 1 66.6944 66.6944 1.607 0.217

Sample 1 1 171.174 171.174 4.124 0.053
Quadratic curvature 1 225.781 225.781 5.440 0.028 (%)
Lack of quadratic fit 1 12.0868 12.0868 0.291 0.594
Treatments 5 2564.92 512.983 12.360 0.000  (***)
Blocks 29 2617.12 90.2454 2174 0.026 (%)
Residual error 25 1037.58 41.5033
Total 59 7850.85 133.065

Sample 1
Id.
(unit/mg) Lower limit | Estimate | Upper limit
Potency 1.11719 1.50184 1.91482
Rel. to Ass. ? ? ?
Rel. to Est. 74.4% 100.0% 127.5%
All samples Standard Sample 1
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A.2.12 Example 9.5.1. (Alternative)

[omt%Tat; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 2

Substance |Atrtifical data

Remarks: Example taken from 'Statistical Method in Biological Assay' by D.J. Finney, 3rd
Edition, 1978, Griffin. Data as given on page 184. The analysis of variance is in
agreement with the 2nd part of the table given on page 186. CombiStats does not
automatically generate the 1st part of the table. The estimated potency and the 95%
confidence limits are in agreement with those given on page 187. For an alternative way
of entering these data see example Finney184 PLA Blocks.epa.

Model: Parallel lines

Design: Randomised block

Transformation: y' =y

Variance: Observed residuals

Common slope(factor) = 18.2303 (13.8330 to 22.6276)
Correlation | r |: 0.915154

Filename: ...\A212 Finney184 PLA Blocks Table.epa. ID: EDQM/DBO/FRA

Standard Sample 1
Id. Id.
Ass. pot. |1 unit/unit Ass. pot. |? unit/mg
Doses 0.9 unit | 1.5unit | 2.5 unit Doses 0.45mg | 0.75mg | 1.25 mg
(1) 20 33 44 (1) 35 48 38
(2) 18 36 33 (2) 14 30 41
(3) 16 40 47 (3) 4 35 50
(4) 22 40 59 (4) 16 35 33
(5) 29 35 44 (5) 26 43 23
(6) 26 47 48 (6) 28 33 51
7) 47 27 35 ) 20 37 33
(8) 30 43 43 (8) 12 30 40
9) 16 43 46 9) 21 39 43
(10) 30 37 51 (10) 25 18 27
Design (A) (B) Observ. | (A) | (B)
(1) 111 ] 11211 (1) 20 | 33
(2) 11112 | 1122 (2) 18 | 36
(3) 113 | 113[1 (3) 16 | 44
(4) 11114 | 1132 (4) 22|33
(5) 1115 | 2111 (5) 29|35
(6) 11116 | 212 (6) 26 | 14
(7) 1117 | 221 (7) 47 | 48
(8) 11118 | 2|22 (8) 30 | 30
9) 1119 | 2I3/1 9) 16 | 38
(10) [ 111110 | 2[3|2 (10) | 30 | 41
(1) | 1213 | 11313 (11) | 40|47
(12) | 1214 | 134 (12) | 40|59
(13) | 11215 | 2)113 (13) |35] 4
(14) | 1216 | 2]1}4 (14) | 47|16
(15) | 1217 | 21213 (15) |27|35
(16) | 1]218 | 2214 (16) | 43|35
(17) | 1219 | 21313 (17) | 43|50
(18) | 12110 | 2314 (18) | 3733
(19) | 13|15 | 2115 (19) | 44|26
(20) | 13l6 | 2116 (20) | 48|28
(1) | 1317 | 21215 (21) |35]|43
(22) | 1318 | 2216 (22) |43|33
(23) 11319 | 2|3|5 (23) | 46|23
(24) | 113110 2136 (24) | 5151
(25) | 21117 | 21217 (25) | 20|37
(26) | 21118 | 228 (26) | 1230
(27 | 219 | 21317 (27) |21]33
(28) | 2/11]10] 238 (28) | 25|40
(29) | 21219 | 239 (29) | 3943
(30) | 2210 | 23|10 (30) | 18] 27
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[om857aT5 \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 2 of 2 * * *
* *
* *
* *
* oy Kk

Executed by:

Calculated by:

Approved by:

Filename: ...\A212 Finney184 PLA Blocks Table.epa. ID: EDQM/DBO/FRA

Source of variation Degrees of freedom Sum of squares Mean square F-ratio Probability
Preparations 1 245.444 245.444 5914 0.023 (%)
Regression 1 2081.34 2081.34 50.149 0.000  (***)
Non-parallelism 1 0.260417 0.260417 0.006 0.937
Non-linearity 2 237.868 118.934 2.866 0.076

Standard 1 66.6944 66.6944 1.607 0.217

Sample 1 1 171.174 171.174 4.124 0.053
Quadratic curvature 1 225.781 225.781 5.440 0.028 (%)
Lack of quadratic fit 1 12.0868 12.0868 0.291 0.594
Treatments 5 2564.92 512.983 12.360 0.000  (***)
Blocks 29 2617.12 90.2454 2174 0.026 (%)
Residual error 25 1037.58 41.5033
Total 59 7850.85 133.065

Sample 1
Id.
(unit/mg) Lower limit | Estimate | Upper limit
Potency 1.11719 1.50184 1.91482
Rel. to Ass. ? ? ?
Rel. to Est. 74.4% 100.0% 127.5%
All samples Standard Sample 1
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A.2.13 Example 11.2.1.

[omE5Iat; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * X %
* *
Remarks: Example taken from 'Statistical Method in Biological Assay' by D.J. Finney, 3rd Edition, 1978, * *
Griffin. Data as given on page 228. The analysis of variance is in agreement with that given on page 229.
The slope differs by a factor In(5) because Finney used dose metameters. The estimated potency and 95% * * *
confidence limits are in agreement with those given on page 230.

Standard Sample 1 Sample 2
Id. Id. Id.
Ass. pot. |1 unit/unit Ass. pot. |1 unit/unit Ass. pot. |1 unit/unit
Doses S1] 82| 83 Doses T1 | T2 | T3 Doses Ut | U2 | U3
(1) 36 | 52 | 64 (1) 45 | 40 | 65 (1) 33 | 44 | 70
(2) 41 | 48 | 62 (2) 38 | 42 | 65 (2) 36 | 57 | 63
(3) 44 | 48 | 100 (3) 45 | 62 | 57 (3) 33 | 54 | 78
(4) 48 | 52 | 59 (4) 40 | 42 | 70 (4) 37 | 61| 70
Model: Parallel lines Common slope(factor) = 8.98347 (7.22956 to 10.7374)
Design: Randomised block Correlation | r |: 0.856311
Transformation: y' =y
Variance: Observed residuals
Dilution step (Increasing): 5
Source of variation Degrees of freedom | Sum of squares Mean square F-ratio Probability
Preparations 2 77.7222 38.8611 0.595 0.560
Regression 1 5017.04 5017.04 76.791 0.000  (***)
Non-parallelism 2 175.583 87.7917 1.344 0.280
Non-linearity 3 244.542 81.5139 1.248 0.315
Standard 1 121.500 121.500 1.860 0.185
Sample 1 1 117.042 117.042 1.791 0.193
Sample 2 1 6.00000 6.00000 0.092 0.764
Quadratic curvature 1 125.347 125.347 1.919 0.179
Lack of quadratic fit 2 119.194 59.5972 0.912 0.415
Treatments 8 5514.89 689.361 10.551 0.000  (***)
Blocks 3 370.750 123.583 1.892 0.158
Residual error 24 1568.00 65.3333
Total 35 7453.64 212.961
Sample 1 Sample 2
Id. Id.
(unit/unit) Lower limit | Estimate | Upper limit (unit/unit) Lower limit | Estimate | Upper limit
Potency 0.298590 | 0.671071 1.43917 Potency 0.383678 | 0.846222 1.83014
Rel. to Ass. 29.9% 67.1% 143.9% Rel. to Ass. 38.4% 84.6% 183.0%
Rel. to Est. 44.5% 100.0% 214.5% Rel. to Est. 45.3% 100.0% 216.3%
All samples Standard Sample 1 Sample 2
Executed by: Calculated by: Approved by:

Filename: ...\A213 Finney228 PLA Blocks.epa. ID: EDQM/DBO/FRA




Model: Parallel lines
Design: (Latin) square
Transformation: y' =y

Variance: Observed residuals

Common slope(factor) = 3.13335 (2.97929 to 3.28741)

Correlation | r |: 0.985111

Warning: Design has confounded effects (df=2)

Source of variation Degrees of freedom Sum of squares Mean square F-ratio Probability
Preparations 7 9.33359 1.33337 20.831 0.000  (***)
Regression 1 75.4727 75.4727 >1000 0.000  (***)
Non-parallelism 7 0.624531 0.0892188 1.394 0.238
Treatments 15 85.4308 5.69539 88.976 0.000  (***)
Rows 6 3.98844 0.664740 10.385 0.000  (***)
Columns 6 0.319688 0.0532813 0.832 0.553
Model 22 90.8284 4.12857 64.498 0.000  (***)
Deviations from model 5 0.462031 0.0924063 1.444 0.232
Full factorial 27 91.2905 3.38113 52.822 0.000  (***)
Residual error 36 2.30438 0.0640104
Total 63 93.5948 1.48563

Filename: ..\A214 Finney231 PLA Latin.epa. ID: EDQM/DBO/FRA
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A.2.14 Example 11.3.1.
[EmE5IaT; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 3 * * *
* *
Substance |Vitamin B12 Statistical Metlhod in Biological Assgy'. D.J. Finney, 3rd Edition, 1978, Griff!n. Page 231. * *
labollod 1 aources of varance Sighly aiforont i CombiStals: Wht ho cars A
Parallelism is actually the deviations from Model in CombiStats. Also, the difference
between columns and rows is confounded with that for between treatments. In cases
like this, CombiStats issues a warning and attributes a higher priority to treatments, which
explains why 1 degree of freedom is lost for rows and columns. Finney retained the 2
confounded degrees of freedom by modeling preparations (df=7) instead of treatments
(df=15). This difference is not very important though. The estimated potency and 95%
confidence limits for preparation D are in agreement with those given on page 234.
Finney does not give the potencies for the other preparations.
Standard Sample 1 Sample 2 Sample 3
Id. S Id. A Id. B Id. C
Ass. pot. |1 unit/unit Ass. pot. |1 unit/unit Ass. pot. |1 unit/unit Ass. pot. |1 unit/unit
Doses M@ ]34 Doses M @B @ Doses M@ @ @ Doses M@ ]34
110 25(26(22]19 110 1.2]13]1.0]1.0 110 1.511.0/03]|0.6 1/30 1.511.0]1.0]1.0
1/5 42[38[38[38 1/5 40]36[33[34 1/5 36[30|30)29 115 43]43[36[34
Sample 4 Sample 5 Sample 6 Sample 7
Id. D Id. E Id. F Id. G
Ass. pot. |1 unit/unit Ass. pot. |1 unit/unit Ass. pot. |1 unit/unit Ass. pot. |1 unit/unit
Doses | ()| (2] @)@ Doses | ()] (2] ©3)]| @ Doses | ()| (2] @)@ Doses | ()| (2] @)@
1/10 05]/09[03]09 110 19]117]16[1.0 1/20 23|16[19]19 110 23|16[15]1.0
1/5 36]28|33 8 1/5 44]33[35(34 110 434036 4 1/5 3.8[3.0[34[34
Design | A [ B [@© [ @ [E®[® [©[H observ. [ (A) [®) [ ©) [ D[ E) [P [(©) ] H)
(1) 2121151211 | 6111 | 31211 | 7]111 | 11111 | 8]1]1 | 4]2)1 (1) |40[36]19|36|23|25|23|43
(2) | 81211 6211|5111 | 1]211 | 411 | 3]1]1 | 211]1 | 7]121 (2) |38|44|05|42|15]/15|12]|43
(3) | 41212|31212| 11112 | 51212 | 812 | 6]112 | 7]1]2 | 2]2]2 (3) |43|30|26|28|16]17|16|36
(4) 3112|4112 71212 | 211]2 | 622 | 8]212 | 1]2)2 | 5]1]2 (4) |1.0]10]40|13|33|30|38/|09
(5) | 613 8113|2123 | 7]1]3 | 323 | 4]213 | 5213 | 1]1]3 (5) |16]15]33|19]30|36|33]|22
(6) | 1114|7114 | 41214 | 8]1]4 | 524 | 2|2/4 | 324 | 6]1]4 6) |19]19]34/10]28|34|29]|1.0
(7) | 5|114 | 21114 | 8]214 | 4]1]4 | 124 | 7]2/4 | 6]2}4 | 3[1]4 (7) |09]10|34|10|38|34|34/|06
(8) | 71213 | 11213 | 3]113 | 623 | 2/1]3 | 5]1|3 | 4]1]3 | 8]2I3 8) |36[38|03|35/1.0]03|10|34
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(Gmb5Tats \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 2 of 3 * * *
*
Substance *
*
* p K

Sample 1 Sample 2

Id. A Id. B

(unit/unit) Lower limit | Estimate | Upper limit (unit/unit) Lower limit | Estimate | Upper limit

Potency 0.723656 | 0.787131 | 0.854740 Potency 0.643410 | 0.701138 | 0.762148

Rel. to Ass. 72.4% 78.7% 85.5% Rel. to Ass. 64.3% 70.1% 76.2%

Rel. to Est. 91.9% 100.0% 108.6% Rel. to Est. 91.8% 100.0% 108.7%
Sample 3 Sample 4

Id. C Id. D

(unit/unit) Lower limit | Estimate | Upper limit (unit/unit) Lower limit | Estimate | Upper limit

Potency 2.28802 2.48709 2.69994 Potency 0.622825 | 0.679114 | 0.738487

Rel. to Ass. 228.8% 248.7% 270.0% Rel. to Ass. 62.3% 67.9% 73.8%

Rel. to Est. 92.0% 100.0% 108.6% Rel. to Est. 91.7% 100.0% 108.7%
Sample 5 Sample 6

Id. E Id. F

(unit/unit) Lower limit | Estimate | Upper limit (unit/unit) Lower limit | Estimate | Upper limit

Potency 0.784508 | 0.852507 | 0.925366 Potency 1.71421 1.86142 2.02025

Rel. to Ass. 78.5% 85.3% 92.5% Rel. to Ass. 171.4% 186.1% 202.0%

Rel. to Est. 92.0% 100.0% 108.5% Rel. to Est. 92.1% 100.0% 108.5%
Sample 7

Id. G

(unit/unit) Lower limit | Estimate | Upper limit

Potency 0.759601 | 0.825729 | 0.896413

Rel. to Ass. 76.0% 82.6% 89.6%

Rel. to Est. 92.0% 100.0% 108.6%

All samples Standard Sample 1 Sample 2 Sample 3 Sample 4
S A B C D

Filename: ..\A214 Finney231 PLA Latin.epa. ID: EDQM/DBO/FRA

* 4 %
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A.2.15 Example 18.2.1.
[EmE5IaTs \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 2 * * *
* *
‘Substance ‘Insulin ‘ R‘emarks: Example taken frolm"StatisticaI Method in Biological Assay' by D.J. * *
e [uouse convisen | | ey o Coon, 1576 Crfr Dt s e o pge Ve Cousecsoenl | K w
Chi-square for deviations from model (df=11) is in agreement with value given on
page 386. The common slope differes by a factor log(10) from that given by Finney
because he used common logs whereas Combistats uses natural logarithms.
Unfortunately, Finney does not give the Chi-square for non-parallelism and non-
linearity.
Standard Sample 1
Preparation |Standard (S) Preparation |Test (T)
Ass. pot. 20 1U/mg Ass. pot. 20 1U/mg
Doses (1) Doses (1)
341U 0/33 6.51U 2/40
521U 5/32 10.0 IU 10/30
7.01U 11/38 14.01U 18/40
8.51U 14137 21.51U 21/35
10.51U 18/40 29.01U 27137
13.01U 21137
18.01U 23/31
21.01U 30/37
28.01U 27/30
Model: Quantal responses Common slope(factor) = 1.39143 (1.19090 to 1.59195)
Design: Completely randomised Correlation | r |: 0.978896 (Weighted)
Transformation: y' = probit(y)
Theoretical variance: 1
Source of variation Degrees of freedom Sum of squares Mean square Chi-square Probability
Preparations 1 0.594412 0.594412 0.594412 0.441
Regression 1 130.268 130.268 130.268 0.000 (***)
Non-parallelism 1 0.282426 0.282426 0.282426 0.595
Non-linearity 10 5.42085 0.542085 5.42085 0.861
Standard 7 2.05821 0.294031 2.05821 0.957
Sample 1 3 3.36263 1.12088 3.36263 0.339
Quadratic curvature 1 1.97386 1.97386 1.97386 0.160
Lack of quadratic fit 9 3.44698 0.382998 3.44698 0.944
Treatments 13 136.566 10.5050 136.566 0.000 (***)
Model 2 130.862 65.4311 130.862 0.000 (***)
Deviations from model " 5.70327 0.518479 5.70327 0.892
Full factorial 13 136.566 10.5050 136.566 0.000 (***)
Theoretical variance 1.00000
Total 13 136.566 10.5050
Sample 1
Preparation Test (T)
(IU/mg) Lower limit | Estimate | Upper limit
Potency 11.0678 13.3704 16.0812
Rel. to Ass. 55.3% 66.9% 80.4%
Rel. to Est. 82.8% 100.0% 120.3%

Filename: ..\A215 Finney376 Quantal Probit.epa. ID: EDQM/DBO/FRA
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(Gmb5Tats \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 2 of 2 * * *
* *
‘Substance ‘Insulin ‘ * *
i * *

‘Method ‘Mouse convulsion ‘ * N *

All samples Standard Sample 1

Standard (S) Test (T)

Executed by: Calculated by: Approved by:

Filename: ..\A215 Finney376 Quantal Probit.epa. ID: EDQM/DBO/FRA
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A.3 Miscellaneous other examples

A.3.1 Diphtheria vaccine, intradermal challenge

[EmE5Iat; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
*
[Substance |Diphteria vaccine | [Remarks: | * *
‘Method ‘Intradermal challenge ‘ * *
* oy X
Standard Sample 1
Ass. pot. 9.5 IU/dose Ass. pot.  |9.5 U/ dose
Doses [OIRBHOHG] Doses M2 B)| 4
02dose | 4 | 4 |3 | 4 0.08dose | 2 | 4 |4 | 4
O1dose | 2 |3 |22 004dose | 2 | 2|2 |2
0.05dose | 0 |0 | 1|0 0.02dose | 1 | 1|0 |1
Model: Parallel lines Common slope(factor) = 9.46769 (7.57410 to 11.3613)
Design: Completely randomised Correlation | r |: 0.880367

Transformation: y' = y2
Variance: Observed residuals

Source of variation Degrees of freedom | Sum of squares Mean square F-ratio Probability
Preparations 1 2.66667 2.66667 0.291 0.596
Regression 1 689.063 689.063 75.170 0.000 (***)
Non-parallelism 1 3.06250 3.06250 0.334 0.570
Non-linearity 2 32.7083 16.3542 1.784 0.196

Standard 1 10.6667 10.6667 1.164 0.295

Sample 1 1 22.0417 22.0417 2.405 0.138
Treatments 5 727.500 145.500 15.873 0.000  (***)
Residual error 18 165.000 9.16667
Total 23 892.500 38.8043

Sample 1
(IU/dose) Lower limit | Estimate | Upper limit
Potency 16.6014 22.1352 29.2553
Rel. to Ass. 174.8% 233.0% 308.0%
Rel. to Est. 75.0% 100.0% 132.2%
All samples Standard Sample 1
Executed by: Calculated by: Approved by:

Filename: ...\A301 Diphteria Challenge Test PLA.epa. ID: EDQM/DBO/FRA
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A.3.2 Erythromycin, agar diffusion (assay 1)

(585155 \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1

1

Erythromycin

Standard Sample 1

Ass. Pot. 920 IU/mg Ass. Pot. |1000 IU/ mg

Pre-dil. 1 |121.3 mg/20 ml Pre-dil. 1 |26.4 mg /25 ml

Doses S1 |82 | S8 Doses T | T2 | T3
(1) 185 | 192 | 210 (1) 172 | 201 | 214
2) 185 | 199 | 216 2) 178 | 205 | 212
(3) 174 | 200 | 211 (3) 185 | 196 | 216
(4) 175 | 198 | 216 (4) 184 | 196 | 208
(5) 185 | 201 | 211 (5) 175 | 201 | 218
(6) 180 | 194 | 211 (6) 178 | 197 | 214

Model: Parallel lines

Design: Randomised block

Transformation: y' =y

Variance: Observed residuals

Dilution step (Increasing): 1.5

Common slope(factor) = 41.2078 (37.6872 to 44.7284)

Correlation | r |: 0.966561

Source of variation

Degrees of freedom | Sum of squares Mean square F-ratio Probability

Preparations 1 1.36111 1.36111 0.081 0.778
Regression 1 6700.04 6700.04 399.737 0.000 (***)
Non-parallelism 1 15.0417 15.0417 0.897 0.353
Non-linearity 2 42.3611 21.1806 1.264 0.300

Standard 1 2.25000 2.25000 0.134 0.717

Sample 1 1 40.1111 40.1111 2.393 0.134
Quadratic curvature 1 30.6806 30.6806 1.830 0.188
Lack of quadratic fit 1 11.6806 11.6806 0.697 0.412
Treatments 5 6758.81 1351.76 80.649 0.000 (***)
Blocks 5 67.1389 13.4278 0.801 0.559
Residual error 25 419.028 16.7611
Total 35 7244.97 206.999

Sample 1

(IU/mg) Lower limit | Estimate | Upper limit
Potency 874.648 936.639 1003.23
Rel. to Ass. 87.5% 93.7% 100.3%
Rel. to Est. 93.4% 100.0% 107.1%

All samples Standard Sample 1

Executed by:

Calculated by:

Approved by:

Filename: ...\A302 Erythromycin Assay 1 PLA Blocks.epa. ID: EDQM/DBO/FRA
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A.3.3 Erythromycin, agar diffusion (assay 2)
(G851t \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
P
PR .o

Standard Sample 1

Ass. Pot. 920 IU/mg Ass. Pot. |1000 IU/ mg

Pre-dil. 1 [21.1 mg /20 ml Pre-dil. 1 |26.5mg /25 ml

Doses S1] 82| S3 Doses T1 | T2 | T3
(1) 176 | 205 | 211 (1) 188 | 192 | 218
(2) 178 | 196 | 213 2) 182 | 198 | 218
(3) 184 | 200 | 222 3) 182 | 204 | 222
(4) 180 | 199 | 212 (4) 177 | 198 | 214
(5) 174 | 198 | 212 (5) 179 | 201 | 216
(6) 173 | 198 | 213 (6) 188 | 198 | 215

Model: Parallel lines

Design: Randomised block

Transformation: y' =y

Variance: Observed residuals

Dilution step (Increasing): 1.5

Common slope(factor) = 43.6741 (40.6919 to 46.6563)

Correlation | r |: 0.977019

Executed by:

Calculated by:

Approved by:

Filename: ...\A303 Erythromycin Assay 2 PLA Blocks.epa. ID: EDQM/DBO/FRA

Source of variation Degrees of freedom | Sum of squares Mean square F-ratio Probability
Preparations 1 58.7778 58.7778 4.887 0.036 (%)
Regression 1 7526.04 7526.04 625.780 0.000 (***)
Non-parallelism 1 5.04167 5.04167 0.419 0.523
Non-linearity 2 61.8056 30.9028 2.570 0.097

Standard 1 53.7778 53.7778 4.472 0.045 (%)

Sample 1 1 8.02778 8.02778 0.667 0.422
Quadratic curvature 1 10.1250 10.1250 0.842 0.368
Lack of quadratic fit 1 51.6806 51.6806 4.297 0.049 (M)
Treatments 5 7651.67 1530.33 127.245 0.000  (***)
Blocks 5 136.667 27.3333 2.273 0.078
Residual error 25 300.667 12.0267
Total 35 8089.00 231.114

Sample 1
(IU/mg) Lower limit | Estimate | Upper limit
Potency 919.331 970.838 1026.05
Rel. to Ass. 91.9% 97.1% 102.6%
Rel. to Est. 94.7% 100.0% 105.7%
All samples Standard Sample 1
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A.3.4 Erythromycin, agar diffusion (assay 3)

APPENDIX A. EXAMPLES

(585155 \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1

Standard Sample 1

Ass. Pot. 920 IU/mg Ass. Pot. |1000 IU/ mg

Pre-dil. 1 |21.5mg/20 ml Pre-dil. 1 |26 mg /25 ml

Doses S1 |82 | S8 Doses T | T2 | T3
(1) 189 | 206 | 222 (1) 185 | 207 | 218
2) 191 | 207 | 220 2) 188 | 208 | 226
(3) 190 | 208 | 222 (3) 188 | 207 | 224
(4) 192 | 210 | 227 (4) 190 | 210 | 222
(5) 191 | 202 | 226 (5) 188 | 208 | 218
(6) 194 | 215 | 227 (6) 194 | 208 | 228

Model: Parallel lines

Design: Randomised block

Transformation: y' =y

Variance: Observed residuals

Dilution step (Increasing): 1.5

Common slope(factor) = 41.1051 (39.1533 to 43.0568)
Correlation | r |: 0.989129

Executed by:

Calculated by:

Approved by:

Filename: ...\A304 Erythromycin Assay 3 PLA Blocks.epa. ID: EDQM/DBO/FRA

Source of variation Degrees of freedom Sum of squares Mean square F-ratio Probability
Preparations 1 13.4444 13.4444 2.610 0.119
Regression 1 6666.67 6666.67 >1000 0.000 (***)
Non-parallelism 1 1.50000 1.50000 0.291 0.594
Non-linearity 2 20.9444 10.4722 2.033 0.152

Standard 1 0.694444 0.694444 0.135 0.717

Sample 1 1 20.2500 20.2500 3.931 0.058
Quadratic curvature 1 14.2222 14.2222 2.761 0.109
Lack of quadratic fit 1 6.72222 6.72222 1.305 0.264
Treatments 5 6702.56 1340.51 260.237 0.000 (***)
Blocks 5 162.222 32.4444 6.299 0.001  (**)
Residual error 25 128.778 5.15111
Total 35 6993.56 199.816

Sample 1
(IU/mg) Lower limit | Estimate | Upper limit
Potency 888.590 923.102 958.767
Rel. to Ass. 88.9% 92.3% 95.9%
Rel. to Est. 96.3% 100.0% 103.9%
All samples Standard Sample 1




. . .
A.3.5 Erythromycin, combination of assays
[6mE%1at; Version 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
[Project [Erythromycin | [Remarks: | * *
Ass. pot. |1000.00 IU/mg * *
* oy X
Assay | Sample | Info | Lower limit Estimate Upper limit | df
1 1 874.648 936.639 100323 |25
2 1 919.331 970.838 1026.05 |25
3 1 888.590 923.102 958.767 |25
Geometric combination
Homogeneity: p = 0.298
Weighted combination Semi-weighted combination
(IU/mg) Lower limit | Estimate | Upper limit (IU/mg) Lower limit | Estimate | Upper limit
Potency 912.564 938.014 964.174 Potency 912.465 938.014 964.279
Rel. to Ass. 91.3% 93.8% 96.4% Rel. to Ass. 91.2% 93.8% 96.4%
Rel. to Est. 97.3% 100.0% 102.8% Rel. to Est. 97.3% 100.0% 102.8%
Unweighted combination
(IU/mg) Lower limit | Estimate | Upper limit
Potency 884.424 943.314 1006.12
Rel. to Ass. 88.4% 94.3% 100.6%
Rel. to Est. 93.8% 100.0% 106.7%

Executed by:

Calculated by:

Filename: No Name. ID: EDQM/DBO/FRA

Approved by:
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A.3.6 Erythropoetin rDNA, normocythaemic mice

[omE5Iat; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1

*
[Substance [Erythropoietin rDNA | [Remarks: |
‘Method ‘Normocy&haemic assay in mice ‘ *
* ok
Standard Sample 1

Sample |Ph. Eur. BRP Batch 1 Sample | Test
Ass. pot. |32500 IU / ampoule Ass. pot. |120000 |U/mg
Doses 101U | 201U | 401U Doses 101U | 201U | 401U

1) 1679 | 1377 | 1853 1) 1064 | 950 | 2715

2 1728 | 2245 | 2299 2) 1536 | 1172 | 2325

(3) 1127 | 2359 | 2298 3) 1243 | 2124 | 2163

(4) 1465 | 1907 | 2216 4) 1526 | 1748 | 2175

(5) 1765 | 1388 | 2067 (5) 1531 | 1761 | 1531

(6) 1367 | 1725 | 2457 (6) 1706 | 1970 | 1947

(7) 922 | 2467 | 1180 (7) 953 | 1753 | 1781

(8) 1070 | 1808 | 2439 (8) 1327 | 2040 | 2280

Model: Parallel lines

Design: Randomised block
Transformation: y' =y
Variance: Observed residuals

Common slope(factor) = 568.828 (396.117 to 741.539)

Correlation | r|: 0.715210

Executed by: Calculated by:

Approved by:

Filename: ...\A306 Erythropoietin rDNA PLA Blocks.epa. ID: EDQM/DBO/FRA

Source of variation Degrees of freedom Sum of squares Mean square F-ratio Probability
Preparations 1 161820 161820 1.007 0.322
Regression 1 4.97465E+06 4.97465E+06 30.965 0.000  (***)
Non-parallelism 1 9625.78 9625.78 0.060 0.808
Non-linearity 2 73889.4 36944.7 0.230 0.796

Standard 1 61633.3 61633.3 0.384 0.540

Sample 1 1 12256.0 12256.0 0.076 0.784
Quadratic curvature 1 9460.51 9460.51 0.059 0.810
Lack of quadratic fit 1 64428.8 64428.8 0.401 0.531
Treatments 5 5.21998E+06 1.04400E+06 6.498 0.000  (***)
Blocks 7 839174 119882 0.746 0.635
Residual error 35 5.62283E+06 160652
Total 47 1.16820E+07 248553

Sample 1

Sample Test

(IU/mg) Lower limit | Estimate | Upper limit

Potency 60355.0 97841.0 148972

Rel. to Ass. 50.3% 81.5% 124.1%

Rel. to Est. 61.7% 100.0% 152.3%

All samples Standard Sample 1
Ph. Eur. BRP Batch 1 Test
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.
A.3.7 Factor IX, coagulation
[6mE%1at; Version 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
[Substance [FactorIx | [Remarks: | * *
Method Coagulation ** N **
Standard Sample 1
Sample Ph. Eur. BRP Batch 1 Sample Batch 123456
Ass. pot. 10.7 IU/vial Ass. pot. 500 IU/vial
Reconstitution |1 vial / ml Reconstitution |1 vial / ml
Doses 1) (2) Doses (1) (2)
110 61.8 63.2 1/500 62.4 65.4
1/20 724 76.1 1/1000 74.0 76.1
1/40 84.8 90.0 1/2000 86.3 89.9
1/80 96.4 99.6 1/4000 96.0 99.4

Model: Parallel

lines

Design: Completely randomised

Transformation
Variance: Obse

1y = log(y)

rved residuals

Common slope(factor) = -0.0923053 (-0.0998628 to -0.0847479)

Correlation | r |: 0.987805

Ph. Eur. BRP Batch 1

Batch 123456

Executed by:

Calculated by:

Filename: ...\A307 Factor IX Coag PLA LogY.epa. ID: EDQM/DBO/FRA

Approved by:

Source of variation Degrees of freedom Sum of squares Mean square F-ratio Probability
Preparations 1 6.80762E-05 6.80762E-05 0.429 0.531
Regression 1 0.0818718 0.0818718 515.839 0.000  (***)
Non-parallelism 1 5.70673E-05 5.70673E-05 0.360 0.565
Non-linearity 4 0.000708816 0.000177204 1.116 0.413

Standard 2 0.000337761 0.000168880 1.064 0.389

Sample 1 2 0.000371055 0.000185528 1.169 0.359
Treatments 7 0.0827058 0.0118151 74.442 0.000  (***)
Residual error 8 0.00126973 0.000158716
Total 15 0.0839755 0.00559837

Sample 1
Sample Batch 123456
(IUMvial) Lower limit | Estimate | Upper limit
Potency 436.530 511.616 599.058
Rel. to Ass. 87.3% 102.3% 119.8%
Rel. to Est. 85.3% 100.0% 171%
All samples Standard Sample 1
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A.3.8 Factor VIII, chromogenic
[omE5Iat; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
‘Substance ‘Factor VIIl concentrate ‘ ‘Remarks: ‘ * *
‘ Method ‘ Chromogenic assay of Factor VIII ‘ * *
* ok
Standard Sample 1
Sample Ph. Eur. BRP Batch 2 Sample Batch 999
Ass. pot. 7.2 |Ulvial Ass. pot. 500 IU/vial
Reconstitution |1 vial / 1 ml Reconstitution |1 vial /5 ml
Pre-dil. 2 1ml/7.2ml Pre-dil. 2 1ml/100 ml
Pre-dil. 3 1ml/50ml Pre-dil. 3 1ml/50 ml
Doses S1 S2 S3 01U Doses T T2 T3
(1) 0.133 | 0.215 | 0.299 | 6022 1) 0.120 | 0.188 | 0.254
(2) 0.133 | 0.215 | 0.299 | 6024 2) 0.119 | 0.188 | 0.253
(3) 0.131 | 0.216 | 0.299 | 6024 3) 0.118 | 0.190 | 0.255
(4) 0.136 | 0.218 | 0.297 | 6026 4) 0.120 | 0.190 | 0.258
(5) 0.137 | 0.220 | 0.297 | 6023 (5) 0.120 | 0.190 | 0.257
(6) 0.136 | 0.220 | 0.305 | 6022 (6) 0.121] 0.191 | 0.257
7) 0.138 | 0.219 | 0.299 | 6022 @) 0.121] 0.191 | 0.255
(8) 0.137 | 0.218 | 0.302 | 6023 (8) 0.121] 0.190 | 0.254

Model: Slope ratio
Design: Completely randomised

Transformation:

Variance: Obse

y'=y
rved residuals

Number of non-zero doses (Increasing): 3

Common intercept = 0.0529792 (0.0517177 to 0.0542406)

Correlation | r |: 0.999518

Executed by:

Calculated by:
Filename: ...\A308 Factor VIII Chromo Slope Ratio.epa. ID: EDQM/DBO/FRA

Approved by:

Source of variation Degrees of freedom Sum of squares Mean square F-ratio Probability
Regression 2 0.191697 0.0958483 >1000 0.000  (***)
Intersection 1 2.97619E-09 2.97619E-09 0.001 0.978
Non-linearity 2 2.30208E-05 1.15104E-05 2.984 0.061

Standard 1 3.33333E-07 3.33333E-07 0.086 0.770

Sample 1 1 2.26875E-05 2.26875E-05 5.882 0.020 (%)
Treatments 5 0.191720 0.0383439 >1000 0.000  (***)
Residual error 42 0.000162000 3.85714E-06
Total 47 0.191882 0.00408259

Sample 1

Sample Batch 999
(IUMvial) Lower limit | Estimate | Upper limit
Potency 408.546 411.573 414.607
Rel. to Ass. 81.7% 82.3% 82.9%
Rel. to Est. 99.3% 100.0% 100.7%

All samples Standard Sample 1

Ph. Eur. BRP Batch 2 Batch 999




Model: Parallel lines

Design: Completely randomised
Transformation: y' = log((y+z)/2)
Variance: Observed residuals

Common slope(factor) = 0.725012 (0.675307 to 0.774717)

Correlation | r |: 0.995503

Source of variation Degrees of freedom Sum of squares Mean square F-ratio Probability
Preparations 1 0.000289614 0.000289614 1.002 0.355
Regression 1 0.232114 0.232114 803.381 0.000  (***)
Non-parallelism 1 3.01665E-05 3.01665E-05 0.104 0.758
Non-linearity 2 0.000340714 0.000170357 0.590 0.584

Standard 1 9.14836E-05 9.14836E-05 0.317 0.594

Sample 1 1 0.000249230 0.000249230 0.863 0.389
Treatments 5 0.232775 0.0465549 161.133 0.000  (***)
Residual error 6 0.00173353 0.000288922
Total " 0.234508 0.0213189

Sample 1
Sample In-house reference
(IU/ml) Lower limit | Estimate | Upper limit
Potency 996.153 1029.95 1064.68
Rel. to Ass. 99.6% 103.0% 106.5%
Rel. to Est. 96.7% 100.0% 103.4%
All samples Standard Sample 1
Ph. Eur. BRP Batch 1 In-house reference
Executed by: Calculated by: Approved by:

Filename: ...\A309 Heparin Clotting PLA LogYZ.epa. ID: EDQM/DBO/FRA
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A.3.9 Heparin sodium, clotting
[6mE%1at; Version 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
[Substance [Heparin Sodium | [Remarks: | * *
‘Method ‘European Pharmacopoeia (1997), 2.7.5 ‘ * *
* x Kk
Standard Sample 1
Sample  |Ph. Eur. BRP Batch 1 Sample |In-house reference
Ass. pot. |1044 |U/ml Ass. pot. |1000 IU/ml
Doses (1) (2) Doses (1) 2)
1.044 IU 78.9/79.8 79.0/79.1 1.000 IU 79.8/76.4 78.9/78.7
1.3211U | 108.2/113.1 | 119.1/122.5 1.2651U | 107.2/106.5 | 117.7/117.3
1.6701U | 176.9/180.1 | 173.6/169.8 1.600 IU | 168.2/171.4 | 179.3/162.7
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A.3.10 Hepatitis A vaccine, immunogenicity (in vivo)

(58515 \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
Substance |Hepatitis A Remarks: ‘ * *
Type A *
Assay Immunogenicity * * *
Standard Sample 1

Sample |Ph. Eur. BRP Batch 1 Sample |Batch 345999
Ass. pot. |37 I1U/ml Ass. pot. |40 I1U/ml
Doses (1) Doses (1)

1/24 710 1124 6/10

1/48 7110 1/48 5/10

1/96 3/10 1/96 110

1192 110 1192 0/10

1/384 110 1/384 0/10
Model: Quantal responses Common slope(factor) = 0.934926 (0.627585 to 1.24227)
Design: Completely randomised Correlation | r |: 0.930566 (Weighted)

Transformation: y' = probit(y)
Theoretical variance: 1

Source of variation Degrees of freedom Sum of squares Mean square Chi-square Probability
Preparations 1 1.05446 1.05446 1.05446 0.304
Regression 1 25.0362 25.0362 25.0362 0.000 (***)
Non-parallelism 1 0.966516 0.966516 0.966516 0.326
Non-linearity 6 3.07224 0.512041 3.07224 0.800

Standard 3 1.88308 0.627693 1.88308 0.597
Sample 1 3 1.18917 0.396389 1.18917 0.756
Treatments 9 30.1294 3.34771 30.1294 0.000 (***)
Theoretical variance 1.00000
Total 9 30.1294 3.34771
Sample 1
Sample Batch 345999
(IU/ml) Lower limit | Estimate | Upper limit
Potency 9.01185 19.6497 37.9049
Rel. to Ass. 22.5% 49.1% 94.8%
Rel. to Est. 45.9% 100.0% 192.9%

All samples Standard Sample 1
Ph. Eur. BRP Batch 1 Batch 345999
Executed by: Calculated by: Approved by:

Filename: ...\A310 HepA Immunogen Quantal Probit.epa. ID: EDQM/DBO/FRA




o e . .
A.3.11 Hepatitis B vaccine, antigen content by ELISA
[6mE%1at; Version 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
[Substance [Hepatitis B vaccine | [Remarks: | * *
Method A * *
\ \ \ * gk
Standard Sample 1 Sample 2

Sample |S Sample |T Sample |U
Ass. pot. |20 pg protein / ml Ass. pot. |20 pg protein / ml Ass. pot. |20 pg protein / ml
Doses Mm@l e Doses Ml el e Doses Mm@l e

1/1000 | 0.514 | 0.531 | 0.545 1/1000 | 1.140 | 1.386 | 1.051 1/1000 | 0.957 | 0.866 | 1.045

1/2000 | 0.283 | 0.295 | 0.362 1/2000 | 0.501 | 0.665 | 0.576 1/2000 | 0.586 | 0.489 | 0.546

1/4000 | 0.159 | 0.154 | 0.166 1/4000 | 0.327 | 0.355 | 0.345 1/4000 | 0.277 | 0.268 | 0.269

1/8000 | 0.093 | 0.099 | 0.082 1/8000 | 0.167 | 0.157 | 0.178 1/8000 | 0.127 | 0.146 | 0.133

1/16000 | 0.043 | 0.045 | 0.051 1/16000 | 0.097 | 0.097 | 0.094 1/16000 | 0.086 | 0.071 | 0.073

Model: Parallel lines Common slope(factor) = 0.904279 (0.881562 to 0.926996)

Design: Completely randomised
Transformation: y' = In (y)
Variance: Observed residuals

Correlation | r |: 0.996069

Executed by:

Calculated by:

Approved by:

Filename: ...\A311 HepB Ag Content PLA LogY.epa. ID: EDQM/DBO/FRA

Source of variation Degrees of freedom Sum of squares Mean square F-ratio Probability
Preparations 2 3.97720 1.98860 256.703 0.000  (***)
Regression 1 35.3589 35.3589 >1000 0.000  (***)
Non-parallelism 2 0.0156343 0.00781717 1.009 0.377
Non-linearity 9 0.0630420 0.00700466 0.904 0.534

Standard 3 0.0170324 0.00567748 0.733 0.541

Sample 1 3 0.0282553 0.00941843 1.216 0.321

Sample 2 3 0.0177542 0.00591808 0.764 0.523
Treatments 14 39.4147 2.81534 363.424 0.000  (***)
Residual error 30 0.232401 0.00774670
Total 44 39.6471 0.901072

Sample 1 Sample 2

Sample T Sample ]

(ug protein/ml) | Lower limit| Estimate | Upper limit (ug protein/ml) | Lower limit | Estimate | Upper limit
Potency 40.4020 43.5762 47.0668 Potency 32.7374 35.2553 38.0062
Rel. to Ass. 202.0% 217.9% 235.3% Rel. to Ass. 163.7% 176.3% 190.0%
Rel. to Est. 92.7% 100.0% 108.0% Rel. to Est. 92.9% 100.0% 107.8%

All samples Standard Sample 1 Sample 2
S T V]
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A.3.12 Hepatitis A immunoglobulin, ELISA

[omE5Iat; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
‘Substance ‘Human Hepatitis Aimmunoglobulin ‘ ‘Remarks: ‘ * *
[Method __[Elisa | * *
* ok
Standard Sample 1
Sample Ph. Eur. BRP Batch 1 Sample Batch 35K09755
Ass. pot. 10.2 [UMvial Ass. pot. 600 IU/ampoule
Reconstitution |1 vial / ml Reconstitution |1 ampoule / ml
Doses (1) (2) (3) Doses (1) (2) (3)
0.080 IU 0.077 | 0.079 | 0.080 0.080 IU 0.040 | 0.042 | 0.035
0.040 IU 0.206 | 0.204 | 0.211 0.040 IU 0.136 | 0.128 | 0.136
0.020 IU 0.401 | 0.409 | 0.411 0.020 IU 0.297 | 0.29 | 0.302
0.010 IU 0.633 | 0.629 | 0.649 0.010 IU 0.502 | 0.508 | 0.518
Model: Parallel lines Common slope(factor) = -0.249882 (-0.252565 to -0.247200)
Design: Completely randomised Correlation | r |: 0.999514

Transformation: y' = sqrt(y)
Variance: Observed residuals

Source of variation Degrees of freedom Sum of squares Mean square F-ratio Probability
Preparations 1 0.0462082 0.0462082 >1000 0.000  (***)
Regression 1 0.900001 0.900001 >1000 0.000  (***)
Non-parallelism 1 4.46096E-06 4.46096E-06 0.131 0.722
Non-linearity 4 0.000372149 9.30372E-05 2.734 0.066

Standard 2 0.000301770 0.000150885 4.433 0.029 (%)

Sample 1 2 7.03791E-05 3.51896E-05 1.034 0.378
Quadratic curvature 1 6.14615E-05 6.14615E-05 1.806 0.198
Lack of quadratic fit 3 0.000310687 0.000103562 3.043 0.059
Treatments 7 0.946586 0.135227 >1000 0.000  (***)
Residual error 16 0.000544535 3.40335E-05
Total 23 0.947131 0.0411796

Sample 1

Sample Batch 35K09755

(IlU/ampoule) | Lower limit | Estimate | Upper limit

Potency 835.028 852.459 870.357

Rel. to Ass. 139.2% 142.1% 145.1%

Rel. to Est. 98.0% 100.0% 102.1%

All samples Standard Sample 1
Ph. Eur. BRP Batch 1 Batch 35K09755

Executed by: Calculated by: Approved by:

Filename: ...\A312 HepA Ig Content PLA SqrtY.epa. ID: EDQM/DBO/FRA




Model: Quantal respons:

es

Design: Completely randomised
Transformation: y' = probit(y)

Theoretical variance: 1

Common slope(factor) = -1.53264 (-1.76609 to -1.29919)
Correlation | r |: 0.957788 (Weighted)

Ph. Eur. BRP Batch 1

Batch 9999999

Executed by:

Calculated by:

Approved by:
Filename: ...\A313 Rabies Ig Content Quantal Probit.epa. ID: EDQM/DBO/FRA

Source of variation Degrees of freedom Sum of squares Mean square Chi-square Probability
Preparations 1 0.00292547 0.00292547 0.00292547 0.957
Regression 1 116.611 116.611 116.611 0.000 (***)
Non-parallelism 1 0.659508 0.659508 0.659508 0.417
Non-linearity 8 7.23974 0.904967 7.23974 0.511

Standard 6 6.38514 1.06419 6.38514 0.381

Sample 1 2 0.854600 0.427300 0.854600 0.652
Treatments 1" 124.514 11.3194 124.514 0.000 (***)
Residual error 4 2.60625 0.651563 2.60625 0.626
Theoretical variance 1.00000
Total 15 127.120 8.47466

Sample 1

Sample Batch 9999999
(IU/ml) Lower limit | Estimate | Upper limit
Potency 126.054 158.663 199.623
Rel. to Ass. 84.0% 105.8% 133.1%
Rel. to Est. 79.4% 100.0% 125.8%

All samples Standard Sample 1
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A.3.13 Rabies immunoglobulin, RFFIT
[6mE%1at; Version 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
Substance |Human rabies immunoglobulin ‘Remarks: ‘ * *
Method RFFIT * *
Assay date |31/12/1999 * o X
Standard Sample 1
Sample Ph. Eur. BRP Batch 1 Sample Batch 9999999
Ass. pot. 91 IUMNial Ass. pot. 150 1U/ml
Reconstiturion |1 vial /1 ml Pre-dil. 1 1ml/80ml
Pre-dil. 2 1ml/50 ml
Doses 1) (2) Doses (1) )
1/8 3/20 1/10 1/20 3/20
110 4/20 1/20 7/20 11/20
116 7120 1/40 16/20 16/20
1/20 7120 1/80 20/20 20/20
1/32 16/20
1/40 15/20
1/64 20/20
1/80 20/20
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A.3.14 Tetanus vaccine, lethal challenge

[omE5Iat; \fersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
‘Substance ‘Tetanus vaccine (adsorbed) ‘ ‘Remarks: ‘ * *
‘Method ‘Test in guinea-pigs * *
* ok
Standard Sample 1
Sample Ph. Eur. BRP Batch 1 Sample Batch G55K99a
Ass. pot. 250 IU/ampoule Ass. pot. 21U/ ml
Reconstitution |1 ampoule /2 ml Conversion 1 ml/ 1000 pl
Pre-dilution 2ml/32ml Pre-dilution 800 pl /49.8 ml
Doses 1) Doses (1)
n 12/12 17 12112
12 8/12 12 7nm2
1/4 3112 1/4 0/12
1/8 0/12 1/8 012

Model: Quantal responses
Design: Completely randomised
Transformation: y' = probit(y)
Theoretical variance: 1

Common slope(factor) = 2.63125 (1.82472 to 3.43779)
Correlation | r |: 0.952688 (Weighted)

Source of variation Degrees of freedom Sum of squares Mean square Chi-square Probability
Preparations 1 0.000117213 0.000117213 0.000117213 0.991
Regression 1 28.7961 28.7961 28.7961 0.000  (***)
Non-parallelism 1 1.75954 1.75954 1.75954 0.185
Non-linearity 4 1.17164 0.292909 1.17164 0.883

Standard 2 1.13392 0.566959 1.13392 0.567

Sample 1 2 0.0377184 0.0188592 0.0377184 0.981
Treatments 7 31.7274 4.53248 31.7274 0.000  (***)
Theoretical variance 1.00000
Total 7 31.7274 4.53248

Sample 1
Sample Batch G55K99a
(IU/ml) Lower limit | Estimate | Upper limit
Potency 275.335 382.451 530.963
Rel. to Ass. ? ? ?
Rel. to Est. 72.0% 100.0% 138.8%
All samples Standard Sample 1
Ph. Eur. BRP Batch 1 Batch G55K99a

Executed by: Calculated by:

Approved by:

Filename: ...\A314 Tetanus Challenge Quantal Probit.epa. ID: EDQM/DBO/FRA
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A.3.15 Inactivated poliomyelitis vaccine, D-antigen content

[6mE%1at; Version 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1

‘Substance ‘Inactivated poliomyelitis vaccine ‘ ‘Remarks: ‘
Type ‘3
Standard Sample 1

Preparation | Ph. Eur. BRP Batch 1 Preparation |Batch 45A54B
Ass. pot. 285 D-Ag U/ml Ass. pot. 160 D-Ag U/ml
Doses (1) (2) (3) (4) Doses (1) ) (3) (4)

1/30 0.418 | 0.460 | 0.469 | 0.464 115 0.416 | 0.467 | 0.390 | 0.451

1/60 0.258 | 0.293 | 0.270 | 0.245 1/30 0.239 | 0.277 | 0.261 | 0.291

1120 0.150 | 0.165 | 0.167 | 0.168 1/60 0.120 | 0.144 | 0.124 | 0.174

1/240 0.073 | 0.081 | 0.110 | 0.140 1/120 0.095 | 0.084 | 0.060 | 8485

Model: Parallel lines

Design: Completely randomised
Transformation: y' = log(y)
Variance: Observed residuals

Common slope(factor) = 0.338369 (0.311572 to 0.365165)

Correlation | r |: 0.973689

Executed by:

Calculated by:

Approved by:

Filename: ...\A315 D Antigen Content PLA LogY.epa. ID: EDQM/DBO/FRA

Source of variation Degrees of freedom Sum of squares Mean square F-ratio Probability
Preparations 1 0.00340861 0.00340861 0.772 0.389
Regression 1 2.06832 2.06832 468.356 0.000  (***)
Non-parallelism 1 0.00770829 0.00770829 1.745 0.199
Non-linearity 4 0.00419635 0.00104909 0.238 0.914

Standard 2 0.000203041 0.000101521 0.023 0.977

Sample 1 2 0.00399331 0.00199665 0.452 0.642
Quadratic curvature 1 0.000462688 0.000462688 0.105 0.749
Lack of quadratic fit 3 0.00373366 0.00124455 0.282 0.838
Treatments 7 2.08364 0.297663 67.403 0.000  (***)
Residual error 23 0.101571 0.00441613
Total 30 2.18521 0.0728403

Sample 1

Preparation Batch 45A54B

(D-Ag U/ml) | Lower limit | Estimate | Upper limit

Potency 107.839 124.963 144.641

Rel. to Ass. 67.4% 78.1% 90.4%

Rel. to Est. 86.3% 100.0% 115.7%

All samples Standard Sample 1
Ph. Eur. BRP Batch 1 Batch 45A54B
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A.3.16 Influenza vaccine, single radial immunodiffusion

(EmE51aT Version 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1

Substance Influenza vaccine ‘Remarks: ‘
Method Single radial immunodiffusion
Determination | Haemagglutinin antigen content
Standard Sample 1 Sample 2
Sample Reference Sample Batch 345 Sample Batch 346
Ass. pot. 39 pg / dose Ass. pot. 15 pg / dose Ass. pot. 15 pg / dose
Reconstitution |1 dose /0.5 ml Reconstitution |1 dose /0.5 ml Reconstitution |1 dose /0.5 ml
Dilution 1ml/39ml Dilution 1mi/15ml Dilution 1mli/15 ml
Doses (1) 2) Doses (1) ) Doses (1) 2)
1/4 5.6/5.7 | 5.7/5.6 1/4 5.4/5.2 | 5.5/5.6 1/4 5.3/54 | 5.4/5.3
12 6.1/6.2 | 6.2/6.5 12 6.2/6.2 | 6.2/6.5 12 5.9/5.9 | 5.7/5.7
3/4 6.8/7.0 | 6.9/6.9 3/4 6.7/6.9 | 6.6/6.7 3/4 6.3/6.3 | 6.3/6.1
n 7474 | 73176 n 71/7.4 | 7.5/7.6 n 6.6/6.6 | 6.6/6.5

Model: Slope ratio
Design: Completely randomised

Transformation:

1y = ((y2)-(3"3))pir4

Variance: Observed residuals

Common intercept = 11.1160 (10.1173 to 12.1147)

Correlation | r |: 0.9

89988

Executed by:

Calculated by:

Approved by:

Filename: ...\A316 Flu SRID Slope Ratio YZ Area.epa. ID: EDQM/DBO/FRA

Source of variation Degrees of freedom Sum of squares Mean square F-ratio Probability
Regression 3 1087.22 362.405 288.559 0.000 (***)
Intersection 2 2.46581 1.23291 0.982 0.403
Non-linearity 6 4.56414 0.760691 0.606 0.722

Standard 2 0.409117 0.204558 0.163 0.852

Sample 1 2 3.76503 1.88251 1.499 0.262

Sample 2 2 0.389997 0.194999 0.155 0.858
Treatments 11 1094.25 99.4769 79.207 0.000 (***)
Residual error 12 15.0709 1.25591
Total 23 1109.32 48.2312

Sample 1 Sample 2
Sample Batch 345 Sample Batch 346
(ug/dose) Lower limit | Estimate | Upper limit (pg/dose) Lower limit | Estimate | Upper limit
Potency 13.3493 14.3548 15.4267 Potency 8.62938 | 9.58347 10.5403
Rel. to Ass. 89.0% 95.7% 102.8% Rel. to Ass. 57.5% 63.9% 70.3%
Rel. to Est. 93.0% 100.0% 107.5% Rel. to Est. 90.0% 100.0% 110.0%
All samples Standard Sample 1 Sample 2
Reference Batch 345 Batch 346

* 6 %
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A.3.17 Inverted ED50 units
[6ms’57aT5 \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
‘Exarnple ‘Invened ED50 units ‘ ‘Remarks: ‘ * *
* *
LY ¢
Sample 1
Ass. pot. |61700 IU/ml
Doses oy 2.59IU | 3.63IU | 5.08lU | 7.11IU | 9.96lU | 13.95IU | 19.52IU | 27.33IU | 38.27IU | 53.57IU | 75IU
(1) 6-+799 0.786 0.877 0.644 0.696 0.497 0.395 0.291 0.233 0.214 0.209 0.217
(2) 0928 0.853 0.801 0.762 0.675 0.561 0.415 0.289 0.235 0.222 0.225 0.208
(3) 0:842 0.793 0.891 0.76 0.681 0.564 0.429 0.31 0.254 0.212 0.222 0.206
(4) 0965 0.815 0.788 0.742 0.682 0.57 0.416 0.309 0.235 0.212 0.219 0.212
Sample 2
Ass. pot. |56700000 IU/ml
Doses oy 2.59IU | 3.63IU | 5.08lU | 7.11IU | 9.96lU | 13.95IU | 19.52IU | 27.33IU | 38.27IU | 53.57IU | 75IU
(1) 0983 0.847 0.795 0.708 0.673 0.516 0.414 0.32 0.253 0.214 0.209 0.204
(2) 0957 0.858 0.843 0.708 0.643 0.506 0.386 0.295 0.241 0.216 0.212 0.21
(3) 0965 0.777 0.808 0.701 0.619 0.514 0.396 0.277 0.235 0.215 0.23 0.21
(4) 0946 0.784 0.768 0.71 0.606 0.532 0.378 0.262 0.243 0.219 0.211 0.215

Model: y=d+a*(Igt(x)) where x=c.+b*In(dose)
Design: Completely randomised

Weight function: w=1/m"2

Variance: Observed residuals

Common slope(factor): b = -2.79255 (-2.89635 to -2.68874)
Correlation | r |: 0.976377 (Weighted)
Asymptotes: 0.205950 and 0.824520

Executed by:

Calculated by:

Approved by:

Filename: ...\A317 ED50 4PL Weighted Sigmoid.epa. ID: EDQM/DBO/FRA

Source of variation Degrees of freedom Sum of squares Mean square Chi-square Probability
Preparations 1 9.73849E-08 9.73849E-08 5.22176E-05 0.994
Regression 1 3.65148 3.65148 1957.92 0.000 (***)
Non-parallelism 1 0.00727755 0.00727755 3.90221 0.048 (%)
Non-linearity 18 0.0484655 0.00269253 25.9871 0.100

Sample 1 9 0.0307804 0.00342005 16.5044 0.057
Sample 2 9 0.0176851 0.00196501 9.48271 0.394
Treatments 21 3.70722 0.176534 1987.81 0.000 (***)
Residual error 66 0.123089 0.00186498
Total 87 3.83031 0.0440266
Sample 1 Sample 2
(IU/ml) Lower limit | Estimate | Upper limit (IU/ml) Lower limit | Estimate | Upper limit
IU/ED50 10.3742 10.6804 10.9848 IU/ED50 9.73711 10.0245 10.3103
Rel. to Ass. 9.1% 9.4% 9.6% Rel. to Ass. 9.7% 10.0% 10.3%
Rel. to Est. 97.2% 100.0% 103.0% Rel. to Est. 97.2% 100.0% 103.0%
All samples Sample 1 Sample 2
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A.3.18 Inverted ED50 volumes

(omE5Tal; Version 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
[substance | | ‘Remarks: * *
* p Kk
Sample 1

Ass. pot. |? IU/dose
Pre-dil. 1 |1 dose/0.5ml
Pre-dil. 2 |0.1ml/well

Doses 1)

-2.4 log 10/10

-3.0 log 8/10

-3.6 log 2/10

4.2 log 0/10
Model: r/n=(Igt(x)) where x=c.+b*In(dose) Common slope(factor): b = 2.26625 (1.14038 to 3.39211)
Design: Completely randomised Correlation | r |: 0.987224 (Weighted)

Weight function: w=n/(m*(1-m))
Theoretical variance: 1

Source of variation Degrees of freedom Sum of squares Mean square Chi-square Probability
Regression 1 10.9622 10.9622 10.9622 0.001  (***)
Non-linearity 2 0.285566 0.142783 0.285566 0.867
Treatments 3 11.2477 3.74924 11.2477 0.010 ()
Theoretical variance 1.00000
Total 3 11.2477 3.74924

Sample 1
(IU/dose) Lower limit Estimate Upper limit
dose/ED50 | 5.41622E-05 | 0.000100237 | 0.000185508
Rel. to Ass. ? ? ?
Rel. to Est. 54.0% 100.0% 185.1%
Sample 1
Executed by: Calculated by: Approved by:

Filename: ...\A318 ED50 Quantal Logit.epa. ID: EDQM/DBO/FRA
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A.3.19 MMR vaccine / Measles, ED50 using ratios
(8515t \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
‘ Substance ‘ MMR vaccine ‘ ‘Remarks: See the other MMR examples for alternative ways of presenting the data. ‘ * *
‘Component ‘Measles * N *
Standard Sample 1
Preparation Ph. Eur. BRP Batch 1 Preparation Batch 123A456
Ass. pot. 4.3 1og10 IU/vial Ass. pot. ? log10 IU/vial
Reconstitution vol. |1 vial / 500 pl Reconstitution vol. |1 vial / 500 pl
Inoculation vol. 100 pl / well Inoculation vol. 100 pl / well
Doses 1) Doses 1)
-1.6 log10 8/8 -1.6 log10 8/8
-2.21og10 8/8 -2.21log10 8/8
-2.8 log10 8/8 -2.8log10 8/8
-3.4 log10 6/8 -3.4log10 7/8
-4.0 log10 4/8 -4.0 log10 2/8
-4.6 log10 1/8 -4.6 log10 18
-5.2log10 0/8 -5.2log10 18
Model: Determination ED50 Common slope(factor) = 0.706600 (0.507139 to 0.906061)
Design: Completely randomised Correlation | r |: 0.914704 (Weighted)
Transformation: y' = probit(y)
Theoretical variance: 1
Source of variation Degrees of freedom Sum of squares Mean square Chi-square Probability
Preparations 1 0.000133922 0.000133922 0.000133922 0.991
Regression 1 33.9536 33.9536 33.9536 0.000 (***)
Non-parallelism 1 0.288249 0.288249 0.288249 0.591
Non-linearity 10 6.33934 0.633934 6.33934 0.786
Standard 5 0.540325 0.108065 0.540325 0.991
Sample 1 5 5.79901 1.15980 5.79901 0.326
Treatments 13 40.5813 3.12164 40.5813 0.000 (***)
Theoretical variance 1.00000
Total 13 40.5813 3.12164
Standard Sample 1
Preparation Ph. Eur. BRP Batch 1 Preparation Batch 123A456
(log10 IU/vial) Lower limit Estimate Upper limit (log10 IU/vial) Lower limit | Estimate | Upper limit
Potency 4.30000 4.30000 4.30000 Potency 3.87154 4.34326 4.81565
Rel. to Ass. +0.00000 +0.00000 +0.00000 Rel. to Ass. ? ? ?
Rel. to Est. 0.00000 0.00000 +0.00000 Rel. to Est. -0.471722 | 0.00000 | +0.472392
log10 ED50/vial 4.29248 4.62444 4.95988 log10 ED50/vial 4.33579 4.66770 5.00375
Rel. to Ass. -0.00752453 | +0.324442 +0.659885 Rel. to Ass. ? ? ?
Rel. to Est. -0.331966 0.00000 +0.335443 Rel. to Est. -0.331907 | 0.00000 | +0.336054
All samples Standard Sample 1

Ph. Eur. BRP Batch 1

Batch 123A456

Executed by:

Calculated by:

Approved by:

Filename: ...\A319 ED50 Measles Quantal Probit aggre data.epa. ID: EDQM/DBO/FRA
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A.3.20 MMR vaccine / Mumps, ED50 using + /- per well

[omt%Tat; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 2 >* * *
* *
‘ Substance ‘ MMR vaccine ‘ ‘Remarks: See the other MMR examples for alternative ways of presenting the data. ‘ * *
‘Component ‘Mumps ‘ *
* 4k
Standard Sample 1
Preparation Ph. Eur. BRP Batch 1 Preparation Batch 123A456
Ass. pot. 4.6 1og10 IU / vial Ass. pot. ? log10 1U/vial
Reconstitution vol. |1 vial / 500 pl Reconstitution vol. |1 vial / 700 pl
Pre-dilution 1 100 pl /1000 pl Pre-dilution 1 100 pl /1000 pl
Pre-dilution 2 100 pl /1000 pl Pre-dilution 2 500 pl /2000 pl
Pre-dilution 3 500 pl /2000 pl Inoculation volume | 100 pl / well
Inoculation volume |[100 pl / well
Doses S1/S2|S3|S4|S5]|S6 Doses T1|T2|T3|T4|T5|T6
1) + + + - - - (1) + + - + - -
) + + + - - - ) + + + - - -
@ e -l- - @) -1
4) + + + - - 4) + + - - -
(5) + + + - - - (5) + + - - - -
(6) + + + - - - (6) + + - - - -
(7) + - - - (7) o o A e
(8) + + + + - - (8) + + - - - -
9) + + + - - - 9) + + - - - -
(10) + + + + - - (10) + + + - - -
Model: Determination ED50 Common slope(factor) = 0.785319 (0.579042 to 0.991596)
Design: Completely randomised Correlation | r |: 0.588428 (Weighted)
Transformation: y' = probit(y)
Theoretical variance: 1
Dilution step (Decreasing): 4
Source of variation Degrees of freedom Sum of squares Mean square Chi-square Probability
Preparations 1 0.00193295 0.00193295 0.00193295 0.965
Regression 1 39.2143 39.2143 39.2143 0.000 (***)
Non-parallelism 1 0.0573792 0.0573792 0.0573792 0.811
Non-linearity 8 2.02714 0.253392 2.02714 0.980
Standard 4 0.831190 0.207798 0.831190 0.934
Sample 1 4 1.19595 0.298986 1.19595 0.879
Treatments 1 41.3008 3.75462 41.3008 0.000 (***)
Residual error 108 71.9602 0.666298 71.9602 0.997
Theoretical variance 1.00000
Total 119 113.261 0.951772
Standard Sample 1
Preparation Ph. Eur. BRP Batch 1 Preparation Batch 123A456
(log10 IU/vial) Lower limit | Estimate | Upper limit (log10 IU/vial) Lower limit | Estimate | Upper limit
Potency 4.60000 4.60000 4.60000 Potency 3.06661 3.46446 3.86048
Rel. to Ass. +0.00000 | +0.00000 | +0.00000 Rel. to Ass. ? ? ?
Rel. to Est. 0.00000 0.00000 +0.00000 Rel. to Est. -0.397857 | 0.00000 | +0.396020
log10 ED50/vial 4.45322 4.73374 5.01399 log10 ED50/vial 3.31617 3.59821 3.87813
Rel. to Ass. -0.146779 | +0.133744 | +0.413985 Rel. to Ass. ? ? ?
Rel. to Est. -0.280523 | 0.00000 | +0.280241 Rel. to Est. -0.282039 | 0.00000 | +0.279919

Filename: ...\A320 ED50 Mumps Quantal Probit raw data.epa. ID: EDQM/DBO/FRA
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[em857at; \lersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 2 of 2 * * *
* *
‘Substance ‘MMR vaccine ‘ * *
* *
‘Component ‘Murnps ‘ * N *

All samples Standard Sample 1
Ph. Eur. BRP Batch 1 Batch 123A456

Executed by: Calculated by: Approved by:

Filename: ...\A320 ED50 Mumps Quantal Probit raw data.epa. ID: EDQM/DBO/FRA
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A.3.21 Oral poliomyelitis vaccine, ELISA

[em857aT5 \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
[Substance [Oral polyomyelitis vaccine | [Remarks: | * *
[Method |Elisa | * *
* ok
Sample 1
Ass. pot. 6.5 log ED50 / ml
Conversion |1 ml/1000 pl
Inoculation |50 ul / well
Doses (1)
-3.5 log 8/8
-4.0 log 8/8
-4.5 log 7/8
-5.0 log 6/8
-5.5 log 2/8
-6.0 log 1/8
-6.5 log 1/8
-7.0 log 0/8
-7.5 log 0/8
-8.0 log 0/8
Model: Determination ED50 Common slope(factor) = 0.646230 (0.426197 to 0.866263)
Design: Completely randomised Correlation | r |: 0.946529 (Weighted)

Transformation: y' = probit(y)
Theoretical variance: 1

Source of variation Degrees of freedom Sum of squares Mean square Chi-square Probability
Regression 1 23.3374 23.3374 23.3374 0.000  (***)
Non-linearity 8 271119 0.338899 2.71119 0.951
Treatments 9 26.0486 2.89429 26.0486 0.002  (*)
Theoretical variance 1.00000
Total 9 26.0486 2.89429

Sample 1
(log10 ED50/ml) | Lower limit | Estimate | Upper limit
log10 ED50/ml 6.30328 6.63128 6.95780
Rel. to Ass. -0.196725 | +0.131276 | +0.457795
Rel. to Est. -0.328001 0.00000 | +0.326519
Sample 1
Executed by: Calculated by: Approved by:

Filename: ...\A321 ED50 Oral Polio Quantal Probit.epa. ID: EDQM/DBO/FRA
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A.3.22 Acellular pertussis, limit test with quantitative data

[6mE%1at; Version 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1

‘Substance ‘Perlussis (acellular) ‘ ‘Remarks:
‘Method ‘Inhouse immunogenecity test in mice ‘
Standard Sample 1
Sample In-house reference Sample Batch 4522C
Ass. pot. 1 inhouse unit / dose Ass. pot. 1 inhouse unit / dose
Dilution 1 dose /2 ml Dilution 1 dose /1 ml
Administered |0.5 ml / mouse Administered |0.5 ml / mouse
Doses Relative antibody titres Doses Relative antibody titres
(1) 0.867 (1) 1.068
(2) 0.568 (2) 0.845
(3) 0.674 (3) 0.964
4) 0.550 (4) 1.274
(5) 0.598 (5) 0.686
(6) 0.732 (6) 1.160
Sample 1
Sample Batch 4522C
Limit tested | 0.500000 inhouse unit / dose
Probability 0.008 (**)
All samples Standard Sample 1
In-house reference Batch 4522C
Executed by: Calculated by: Approved by:

Filename: ...\A322 Limit Test Quantitative Resp.epa. ID: EDQM/DBO/FRA
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A.3.23 Yellow fever vaccine, plaque forming units

[omE5Iat; \fersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1

‘Substance ‘Yellowfevervaccine ‘
[Method  |A

Sample 1
Ass. pot. |?log10 PFU/mI
Pre-dil. 1 |0.2 ml/well
Doses M1 @] @
-5log10 | 86 | 80 | 90
-6log10 9 12 1"
-7log10 3 3 2

Design: Completely randomised
Weight function: w=1/m
Theoretical variance: 1

Remarks:

This example is based on an example given in WHO/BS/03.1985 Rev. 1
Unfortunately, the WHO document only gives the mean counts per dilution and
not the individual results. It also does not specify on how many replicates the
mean is based. Without this knowledge it is not possible to calculate the
confidence limits.

For the purpose of this example it was assumed that 3 replicates were perfomed
and 3 random counts were 'recreated’ in such a way that the mean is (almost)
identical to the mean in the document. The weight of 1/m is based on the
assumption that the counts follow a Poisson distribution.

Another possibility would have been to use the mean values, and specify a
weight function of w=3/m. (the number 3 is the number of replicates on which the
mean is based).

Model: y=100*(exp(x)) where x=c.+b*In(dose)

Correlation | r |: 0.972745 (Weighted)
Multiplication: a = 100.000, Addition: d = 0.00000

Source of variation Degrees of freedom | Sum of squares Mean square Chi-square Probability
Regression 1 113.471 113.471 113.471 0.000  (***)
Non-linearity 1 4.60255 4.60255 4.60255 0.032 (%)
Treatments 2 118.073 59.0366 118.073 0.000 (***)
Residual error 6 1.84500 0.307500 1.84500 0.933
Theoretical variance 1.00000
Total 8 119.918 14.9898

Sample 1

(log10 PFU/mI) | Lower limit Estimate Upper limit

log10 ED(1)/ml 7.59834 7.64782 7.69729

Rel. to Ass. ? ? ?
Rel. to Est. -0.0494751 0.00000 +0.0494751
Sample 1
Executed by: Calculated by: Approved by:

Filename: ...\A323 Yellow Fever Vaccine Exponential Reg.epa. ID: EDQM/DBO/FRA

Common slope(factor): b = 1.00000 (fixed, p = 0.006)
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A.3.24 Tetanus immunoglobulins, toxoid binding inhibition

[EmE5IaT; Version 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 2 * * *
* *
‘Substance ‘Human Tetanus Immunoglobulins ‘ ‘Remarks: ‘ * *
[Method | Toxoid binding Inhibition Assay (TIA) | * *
* oy K
Standard Sample 1 Sample 2 Sample 3
Id. BRP Id. Sample A Id. Sample B Id. Sample C
Ass. pot. |1201U/ml Ass. pot. |?1U/ml Ass. pot. | ?1U/ml Ass. pot. |?1U/ml
Pre-dil. 1 [ 1ml/100ml Pre-dil. 1 {1mlI/100ml Pre-dil. 1 {1ml/100ml Pre-dil. 1 {1ml/100ml
Pre-dil. 2 | 1ml/3ml Pre-dil. 2 | 1ml/7.5ml Pre-dil. 2 | 1ml/7.5ml Pre-dil. 2 [ 1ml/3.6ml
Doses 1) 2) Doses (1) (2) Doses (1) (2) Doses (1) )
20/20 | 0.592 | 0.505 20/20 | 0.524 | 0.516 20/20 | 0.515 | 0.497 20/20 | 0.514 | 0.534
10/20 | 0.637 | 0.599 10/20 | 0.652 | 0.656 10/20 | 0.625 | 0.632 10/20 | 0.561 | 0.616
9/20 | 0.719 | 0.704 9/20 | 0.788 | 0.803 9/20 ] 0.790 | 0.719 9/20 | 0.631 | 0.767
8/20 | 1.003 | 0.843 8/20 | 1.193 | 1.150 8/20 1.211 | 0.962 8/20 | 0.835 | 0.900
7120 1.373 | 1.386 7/20 1.509 | 1.765 7/20 1.864 | 1.327 7120 1.120 | 1.365
6/20 1.875 | 2.024 6/20 2.307 | 2.175 6/20 2.221 | 2.029 6/20 1.620 | 2.091
5/20 2711|2572 5/20 2.530 | 2.686 5/20 2.977 | 2.673 5/20 2.334 | 2.834
2/20 3.206 | 2.885 2/20 2.907 | 3.031 2/20 2.529 | 2.995 2/20 3.009 | 3.208
Design | (1) | 2) | @) | 4 | (5) | (6) | (7) | 8) | (9 |(10) | (11) | (12)
(A) Neg A [ 21101 [ 3111 [ 41111 [ 1112 | 2[1]2 | 3[1]2 | 4]1]2 Pos
(B) | Neg 1021 | 21211 | 31211 | 41211 | 11212 | 21212 | 3[2]2 | 4]212 Pos
(C) | Neg 11311 | 21311 | 313]1 | 413]1 | 11312 | 213]12 | 3]3]2 | 4[3]2 Pos
(D) Neg 11411 | 21411 | 31411 | 4]4]1 | 1]4]2 | 2]4]2 | 3|42 | 44|12 Pos
(E) Neg 11511 | 2|51 | 3|5]1 | 4I5]1 | 1]5]2 | 2|5]2 | 3]5]2 | 4]5|2 Pos
(F) Neg 11611 | 26]1 | 3|6]1 | 4]6]1 | 1]6]2 | 2|6]2 | 3]6]2 | 4|6|2 Pos
(G) Neg U710 21711 | 31711 | 41711 [ 11712 | 2|72 | 3]7|2 | 47|12 Pos
(H) Neg 1181 ] 281 | 3|8]1 | 4I8]1 | 1]8]2 | 2|8]2 | 3[8|2 | 4]8]2 Pos
Observ. | (1) | (2 | ®) | 4 | (5) | 6) | ) | ®) | (9 | (10) | (11) | (12)
(A) 0.197 0.592 | 0.524 | 0.515 | 0.514 | 0.505 | 0.516 | 0.497 | 0.534 1.293
(B) 0.183 0.637 | 0.652 | 0.625 | 0.561 | 0.599 | 0.656 | 0.632 | 0.616 1.063
(C) 0.192 0.719 | 0.788 | 0.790 | 0.631 | 0.704 | 0.803 | 0.719 | 0.767 1.482
(D) 0.194 1.003 | 1.193 | 1.211 | 0.835 | 0.843 | 1.150 | 0.962 | 0.900 1.372
(E) 0.199 1.373 | 1.509 | 1.864 | 1.120 | 1.386 | 1.765 | 1.327 | 1.365 1.419
(F) 0.203 1.875 | 2.307 | 2.221 | 1.620 | 2.024 | 2.175 | 2.029 | 2.091 1.471
(G) 0.211 2.711 | 2.530 | 2.977 | 2.334 | 2.572 | 2.686 | 2.673 | 2.834 1.543
(H) 0.206 3.206 | 2.907 | 2.529 | 3.009 | 2.885 | 3.031 | 2.995 | 3.208 1.678
Model: y=d+a*(Igt(x)) where x=c.+b*In(dose) Common slope(factor): b = -7.20313 (-7.71172 to -6.69453)
Design: Completely randomised Correlation | r |: 0.966216 (Weighted)
Weight function: w=1/m*2 Asymptotes: 0.519808 and 2.96044
Variance: Observed residuals
Source of variation Degrees of freedom Sum of squares Mean square Chi-square Probability
Preparations 3 0.00441498 0.00147166 0.517661 0.915
Regression 1 4.62846 4.62846 542.692 0.000  (***)
Non-parallelism 3 0.00292836 0.000976119 0.343353 0.952
Non-linearity 24 0.0537980 0.00224158 6.30788 1.000
Standard 6 0.0104158 0.00173597 1.22127 0.976
Sample 1 6 0.0115397 0.00192328 1.35304 0.969
Sample 2 6 0.0232965 0.00388275 2.73154 0.842
Sample 3 6 0.00854606 0.00142434 1.00203 0.986
Treatments 31 4.68960 0.151277 549.860 0.000 (***)
Residual error 32 0.272919 0.00852871
Total 63 4.96252 0.0787701

Filename: ...\A324 Tetanus Ig Inhibition 4PL Weighted Sigmoid.epa. ID: EDQM/DBO/FRA
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(Bms51al; Version 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 2 of 2

‘Substance ‘Human Tetanus Immunoglobulins ‘
[Method | Toxoid binding Inhibition Assay (TIA) |

Sample 1 Sample 2
Id. Sample A Id. Sample B
(1U/ml) Lower limit | Estimate | Upper limit (IU/ml) Lower limit | Estimate | Upper limit
Potency 270.458 280.428 290.727 Potency 275.726 285.908 296.440
Rel. to Ass. ? ? ? Rel. to Ass. ? ? ?
Rel. to Est. 96.4% 100.0% 103.7% Rel. to Est. 96.4% 100.0% 103.7%
Sample 3
Id. Sample C
(1U/ml) Lower limit | Estimate | Upper limit
Potency 142.706 148.040 153.579
Rel. to Ass. ? ? ?
Rel. to Est. 96.4% 100.0% 103.7%
All samples Standard Sample 1 Sample 2 Sample 3
BRP Sample A Sample B Sample C

Executed by:

Calculated by:

Approved by:

Filename: ..\A324 Tetanus Ig Inhibition 4PL Weighted Sigmoid.epa. ID: EDQM/DBO/FRA
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Model: Quantal responses
Design: Randomised block
Transformation: y' = probit(
Theoretical variance: 1

Y)
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. . .
A.3.25 Inactivated rabies (veterinary), challenge assay
(8515t \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
Substance |Veterinary Rabies (Inactivated) ‘Remarks: ‘ * *
Method Challenge test in mice * *
Assay 1, 2 and 3 combined * * *
Standard Sample 1
Sample Ph. Eur BRP Batch 3 Sample Batch 9999999
Ass. pot. 91U/ vial Ass. pot. 101U / vial
Reconstitution |1 vial / ml Reconstitution |1 vial / ml
Basic dilution |1 ml/9 ml Basic dilution |1 ml/ 10 ml
Vol. injected 0.5 ml/ mouse Vol. injected 0.5 ml/ mouse
Doses (1) (2) (3) Doses (1) 2) 3)
n 5/9 1111 | 1112 17 710 | 12112 | 912
1/5 3/10 | 11/11 | 6/12 1/5 3/10 | 9112 | 6/10
1/25 2/9 | 6/12 | 4/12 1/25 0/9 312 | 5112
1125 110 112 | 012 1125 0/10 112 | 412

Common slope(factor) = 0.508908 (0.414037 to 0.603779)
Correlation | r |: 0.867768 (Weighted)

Executed by:

Calculated by:

Approved by:

Filename: ...\A325 Rabies Challenge Test Quantal Probit.epa. ID: EDQM/DBO/FRA

Source of variation Degrees of freedom Sum of squares Mean square Chi-square Probability
Preparations 1 0.0405644 0.0405644 0.0405644 0.840
Regression 1 77.8516 77.8516 77.8516 0.000 (***)
Non-parallelism 1 0.467216 0.467216 0.467216 0.494
Non-linearity 4 2.30644 0.576610 2.30644 0.680

Standard 2 0.762112 0.381056 0.762112 0.683

Sample 1 2 1.54294 0.771471 1.54294 0.462
Treatments 7 80.6658 11.5237 80.6658 0.000 (***)
Blocks 2 23.0321 11.5160 23.0321 0.000 (***)
Residual error 14 24.6866 1.76333 24.6866 0.038 (%)
Theoretical variance 1.00000
Total 23 111.185 4.83413

Sample 1

Sample Batch 9999999
(IUMvial) Lower limit | Estimate | Upper limit
Potency 4.02530 8.28373 16.9204
Rel. to Ass. 40.3% 82.8% 169.2%
Rel. to Est. 48.6% 100.0% 204.3%

All samples Standard Sample 1

Ph. Eur BRP Batch 3 Batch 9999999
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A.3.26 MMR vaccine / Rubella, ED50 by pooling of ratios

[omt%Tat; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 2 >* * *
* *
‘ Substance ‘ MMR vaccine ‘ ‘Remarks: See the other MMR examples for alternative ways of presenting the data. * *
‘Component ‘ Rubella ‘ * *
* 4k
Standard Sample 1
Preparation Ph. Eur. BRP Batch 1 Preparation Batch 123A456
Ass. pot. 3.6 10g10 1U / vial Ass. pot. ? log10 IU/vial
Reconstitution vol. |1 vial / 500 pl Reconstitution vol. |1 vial / 700 pl
Inoculation vol. 100 pl / well Inoculation vol. 100 pl / well
Doses (1) 2) 3) Doses (1) (2) 3)
-1.0log10 8/8 8/8 8/8 -1.0log10 8/8 8/8 8/8
-1.6 log10 8/8 8/8 8/8 -1.6 log10 8/8 8/8 8/8
-2.21og10 8/8 7/8 8/8 -2.21og10 8/8 8/8 8/8
-2.8log10 4/8 2/8 4/8 -2.8log10 8/8 8/8 8/8
-3.4log10 2/8 18 18 -3.4log10 2/8 2/8 3/8
-4.0 log10 0/8 0/8 0/8 -4.0 log10 1/8 0/8 2/8
-4.6 log10 0/8 0/8 0/8 -4.6 log10 0/8 0/8 0/8
-5.21og10 0/8 0/8 0/8 -5.21og10 0/8 0/8 0/8
-5.8 log10 0/8 0/8 0/8 -5.8 log10 0/8 0/8 0/8
-6.4 log10 0/8 0/8 0/8 -6.4 log10 0/8 0/8 0/8
Model: Determination ED50 Common slope(factor) = 1.03698 (0.838796 to 1.23516)
Design: Completely randomised Correlation | r |: 0.895400 (Weighted)
Transformation: y' = probit(y)
Theoretical variance: 1
Source of variation Degrees of freedom Sum of squares Mean square Chi-square Probability
Preparations 1 1.55722E-06 1.55722E-06 1.55722E-06 0.999
Regression 1 74.0737 74.0737 74.0737 0.000  (***)
Non-parallelism 1 0.390169 0.390169 0.390169 0.532
Non-linearity 16 9.85754 0.616096 9.85754 0.874
Standard 8 3.20992 0.401240 3.20992 0.921
Sample 1 8 6.64762 0.830953 6.64762 0.575
Treatments 19 84.3214 4.43797 84.3214 0.000  (***)
Residual error 40 8.06970 0.201743 8.06970 1.000
Theoretical variance 1.00000
Total 59 92.3911 1.56595
Standard Sample 1
Preparation Ph. Eur. BRP Batch 1 Preparation Batch 123A456
(log10 IU/vial) Lower limit Estimate Upper limit (log10 IU/vial) Lower limit | Estimate | Upper limit
Potency 3.60000 3.60000 3.60000 Potency 4.06365 4.28037 4.49710
Rel. to Ass. +0.00000 +0.00000 +0.00000 Rel. to Ass. ? ? ?
Rel. to Est. 0.00000 0.00000 +0.00000 Rel. to Est. -0.216715 | 0.00000 | +0.216730
log10 ED50/vial 3.38516 3.53841 3.69165 log10 ED50/vial 4.06553 4.21878 4.37202
Rel. to Ass. -0.214841 | -0.0615908 | +0.0916508 Rel. to Ass. ? ? ?
Rel. to Est. -0.153250 0.00000 +0.153242 Rel. to Est. -0.153243 | 0.00000 | +0.153249

Filename: ...\A326 ED50 MMR Vaccine Quantal Probit.epa. ID: EDQM/DBO/FRA
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[om857aT5 \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 2 of 2 * * *
* *
‘Substance ‘MMR vaccine ‘ * *
* *
‘Component ‘Rubella ‘ * N *

All samples Standard Sample 1
Ph. Eur. BRP Batch 1 Batch 123A456
Executed by: Calculated by: Approved by:

Filename: ...\A326 ED50 MMR Vaccine Quantal Probit.epa. ID: EDQM/DBO/FRA
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A.3.27 MMR vaccine / Measles, ED50 with fixed slope

(58515 \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
‘Substance ‘MMR vaccine ‘ Remarks: In cases where no slope can be calculated, it is possible to specify a fixed * *
[Component [measies | - 1 mS e i ced stope equl 1 1n(aiton facto). Ths should oy be done n .k
cases Where less than 2 non-extreme responses are observed as shown in this
example. The confidence limits are a good approximation to the Irwin/Cheeseman
limits.
Sample 1 Sample 2 Sample 3
Preparation Batch A Preparation Batch B Preparation Batch C
Ass. pot. 4.3 1og10 [U/vial Ass. pot. 4.0 10g10 IU/vial Ass. pot. 4.01og10 [U/vial
Reconstitution vol. |1 vial / 500 pl Reconstitution vol. |1 vial / 500 pl Reconstitution vol. |1 vial / 500 pl
Inoculation vol. 100 pl / well Inoculation vol. 100 pl / well Inoculation vol. 100 pl / well
Doses (1) Doses 1) Doses (1)
-1.6 log10 8/8 -1.6 log10 8/8 -1.6 log10 8/8
-2.21og10 8/8 -2.21og10 8/8 -2.2log10 8/8
-2.8log10 8/8 -2.8 log10 8/8 -2.8 log10 8/8
-3.4 log10 418 -3.4 log10 8/8 -3.4 log10 7/8
-4.0 log10 0/8 -4.0 log10 0/8 -4.0 log10 0/8
-4.6 log10 0/8 -4.6 log10 0/8 -4.6 log10 0/8
-5.21og10 0/8 -5.21og10 0/8 -5.2log10 0/8
Model: Determination ED50 Common slope(factor) = 0.723824 (fixed, p = 0.999)
Design: Completely randomised Correlation | r |: 1.00000 (Weighted)
Transformation: y' =y
Theoretical variance: 1
Sample 1 Sample 2
Preparation Batch A Preparation Batch B
(log10 IU/vial) Lower limit Estimate Upper limit (log10 IU/vial) Lower limit Estimate Upper limit
log10 ED50/vial 3.89108 4.09897 4.30686 log10 ED50/vial 4.39888 4.39897 4.39906
Rel. to Ass. -0.408916 -0.201030 +0.00685562 Rel. to Ass. +0.398884 +0.398970 +0.399056
Rel. to Est. -0.207886 0.00000 +0.207886 Rel. to Est. -8.62441E-05 0.00000 +8.62441E-05
Sample 3
Preparation Batch C
(log10 IU/vial) Lower limit | Estimate | Upper limit
log10 ED50/vial 4.18647 4.32397 4.46147
Rel. to Ass. +0.186467 | +0.323970 | +0.461473
Rel. to Est. -0.137503 | 0.00000 | +0.137503
All samples Sample 1 Sample 2 Sample 3
Batch A Batch B Batch C

Executed by: Calculated by: Approved by:

Filename: ...\A327 ED50 MMR Vaccine Spearman Kaerber.epa. ID: EDQM/DBO/FRA
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A.3.28 Swine erysipelas, limit test with quantal data
[6mE%1at; Version 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
*
‘Substance ‘Swine Erysipelas ‘ ‘Remarks: ‘ * *
* *
‘Method ‘Batch potency test ‘ * N *
Standard
Sample |Inhouse reference
Ass. pot. |1 inhouse unit/ dose
boses [ () [@[@[@w[E[@ 06 ][]0
150 [ 1 ]ofJo[1]o]lo]ol1]o]o
Sample 1
Ass. pot. |1 inhouse unit / dose
boses [ () [@[@]@w[E[@]n]e ][]0
w0 [1]olol1]ol1]lol1]1]0
Sample 1
Limit tested | 1.00000 inhouse unit / dose
Probability 0.325
All samples Standard Sample 1
Inhouse reference

Executed by: Calculated by:

Filename: ...\A328 Limit Test Quantal Resp.epa. ID: EDQM/DBO/FRA

Approved by:
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A.3.29 Hepatitis B vaccine, weighted exponential regression

[omE5Iat; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * X %
* *
‘Substance ‘Hepatitis B vaccine ‘ Remarks: This example shows an alternative way of analysing the data (see file * *
Hepatitis B.epa). Instead of making a log transformation of the data followed by an * *
Method A " ! - . ;
unweighted linear regression, this approach does not make a log transformation * * *
but uses a weighted exponential regression where the weights are inversely
proportional to the variance which is assumed to have a constant coefficient of
variation.
Standard Sample 1 Sample 2
Sample |S Sample |T Sample |U
Ass. pot. |20 pg protein / m| Ass. pot. |20 pg protein / ml Ass. pot. |20 pg protein / ml
Doses (1) (2) (3) Doses 1) (2) 3) Doses (1) 2) (3)
1/1000 | 0.514 | 0.531 | 0.545 1/1000 | 1.140 | 1.386 | 1.051 1/1000 | 0.957 | 0.866 | 1.045
1/2000 | 0.283 | 0.295 | 0.362 1/2000 | 0.501 | 0.665 | 0.576 1/2000 | 0.586 | 0.489 | 0.546
1/4000 | 0.159 | 0.154 | 0.166 1/4000 | 0.327 | 0.355 | 0.345 1/4000 | 0.277 | 0.268 | 0.269
1/8000 | 0.093 | 0.099 | 0.082 1/8000 | 0.167 | 0.157 | 0.178 1/8000 | 0.127 | 0.146 | 0.133
1/16000 | 0.043 | 0.045 | 0.051 1/16000 | 0.097 | 0.097 | 0.094 1/16000 | 0.086 | 0.071 | 0.073

Model: y=(exp(x)) where x=c.+b*In(dose)
Design: Completely randomised

Weight function: w=1/m*2

Correlation | r |: 0.995981 (Weighted)

Variance: Observed residuals

Common slope(factor): b = 0.905322 (0.882945 to 0.927700)

Source of variation Degrees of freedom Sum of squares Mean square Chi-square Probability
Preparations 2 3.98193 1.99097 497.540 0.000 (***)
Regression 1 35.4405 35.4405 4428.27 0.000 (***)
Non-parallelism 2 0.0153909 0.00769544 1.92308 0.382
Non-linearity 9 0.0632826 0.00703140 7.90711 0.544

Standard 3 0.0185983 0.00619944 2.32385 0.508

Sample 1 3 0.0266259 0.00887529 3.32689 0.344

Sample 2 3 0.0180584 0.00601946 2.25638 0.521
Treatments 14 39.5011 2.82151 4935.64 0.000 (***)
Residual error 30 0.240097 0.00800325
Total 44 39.7412 0.903209

Sample 1 Sample 2

Sample T Sample u

(Mg protein/ml) | Lower limit | Estimate | Upper limit (Mg protein/ml) | Lower limit | Estimate | Upper limit
Potency 40.4720 | 43.5676 | 46.9635 Potency 32.7673 | 35.2206 | 37.8948
Rel. to Ass. 202.4% 217.8% 234.8% Rel. to Ass. 163.8% 176.1% 189.5%
Rel. to Est. 92.9% 100.0% 107.8% Rel. to Est. 93.0% 100.0% 107.6%

All samples Standard Sample 1 Sample 2
S T V]

Executed by:

Calculated by: Approved by:

Filename: ...\A329 HepB Weighted Exponential Reg.epa. ID: EDQM/DBO/FRA
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A.3.30 Robust regression with Huber’s weights

[6mE%1at; Version 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
*
‘Project ‘Validation CombiStats version 7.0 ‘ Remarks: This is example 5.1.3 from the European Pharmacopoeia but *
‘Assay ‘Example 5.1.3 from the Ph. Eur. ‘ mftlzgn\ézlzef}tﬁglzﬁ:iderbz:r?l;zu:gzz.cgg \lljv?tlr?gutlzg\e/ir:gvivglgrélsug:i‘t.me * * *
Standard Sample 1
Id. S Id. T
Ass. pot. 670 IU/mg Ass. pot. 20000 IU/vial
Reconsitution |16.7 mg/25ml Reconsitution |1 vial/40 ml
Pre-dilution 1 ml/40 ml Pre-dilution 1 ml/40 ml
Doses S1|S2 | S3 | s4 Doses T1 | T2 | T3 | T4
1) 2521207 | 168 | 113 (1) 242 | 206 | 146 | 115
) 249 | 201 | 187 | 107 (2) 236 | 197 | 153 | 102
(3) 247 | 193 | 162 | 111 (3) 246 | 197 | 148 | 104
(4) 250 | 207 | 155 | 108 4) 231|191 | 159 | 106
(5) 235 | 207 | 140 | 98 (5) 232 | 186 | 146 | 188
Model: y=(x) where x=c.+b*In(dose) Common slope(factor): b =-110.701 (-115.637 to -105.766)
Design: Randomised block Correlation | r |: 0.989049 (Weighted)
Weight function: w=h
Variance: Observed residuals
Dilution step (Increasing): 1.5
Source of variation Degrees of freedom | Sum of squares Mean square Chi-square Probability
Preparations 1 104.793 104.793 1.49041 0.222
Regression 1 95708.7 95708.7 1361.21 0.000  (***)
Non-parallelism 1 85.9617 85.9617 1.22258 0.269
Non-linearity 4 82.2383 20.5596 1.16963 0.883
Standard 2 74.7300 37.3650 1.06284 0.588
Sample 1 2 7.50630 3.75315 0.106758 0.948
Treatments 7 95981.7 13711.7 1365.09 0.000  (***)
Blocks 4 545.737 136.434 7.76170 0.101
Residual error 28 1968.72 70.3116
Total 39 98100.6 2515.40
Sample 1
Id. T
(IUMvial) Lower limit | Estimate | Upper limit
Potency 18035.7 18924.8 19861.1
Rel. to Ass. 90.2% 94.6% 99.3%
Rel. to Est. 95.3% 100.0% 104.9%
All samples Standard Sample 1
S T
Executed by: Calculated by: Approved by:

Filename: ...\A330 Robust Regression Hubers Weights.epa. ID: EDQM/DBO/FRA
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A.3.31 Automatic invocation of the Spearman /Kérber method

[omt%Tat; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 2 * * *
* *
Study |Rabies serology Remarks: The model specifications in this example are for the probit model but the data do * *
not allow for estimation of the slope because there are not enough non-extreme responses. *
In that case CombiStats invokes the Spearman/Kaerber method and issues a warning that * * *
this method was used instead of the probit model.

Standard Sample 1 Sample 2 Sample 3
Designation |2nd IS (RAI) Serum Mouse 1 Serum Mouse 2 Serum Mouse 3
Ass. pot. 2 1U/ml Ass. pot. ? 1U/ml Ass. pot. ? 1U/ml Ass. pot. ? 1U/ml
Predilution | 1ml/5ml Predilution | 1ml/5ml Predilution | 1ml/5ml Predilution | 1ml/5ml
Inoculation  |0.050ml/well Inoculation  |0.050ml/well Inoculation  |0.050ml/well Inoculation  |0.050ml/well
Doses (1) Doses 1) Doses (1) Doses (1)

11 0/6 n 0/4 171 0/4 7 0/4
1/2 0/6 12 0/4 1/2 0/4 12 0/4
1/4 0/6 1/4 1/4 1/4 0/4 1/4 0/4
1/8 4/6 1/8 4/4 1/8 0/4 1/8 0/4
116 6/6 116 4/4 116 0/4 116 4/4
1/32 6/6 1/32 4/4 1/32 2/4 1/32 4/4
1/64 6/6 1/64 4/4 1/64 4/4 1/64 4/4
1/320 6/6 1/320 4/4 1/320 4/4 1/320 4/4

Sample 4 Sample 5 Sample 6
Serum Mouse 4 Serum Mouse 5 Serum Mouse 6
Ass. pot. 2 1U/ml Ass. pot. ? 1U/ml Ass. pot. 2 1U/ml
Predilution | 1ml/5ml Predilution | 1ml/5ml Predilution | 1ml/5ml
Inoculation  |0.050ml/well Inoculation  |0.050ml/well Inoculation  |0.050ml/well
Doses (1) Doses 1) Doses (1)

n 3/4 n 0/4 n 0/4
12 4/4 12 0/4 12 0/4
1/4 4/4 1/4 0/4 1/4 0/4
1/8 4/4 1/8 0/4 1/8 0/4
116 4/4 116 1/4 116 414
1132 4/4 1/32 4/4 1132 4/4
1/64 4/4 1/64 4/4 1/64 4/4
1/320 4/4 1/320 4/4 1/320 4/4

Model: Quantal responses
Design: Completely randomised
Transformation: y' = probit(y)
Theoretical variance: 1
Spearman-Kaerber method used

Sample 1 Sample 2
Serum Mouse 1 Serum Mouse 2
(IU/ml) Lower limit | Estimate | Upper limit (IU/ml) Lower limit | Estimate | Upper limit
Potency 0.900571 | 1.33484 1.97852 Potency 5.84948 | 8.97970 13.7850
Rel. to Ass. ? ? ? Rel. to Ass. ? ? ?
Rel. to Est. 67.5% 100.0% 148.2% Rel. to Est. 65.1% 100.0% 153.5%
Sample 3 Sample 4
Serum Mouse 3 Serum Mouse 4
(IU/ml) Lower limit | Estimate | Upper limit (IU/ml) Lower limit | Estimate | Upper limit
Potency 244438 | 3.17480 | 4.12348 Potency 0.159200 | 0.235969 | 0.349756
Rel. to Ass. ? ? ? Rel. to Ass. ? ? ?
Rel. to Est. 77.0% 100.0% 129.9% Rel. to Est. 67.5% 100.0% 148.2%

Filename: ...\A331 Rabies Spearman Kaerber Probit.epa. ID: EDQM/DBO/FRA
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[omE5Iat; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 2 of 2 * * *
* *
Rabies serology * *
* *
* oy Kk
Sample 5 Sample 6
Serum Mouse 5 Serum Mouse 6
(IU/ml) Lower limit | Estimate | Upper limit (IU/ml) Lower limit | Estimate | Upper limit
Potency 3.60229 5.33936 7.91407 Potency 2.44438 3.17480 4.12348
Rel. to Ass. ? ? ? Rel. to Ass. ? ? ?
Rel. to Est. 67.5% 100.0% 148.2% Rel. to Est. 77.0% 100.0% 129.9%
All samples Standard Sample 1 Sample 2 Sample 3 Sample 4
2nd IS (RAI) Mouse 1 Mouse 2 Mouse 3 Mouse 4
Sample 5 Sample 6
Mouse 5 Mouse 6
Executed by: Calculated by: Approved by:

Filename: ...\A331 Rabies Spearman Kaerber Probit.epa. ID: EDQM/DBO/FRA
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A.3.32 Five-parameter logistic curve regression

[omE5Iat; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1

‘Project ‘Validation CombiStats version 7.0 ‘

|Assay |Example 5.4.1 from the Ph. Eur. |

Remarks: This is example 5.4.1 from the European Pharmacopoeia but
using a 5-parameter logistic curve instead of 4-parameters.

Standard Sample 1
Ass. pot. |0.4 1U/ml Ass. pot. |? IU/ml
Doses (1) ) Doses (1) )

110 2912 | 2.917 110 3.017 | 2.987
1/20 | 2.579 | 2.654 1/20 | 2.801 | 2.808
1/40 2.130 | 2.212 1/40 2.401 | 2.450
1/80 | 1.651 | 1.638 1/80 | 1.918 | 1.963
1/160 | 1.073 | 0.973 1/160 | 1.364 | 1.299
1/320 | 0.585 | 0.666 1/320 | 0.861 | 0.854
1/640 | 0.463 | 0.356 1/640 | 0.497 | 0.496
1/1280 | 0.266 | 0.234 1/1280 | 0.340 | 0.344
1/2560 | 0.228 | 0.197 1/2560 | 0.242 | 0.217
1/5120 | 0.176 | 0.215 1/5120 | 0.178 | 0.125

Model: y=d+a*(Igt(x))*g where x=c.+b*In(dose)
Design: Completely randomised

Weight function: w=1.0

Variance: Observed residuals

Common slope(factor): b = 1.18041 (1.15672 to 1.20409)
Correlation | r |: 0.997888 (Weighted), 0.999518 (Unweighted)
Asymptotes: 3.25804 and 0.154367
Asymmetry factor: g = 0.806338

Executed by:

Calculated by:

Approved by:

Filename: ...\A332 PhEur Ex 541 Five Parameter Logistic Curve.epa. ID: EDQM/DBO/FRA

Source of variation Degrees of freedom Sum of squares Mean square Chi-square Probability
Preparations 1 0.00120101 0.00120101 0.840468 0.359
Regression 1 9.60311 9.60311 6720.28 0.000  (***)
Non-parallelism 1 0.000121809 0.000121809 0.0852423 0.770
Non-linearity 16 0.0120056 0.000750349 8.40154 0.936

Standard 8 0.00640260 0.000800325 4.48055 0.811

Sample 1 8 0.00560299 0.000700373 3.92098 0.864
Treatments 19 9.61644 0.506128 6729.60 0.000  (***)
Residual error 20 0.0285795 0.00142897
Total 39 9.64502 0.247308

Sample 1
(IU/ml) Lower limit | Estimate | Upper limit
Potency 0.556676 | 0.583385 | 0.611391
Rel. to Ass. ? ? ?
Rel. to Est. 95.4% 100.0% 104.8%
All samples Standard Sample 1
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A.3.33 Five-parameter logistic curve regression
[6mE%1at; Version 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
* *
Remarks: Data reconstructed from Gottschalk and Dunn "The five-parameter logistic: A characterization and * *
comparison with the four-parameter logistic". * *
* oy X

Standard
Id.
Ass. pot. |1 IU/mL
Doses 1)
1/125 246
1/250 282
1/500 387
1/750 458
1/1000 634
1/1500 915
1/2000 1197
1/3000 1866
1/4000 2430
1/8000 5282
1/16000 11092
1/32000 22958
1/64000 24049
1/128000 | 24120

Model: y=d+a*(1-Igt(x))*g where x=c.+b*In(dose)
Design: Completely randomised

Weight function: w=1.0

Theoretical variance: 1

Common slope(factor): b = 9.01489 (9.01343 to 9.01634)

Correlation | r |: 0.998091 (Weighted), 0.999833 (Unweighted)

Multiplication: a = 23987.1, Addition: d = 163.512
Asymmetry factor: g = 0.133047

Source of variation Degrees of freedom Sum of squares Mean square Chi-square Probability
Regression 1 1.04191E+08 1.04191E+08 1.04191E+08 0.000  (***)
Non-linearity 12 398980 33248.4 398980 0.000  (***)
Treatments 13 1.04590E+08 8.04537E+06 1.04590E+08 0.000  (***)
Theoretical variance 1.00000
Total 13 1.04590E+08 8.04537E+06

Standard

Executed by:

Calculated by:

Approved by:

Filename: ...\A333 Five Parameter Logistic Curve.epa. ID: EDQM/DBO/FRA
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A.3.34 Equivalence testing

[omE5Iat; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 2 * * *
* *
‘ Project ‘Validation CombiStats version 7.0 ‘ Remarks: This is example 5.1.1 from the European Pharmacopoeia with * *
additional table for equivalence testing. The extra table shows clearly * *
[Assay_[Example 5.1.1 from the Ph. Eur. | that the slope of Sample 2 is significantly different from the standard * 4 *

because 0 is not included in the difference interval and 1 is not included
in the ratio interval. Whether or not this non-parallelism is acceptable
depends on the goal-posts defined for this assay (currently unavailable).

Standard Sample 1 Sample 2

Id. S Id. T Id. U

Ass. pot. |1 unit/mg Ass. pot. |1 unit/mg Ass. pot. |1 unit/mg

Doses 0.25 unit | 1.0 unit Doses 0.25 unit | 1.0 unit Doses 0.25 unit | 1.0 unit
(1) 300 289 (1) 310 230 (1) 250 236
(2) 310 221 (2) 290 210 (2) 268 213
(3) 330 267 (3) 360 280 (3) 273 283
(4) 290 236 (4) 341 261 (4) 240 269
(5) 364 250 (5) 321 241 (5) 307 251
(6) 328 231 (6) 370 290 (6) 270 294
(7) 390 229 (7) 303 223 ) 317 223
(8) 360 269 (8) 334 254 (8) 312 250
9) 342 233 9) 295 216 9) 320 216
(10) 306 259 (10) 315 235 (10) 265 265

Model: Parallel lines

Design: Completely randomised
Transformation: y' =y

Variance: Observed residuals

Common slope(factor) = -47.0559 (-55.6804 to -38.4314)

Correlation | r |: 0.765367

Source of variation Degrees of freedom | Sum of squares | Mean square F-ratio Probability
Preparations 2 6256.63 3128.32 4.086 0.022 (%)
Regression 1 63830.8 63830.8 83.377 0.000  (***)
Non-parallelism 2 8218.23 4109.12 5.367 0.007  (*)
Treatments 5 78305.7 15661.1 20.457 0.000  (***)
Residual error 54 41340.9 765.572
Total 59 119647 2027.91

Slope per Sample Difference with Standard Ratio with Standard
Standard  |-60.3047 (-75.2427 to -45.3666) |0 1
Sample 1 |-57.6357 (-72.5738 to -42.6976)  |2.66899 (-18.4567 to 23.7946) 0.955742 (0.659070 to 1.37737)
Sample 2 |-23.2274 (-38.1655 to -8.28930) | 37.0773 (15.9516 to 58.2029) 0.385167 (0.135203 to 0.685490)
Sample 1 Sample 2
Id. T Id. U
(unit/mg) Lower limit | Estimate | Upper limit (unit/mg) Lower limit | Estimate | Upper limit
Potency 0.783648 1.14205 1.68690 Potency 1.14813 1.66889 2.55503
Rel. to Ass. 78.4% 114.2% 168.7% Rel. to Ass. 114.8% 166.9% 255.5%
Rel. to Est. 68.6% 100.0% 147.7% Rel. to Est. 68.8% 100.0% 153.1%

Filename: ...\A334 PhEur Ex 511 EquivalenceTesting.epa. ID: EDQM/DBO/FRA
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[om857aT5 \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 2 of 2 * * *
* *
‘Project ‘Validation CombiStats version 7.0 ‘ * *
* *
‘Assay ‘Example 5.1.1 from the Ph. Eur. ‘ * . *

All samples

V4

Standard
S

N

Sample 1
T

“

Sample 2
V]

AN

Executed by:
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A.3.35 Single dose assay with quantal responses

[omE5Iat; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1

* X %
* *
Remarks: Single dose assays based upon quantal responses can be entered as ratio, provided the model * *
specification on the options wizard is set to "Quantal Responses". * *
* p Kk
Standard Sample 1 Sample 2
Id. Reference Id. average potent batch Id. average sub-potent batch
Ass. pot. |8 IU/ml Ass. pot. |2.5 IU/ml Ass. pot. |2.5 IU/ml
Doses (1) Doses 1) Doses (1)
1/300 20/28 1/30 10/28 1/30 15/28
Sample 1 Sample 2
Id. average potent batch Id. average sub-potent batch
Limit tested 0.800000 IU / ml Limit tested 0.800000 IU / ml
Probability 0.008 (**) Probability 0.135
All samples Standard Sample 1 Sample 2
Reference average potent batch average sub-potent batch
Executed by: Calculated by: Approved by:

Filename: ...\A335 Single Dose Assay Quantal.epa. ID: EDQM/DBO/FRA
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Tutorial

Introduction

This tutorial is intended to offer a quick and easy way to become familiar
with the possibilities of CombiStats. It is assumed that you know how to
use Windows and also that you have some basic knowledge of the statistical
interpretation of biological assays. You should try to reproduce all exam-
ples, even though you may perhaps never perform this particular type of
assay. The type of assay is not essential for understanding the possibilities
of CombiStats. So, switch on your computer and take the time to work your
way through this tutorial. In doing so, you will very soon be able to use the
software as correctly and as efficiently as possible, even if the type of assay
you perform is not described here.

Lesson 1: Creating a template

1.1 Getting started

Let us assume that you want to perform a parallel line analysis on data that
you obtained from the micro-biological assay by diffusion of the antibiotic
Tylosin. The Ph. Eur. CRS 1 (Chemical Reference Substance, Batch 1) has
an assigned potency of 1035 IU/mg. You are interested in the potency of a
test sample in IU/vial. Let us also assume that you know that the sample
being tested contains approximately 25000 IU/vial. On the basis of this
information, you want to create stock solutions containing approximately
500 TU/ml. To achieve this, you weigh 24.2 mg of the CRS and dissolve this
in 50 ml solvent. The content of a complete vial of the test sample is also
dissolved in 50 ml solvent. From each of these stock solutions, three serial
dilutions are prepared using a dilution step of 1.5, and each of the resulting
six treatments is applied once in eight Petri dishes with agar.

Make sure that CombiStats is installed on your computer. By default,

149
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[mEm ¢? e

ombGlals

Figure B.1: The start screen of CombiStats

a shortcut ¥ should appear on your desktop. It has the twelve European
stars with two parallel lines crossing it. If the icon does not appear on
your desktop, try to start it from the Start menu or try to find the file
CombiStats.exe and create a shortcut. Your screen should now look like
shown in figure B.1. We are now ready to create our first calculation sheet.

1.2 Size of tables

Click on the button with a blank sheet [ in the toolbar or select File > New
from the menu. You are now presented with the Options Wizard. Since
the assay includes one standard and one test sample, we need 2 tables. As
additional information, we want to include the batch number of our test
sample and the name of the manufacturer. We therefore need 2 information
lines. The stock solutions were prepared from 1 pre-dilution, from which we
prepared 3 doses, and which we applied in 8 replicates (one per Petri dish).
So, we modify the Options Wizard as shown in figure B.2. Click on Next to
go to the next group of options, which is the orientation of the tables.

1.3 Orientation of tables

The orientation of the tables is purely a matter of page layout. In some cases,
it is better to present the tables with the doses on top (doses horizontal),
and, sometimes, it is better to present the doses on the left (doses vertical).
In most cases, it will be chosen so as to save paper. Since we can easily
change the orientation of the tables at a later stage, we will not worry about
it right now. Just click on Next to go to the next group of options, which is
the choice of models.
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P options wizard @ Pl Options wizard @
Doses | Transformation | Wariance | ANOVA | Doses | Tiansfomation | Variance | aNOVA |
Size | Oriertaton | Model | Desin | Siee Drentation | bodel | Desin |

Size of tables Origntation of tables
Murnber of tables: 2
Humber of information lines 2 Dases vertical .0
Mumber of pre-dilutions: 1
Doses horizontal ol
Humber of doses 7
Mumber of replicates; a
| Hext >3 | << Previous ‘ Bl 55
oK coeed | Hep | o« | Concel | oo |

(a) Modify the size of the tables (b) Do not change the orienta-
as shown here. tion for the moment. We will
do that later.

W Options wizard =3 Pl Options wizard ==
Doses | Transformation | Varance | ANDVA | Doses | Tiansformation | Variance | aMDva |
Sze | Orientation Model | Design | Sze | Orentaion | Model Design
Model Design
Parallel lines [In dose) IC
o
i fe - Completely randomised
Sigmoid curves (In doze) (o Randomized black. o
(o
Quantal responses (In dose] TR i~
ED ,ﬁ determination (In dose]

[ Show design

[ Use fived slope:

T

<« Previaus | P— ‘ p—

oK ‘ LCaneel ‘ Help | oK | LCancel | Help ‘

(c¢) The option ‘Parallel lines’ is (d) Each Petri dish contains all
already selected by default. treatments, so they can be iden-
tified as blocks.

Figure B.2: The options wizard
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1.4 Model

CombiStats can deal with 5 types of models. We want to analyse our data
with the parallel line model, which is already selected by default. Click
on Next to go to the next group of options, which is the choice of design.
The design of our assay is Randomised blocks because each block (the Petri
dishes) can be identified as a source of variation. Select this option and
move to the next group of options.

1.5 Design

The design of our assay is Randomised blocks because each block (the Petri
dishes) can be identified as a source of variation. Select this option and
move to the next group of options.

1.6 Notation of doses

The next group of options are the doses (see figure B.3). Here we have the
possibility to specify if the doses are given in symbolic notation (e.g. S1, S2,
S3 or Low, Middle, High) or in explicit notation (e.g. 4 TU, 6 TU, 9 TU or
1/22.5, 1/15, 1/10). Symbolic notation can only be used for equal dilution
steps, and, since this is the case in our assay, we decide to use symbolic
notation. Click on Symbolic notation (Increasing), specify the dilution step
of 1.5 and move to the next group of options.

1.7 Transformation

The next group is the group of transformations. Suppose that we have
measured the diameter of the inhibition zones and that this is assumed to
have a linear relationship with the log(dose). In that case, we need “No
transformation” (y’=y). But, if the area of the inhibition zones is assumed
to have a linear relationship instead of the diameter, we need to apply a
“Square” transformation (y’=y~2 or y’=y*y). The square transformation
does not exactly give the area of the zones but only differs by a constant
factor 7, which does not affect the results. However, if you prefer, you can
select “Other” and then specify y’=(y~2)*pi/4. For our assay, we will select
“No transformation”.

1.8 Variance

The next group is the group of variances. This allows us to specify which
residual error has to be used in the analysis of variance and for the calculation
of the 95 per cent confidence limits. For parallel lines and slope ratio assays,
you usually select “Observed residuals”. The other options will be discussed
later.
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"B Options wizard == Fll options wizard =
Sie | Orisntston | Modsl | Design | Szs | Orentaton | Modsl | Design |
Doses | Tramsfomation | Waiance | AnOvA | Doses Transformation | variance | aNOVA |

Dases Transformation

b

Mo transformation

Explicit natati ol
BB D Square root (o
Symbolic notation (Increasingl & Lagaiithm ol
(o
Symbolic notation [Desieasing) Lol
Other r

Dilution step: 15

<< Pravious | et 5> <4 Pravious ‘ Meast > !

Help | oK | el | Help

ax

Lancel

(a) We use a constant dilution (b) By default, ‘No transfor-
step of a factor 1.5 and we want mation’ is selected. Let’s not
to specify them in increasing or- change that for the moment.
der using symbolic notation.

W Options wizard =3 Pl Options wizard ==
Size | Orientation Model | Design | Sz | Orentaon | Model | Desin |
Doses | Tramsfomation  Vaiance | anova | Doses | Transformation | Variance  ANDVA

Variance Analysis of variance [ANOVA]

No ANDVA ol
@

Observed residuals Feduced ~
~

Deviations from mode! Normal i~
o

Deviations from linearity Eutended =
’ 3 ~

Theoretical variance B i~

Equivalence testing [~

< Previous ‘ ‘

T

<< Previous |

LCancel | Help

oK bep |

LCaneel

(c) In assays with quantitative (d) The extended ANOVA will
responses, the observed residu- allow us to check the quadratic
als are normally used to esti- curvature in addition to the
mate the residual variance. normal ANOVA.

Figure B.3: The options wizard
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L5 Version 7.0, Fiday, 16 October 2021, 120000 [+01:00. Page 1f 1 R
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Calculated by: Approved by:

Figure B.4: Your screen should now look like this

1.9 Analysis of variance

The last group of options ANOVA allows you to specify which sources of
variation you want to be included in the analysis of variance. By default,
“Normal” is selected, which allows you to check for linearity and parallelism.
The Extended ANOVA also includes the quadratic curvature and the lack
of quadratic fit. The “Complete ANOVA” includes several more sources of
variation and the “Reduced ANOVA?” is restricted to the deviations from the
model (with all sources combined except those which can be explained from
the model assumptions). We select the Extended ANOVA.

Finished! All options are defined and the data sheet can be created with
a click on the OK button.

1.10 The initial template

Your screen should now look like shown figure B.4. On top of the page, you
can see the version number, the date, the time, and the page numbering.
Then follows a table that contains five entries by default. These entries
are only suggestions and we will modify them later. Next to this table is a
remarks box, in which you can place any important remarks regarding your
assay. Below this are the tables for the standard and the test sample, and a
summary of the options we selected.

1.11 Further customising the template

The tables are not yet completely ready to be used as a template. Suppose
that we do not want to specify the assay number and the technician, but
instead we want to specify the study number. We can do this as follows (see
figure B.5): Select with the mouse the cells from Assay number to Date of
assay and press DELETE on the keyboard. The last two rows disappear and
one empty row stays selected. Type “Study number” followed by ENTER.
One line is added. You can also use the arrow keys to move down and add
new rows. Type “Date of assay” followed by ENTER.
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Substance Substance Substance
Method Method Method
EAszay number § Study rurnber

T

Figure B.5: You can customize the standard entries of your template if
desired

BT Version 7.0, Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 a X
*
Substance |Remarks | i; -
ethod
Aszay number * ok *
Technician
Diate of sssay
Standard Sample 1

Id. Id.
Origin Manufacturer
Eatch rumber Batch rumber
Azg. pot, Ags. pol.
Pre-di. 1 Pre-di. 1
Doges (U121 (31 (4] (51 (6]) (1] (81 Doses 01 (2] (@] (4] 151] (61| (71] (8]

51 T

52 T2

53 T3

Model Parallel lines

Design: Randomised block
Transformation; y'=p
Wariance: Observed residuals
Diilution step [Increasing): 1.5

Executed by: Calculated by: Approved by:

Figure B.6: The template is now ready to be added to the library

The two tables for the standard and the sample also need to be further
customised. Since we included two additional information lines for the man-
ufacturer and the batch number, we complete the tables accordingly. The
doses can be given in symbolic notation, since that is what we specified in
the options wizard. Symbolic notation always starts with a letter (A to Z or
a to z, but no accents or special characters). It does not matter what you
fill in exactly, because CombiStats calculates the doses on the basis of the
dilution step that you have specified. You can even leave the cells empty,
but this is not recommended because it makes the tables more difficult to
understand for a human reader. If you enter something that can be inter-
preted as an explicit notation (for example 100 IU), this overrules the dose
that would be calculated by CombiStats. Complete the tables as shown in
figure B.6. The template is now ready for use.

1.12 Adding the template to the library

We can save this template to a file so that we can use it each time we need
it. In this way, we do not have to specify all the options each time we want
to analyse new data, but simply open the template and immediately start
entering the observed data.

Click on & or select File>Save from the menu and go to the directory
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Pl sovefile as ... (=3
@'\j“?‘ | Libraries\Documents\Templates - | - | | Search Documents P
File name:  Tylosin Diffusien -
Save as type: |Temp|ate (*.epm) 'l
= Browse Folders | Concel |

Figure B.7: Be sure to save the file with the extension EPM

B Library of templates =

Seachfor |

Tylosin Diffusion

Bemnva| Add | ? Qance\‘ oK

Figure B.8: The library contains the template we just created

where you want to save this template. Choose an appropriate name, for
example “Antibiotics Diffusion” or “Tylosin Diffusion” and save the form as
an *.epm file. It is important that you do not save it as an *.epa file, because
CombiStats will then not recognize the form as a template (see figure B.7).
Click on Save and CombiStats will ask you if you want to add this template
to the library. Click on Yes and we are finished. Close the form by selecting
File > Close from the menu or click on the cross in the upper right corner (be
careful not to close the application, but only the form). This ends the first
lesson. In the next lesson, you will use this template to enter some data and
get familiar with the output.

Lesson 2: Completing a data sheet

2.1 Entering data into a template

We will now use the template that we created in Lesson 1 to enter some
assay data. Click on the button showing a template & or select File > Library
of templates from the menu. The library of templates as shown in figure B.8
appears.

It contains the template that we just created. Select it and click on OK.
You can also open the form by double clicking on it. We can now start
entering the data. Complete the data sheet as shown in figure B.9. Tip:
Use the Insert key on your keyboard if you want to modify the contents of
a cell. Use the ‘Undo’ button ® if you have accidentally deleted something
and want to revert back.

When you have finished entering the data, save the sheet by clicking
on the save button & or by selecting File>Save from the menu. Go to the
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EmSIEE Version 7.0, Friday. 15 October 2021, 12:00:00 [+07:00]. Page 1 of 1 + *

*
Substance | Tylosin [Fremarks ] : *
ethod Diffusion
Study number | T112-a * o *
Date of agsay | 21/03/2020
Standard Sample 1
Origin Ph. Eur. CRS M anufacturer | Fantasy Pharm Ltd.
Eatch number | Batch 1 Batch number | 34656
Ass. pot. 1035 1U/mg Ass. pot. 25000 I Avial
Pre-di. 1 24.2 mg/50 mL Pre-di. 1 1 wvial/50 mL
Doses M2 13466 F] 8 Doses M2 ] 13 45|06 F] 8
51 162| 164|178 162 [ 168|168 170) 168 T1 168|174 162|176 [172| 168 164) 174
52 184 [ 194|192 186|196 | 186) 190[ 185 T2 194 (192|190 194 186 192] 186 [ 194
53 208| 208] 208) 214 [ 206 | 206) 202) 208 T3 204| 210] 206) 204 [ 212 | 208) 210) 208

Modek Paralle lines

Design: Randomized block
Transformatian: y' =y
Variance: Dbserved residuals
Dilution step [Increasing): 1.5

Executed by: Calculated by Lpproved by:

Figure B.9: Enter data into the tables as shown here

directory where you want to save the file, choose an appropriate name, for
example “Tylosine Assay 1”7 and save the file with the extension *.epa.

2.2 Calculate and print

Click on the pocket calculator B or select Toolst Calculate from the menu.
CombiStats will now perform the necessary calculations. Click on the print
button or select File> Print from the menu. If your printer is correctly in-
stalled, a printout should be made that looks like shown in figure B.10.
The large table in the middle of the page is the analysis of variance. We
can see that there are no significant deviations from linearity or parallelism
(Probability>0.05) and that there is a highly significant regression (Proba-
bility<0.001). The small table shows the potency estimate with the 95 per
cent confidence limits expressed in IU/vial, relative to the assumed potency
(in percentage), and relative to the estimated potency (also in percentage).
At the bottom of the page are shown 3 small graphics, the first being a
superposition of standard and test sample, and the others being separate
representations of each preparation. These graphics show the observed re-
sponses (the little dots) and the fitted parallel lines.

The information you have given in the first information line of the sample
tables is repeated in the table of the potency estimate and in the graphics.
It is therefore a good idea to put information in that first line that uniquely
identifies? the preparation in the context of the assay. For example, if we
had different batches from the same manufacturer, it would have been bet-
ter to use the batch number as identification instead of the name of the
manufacturer.
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(657575 \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1 * * *
*
Substance Tylosin Remarks: ‘ *
Method Diffusion *
Study number |T112-a * * *
Date of assay |21/03/2020
Standard Sample 1
Origin Ph. Eur. CRS Manufacturer | Fantasy Pharm Ltd.
Batch number |Batch 1 Batch number | 34G56
Ass. pot. 1035 IU/mg Ass. pot. 25000 IU/vial
Pre-dil. 1 24.2 mg/50 mL Pre-dil. 1 1 vial/50 mL
Doses M@ 1R @ ]|®6) |6 |7]@®) Doses (UENORNORRORNONRORNUENC)
S1 162 | 164 | 178 | 162 | 168 | 168 | 170 | 168 ™ 168 | 174 | 162 | 175 | 172 | 168 | 164 | 174
S2 184 | 194 | 192 | 186 | 196 | 186 | 190 | 185 T2 194 | 192 | 190 | 194 | 186 | 192 | 188 | 194
S3 208 | 208 | 208 | 214 | 206 | 206 | 202 | 206 T3 204 | 210 | 206 | 204 | 212 | 208 | 210 | 206

Model: Parallel lines

Design: Randomised block
Transformation: y' =y
Variance: Observed residuals
Dilution step (Increasing): 1.5

Common slope(factor) = 47.8617 (44.7195 to 51.0039)
Correlation | r |: 0.972424

Source of variation

Degrees of freedom | Sum of squares Mean square F-ratio Probability

Preparations 1 27.0000 27.0000 1.484 0.231
Regression 1 12051.3 12051.3 662.332 0.000 (***)
Non-parallelism 1 7.03125 7.03125 0.386 0.538
Non-linearity 2 54.8542 27.4271 1.507 0.236

Standard 1 16.3333 16.3333 0.898 0.350

Sample 1 1 38.5208 38.5208 2117 0.155
Treatments 5 12140.2 2428.03 133.443 0.000 (***)
Blocks 7 68.9167 9.84524 0.541 0.797
Residual error 35 636.833 18.1952
Total 47 12845.9 273.317

Sample 1

Manufacturer Fantasy Pharm Ltd.
(IUlvial) Lower limit | Estimate | Upper limit
Potency 24528.6 25844.4 272415
Rel. to Ass. 98.1% 103.4% 109.0%
Rel. to Est. 94.9% 100.0% 105.4%

All samples Standard Sample 1

Ph. Eur. CRS Fantasy Pharm Ltd.
Executed by: Calculated by: Approved by:

Filename: ..\Tylosin.epa. ID: EDQM/DBO/FRA

Figure B.10: A printed data sheet with the calculated results

* 6 %
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2.3 Detailed graphics

The graphics on the calculation sheet are intended to spot irregularities in
the assay, such as outliers, typing errors in the data entry, or a specific
curvature of the responses. In some cases, you might want to have a more
detailed graphic. Click on the graph button £ and you will get a full size
graphic that looks like shown in figure B.11.

Click on the portrait button /I to change the graph to a portrait layout.
Click on the coloured 1 or black-white button ¥ to choose between a colour
representation or a black and white representation. Click on ¥ to obtain
a graph that connects the mean of the observed responses per doses. The
doses are shown on a logarithmic scale with labels at the dose levels of the
standard as indicated in the calculation sheet (S1, S2 ans S3). In some
cases, you might prefer to see the doses expressed in units rather than (or
in addition to) the dose labels. You can do this by clicking on the menu
Options> Show Doses. You will now get the units of the standard, calculated
on the basis of the information provided in the calculation sheet. You will
see that the doses are 222.64 1U, 333.96 IU and 500.94 IU respectively.
CombiStats has calculated this as 1035 - Z-2 . (working dilution), where the
working dilution is assumed to be 1/1 for the highest dose. In this case, the
highest dose is S3 because we have specified that the doses would increase
with steps of 1.5.

It is your own responsibility to provide enough details for CombiStats to
be able to calculate the dose in units correctly. If you have only provided
relative doses (e.g by omitting pre-dilution steps), the scale in units will not
necessartly match the actual doses administered to the experimental units,
although the calculated potency might still be correct (e.g. if the omitted pre-
dilution steps were the same for the standard and all test preparations).

Lesson 3: What else is possible...

3.1 Introduction

Now that we have created an example, we can use it to explore some of the
other features of CombiStats. This lesson is not intended to show a typical
way of exploring data or performing the analysis. They are merely intended
to show some additional functionalities of the software. Close the example
that we just created. Select the menu File and you will find the name of the
example at the bottom of the menu as shown in figure B.12. This enables
you to quickly open the most recently used files. CombiStats keeps record
of the 9 last files. Alternatively you can click on the appropriate button and
search for the file yourself.
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[6mb51T; \ersion 7.0. Friday, 15 October 2021, 12:00:00 [+01:00]. Page 1 of 1

* X x
* *
Substance Tylosin Remarks: ‘ * *
Method Diffusion * « *
Study number |T112-a *x *
Date of assay |21/03/2020
220
[e]
x
Ph. Eur. CRS O

Fantasy Pharm Ltd. X

Response (y)

R
1 s2 s3
160 I . . } . . f f f
222.641U 333.961U 500.941U
Dose (In 1U)

Filename: ...\Tylosin.epa. ID: EDQM/DBO/FRA

Figure B.11: A printed sheet of the detailed graph
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Pl Combistats

Edit Tools Options Window ?

- [(mEm % ? @
Library of templates... Ctri+L  F =
Open Ctrl+0

Close

Save Ctrl+5

Save As...

Print Ctrl+P

Print All

Hash RIPEMD-160 Ctrl+H

1. C\CombiStats Files\Tylosine Assay 1.epa

Quit Ctrl+Q

Figure B.12: Recent files can be accessed more rapidly from the File menu

Standard Sample 1

Origin Ph. Eur. CRS tanufacturer | Fantasy Pharm Lid.

Batch nurber | Batch 1 Batch number | 34656

Agz. pot. 103510 / mg Az poat, 2800010 / wvial

Pre-dil. 1 24.2mag /50 ml Pre-dil. 1 1 wial /50 ml

Dozes 51 52 53 Dozes T T2 T3
1] 162 | 184 | 208 [1] 168 | 194 | 204
2] 164 | 194 | 208 [2] 174 | 192 | 210
[3) 178 | 192 | 208 [3] 162 | 190 | 206
4] 162 | 186 | 214 [4] 175 | 194 | 204
(5] 168 | 196 | 206 [5] 172 | 186 | #12
151] 168 | 186 | 206 [E] 168 | 192 | 208
(7 170 | 190 | 202 [7] 164 | 188 | 210
(8 168 | 185 | 206 [B] 174 | 194 | 206

Figure B.13: The orientation of the doses is now horizontal

3.2 Changing the orientation

Click on the wizard button & or select Tools > Options Wizard from the menu.
Go to Orientation and select Doses horizontal. Click on OK and the presen-

tation of the tables will be modified in the way you would expect (see figure
B.13).

3.3 Inspecting the mean response

Select Options > Mean response from the menu. This allows you to do a quick
on-screen inspection of the mean response per dose (see figure B.14). The
means disappear automatically when you perform your next action or when
you select the same menu option again. The number of decimals shown is
equal to the number of decimals used for the first response in the table.
So, if you want CombiStats to show more decimals, it suffices to add some
non-significant zeros to the first observation as shown in figure B.15.
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Standard Sample 1
Crigit Fh. Eur. CRS b anufacturer | Fantasy Pharm Lid,
Batch rumber | Batch 1 Batch number | 34G56
Agz. pat, 103510 / mo Agz. pat, 2800010 4 wvial
Pre-dil. 1 242 ma /50 ml Pre-dil. 1 1 wial /B0 ml
Doges 51 52 53 Doges T1 T2 T3
(1] 162 | 184 | 208 (1] 163 | 154 [ 204
[2] 164 | 154 | 208 [2] 174 | 1582 [ 210
(3] 178 | 192 | 208 (3] 162 | 190 [ 206
(4] 162 | 186 [ 214 (4] 175 | 154 | 204
(5] 168 | 196 | 208 (5] 172 | 186 | 212
(E] 163 | 186 [ 206 (E] 163 | 192 [ 208
[¥] 170 | 180 | 202 [¥] 164 | 188 [ 210
(8] 168 | 185 | 208 (8] 174 | 154 | 208
163 | 189 [ 207 170 ) 191 | 208

Figure B.14: An extra row with the average responses is added at the bottom

Standard Sample 1

Crigir FPh. Eur. CRS M anufacturer | Fantasy Pharm Ltd.

Batch number | Batch 1 Batch number | 34G56

Agz. pat, 103510 / mg Agz. pat, 28000 10 4 wial

Pre-dil. 1 24.2 mag /50 ml Pre-dil. 1 1 wial /50 ml

Dozes 51 52 53 Dozes T1 T2 T3
(1] 1620( 184 | 208 (1] 168.0( 194 | 204
[2] 164 | 194 | 208 [2] 174 | 192 | 210
(3] 178 | 192 | 208 (3] 162 | 190 | 208
(4] 162 | 186 | 214 (4] 175 | 194 | 204
(5] 168 | 196 | 206 (5] 172 | 186 | 212
[E] 168 | 186 | 206 [E] 168 | 192 | 208
(7] 170 | 190 | 202 (7] 164 | 188 | 410
(8] 168 | 185 | 206 (8] 174 | 194 | 206

167.5] 1891 2073 1696|191.3] 207 5

Figure B.15: Add extra zero’s to the first observation to obtain more deci-
mals for the average response
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3.4 Excluding observations

Double click on S1 in the table of the standard. All observations of the first
dose are barred out (see figure B.16).

3.5 Selecting the table for the standard

Double click on the word Sample 1 in the top row of the table. It changes
into “Standard” and the other table is automatically renumbered to contain
the word “Sample 17 (see figure B.17).

This enables you to put the standard in a different table than the first,
which is the table by default to contain the Standard. This can also be
useful if you have included two different standards (e.g. an in-house standard
and an international standard) and want to compare the outcome for both.
When you double click on the header of the Standard itself, none of the tables
is assigned to the standard anymore. This may occasionally happen in assays
that do not strictly require a standard, such as ED50 determinations. Click
on the first table to make it the standard again.

Although you can still see them, they will no longer be taken into ac-
count in the calculations. Double click again on S1 and the values are again
included. Double click on (2) to exclude the second block. Double click on
Doses to exclude all observations. Do this again to include all observations.

3.6 Notation of the doses

We have arrived at a very important part of this lesson: The notation of the
doses. Basically, there are 4 types of notation and it is very important that
you understand how CombiStats interprets each of the notations in order to
make the correct choice when creating a data sheet. The 4 types of notation
are listed below followed by a few examples:

e Symbolic notation: S1, High, Blahblah, etc.

e Content units: 30 TU, 1000 AU, 1.25 units, etc.
e Volume units: 0.5 ml, 500 pl, 0.5 vial, etc.

e Dilutions: 1/10, 5/100, -2logl0, etc.

The manual gives more detailed information about the syntax of each of
these notations.

In our example, we have used symbolic notation (S1, S2, S3 and T1,
T2, T3). CombiStats interprets anything that starts with a character of
the alphabet (A to Z or a to z) as symbolic notation. Tt is just a label
you attribute to the dose and it has no special meaning to CombiStats.
Only its position in the table is of importance. The first or last dose in a
table (depending on whether the doses increase or decrease) is interpreted
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Standard Sample 1

Origin Fh. Eur. CRS b anufacturer | Fantasy Pharm Lid,

Batch number | Batch 1 Batch number | 34G56

Azs, pat, 103510 / mg Azs, pat, 2800010 4 wial

Pre-dil. 1 24 2mg /50 ml Pre-dil. 1 1 wial /B0 ml

Dozes 51 52 53 Dozes T1 T2 T3
(1] 162 | 184 | 208 (1] 168 | 194 | 204
(2] 184 | 194 | 208 (2] 1741 182 | 210
(3] 1Ea | 192 | 208 (3] 162 | 190 | 208
(4] 62 | 186 | 214 (4] 175 | 194 | 204
(5] 1e3 | 196 | 208 (5] 172 | 186 | 212
[E] 163 | 186 | 206 [E] 168 | 192 | 208
(7] A0 | 190 | 202 (7] 164 | 188 | 210
(3] 1e3 | 185 | 208 (3] 174 | 194 | 208

Figure B.16: Double click on S1 to exclude observations
Sample 1 Standard

Origin Fh. Eur. CRS b anufacturer | Fantasy #harm Lid,

Batch number | Batch 1 Batch number | 34G56

Azs, pat, 103510 / mg Azs, pat, 2800010 4 wial

Pre-dil. 1 24 2mg /50 ml Pre-dil. 1 1 wial /B0 ml

Dozes 51 52 53 Dozes T1 T2 T3
(1] 162 | 184 | 208 (1] 168 | 194 | 204
(2] 164 | 194 | 208 (2] 1741 182 | 210
(3] 178 | 192 | 208 (3] 162 | 190 | 208
(4] 162 | 186 | 214 (4] 175 | 194 | 204
(5] 168 | 196 | 208 (5] 172 | 186 | 212
[E] 168 | 186 | 206 [E] 168 | 192 | 208
(7] 170 | 190 | 202 (7] 164 | 188 | 210
(3] 168 | 185 | 208 (3] 174 | 194 | 208

Figure B.17: Double click on the header of a table to define it as the standard
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as “undiluted” or “1/1” with respect to the working solution. So, S3 in
our example is interpreted as 500.95 IU since the working solution for the
standard is @ X % = 500.94 TU/ml, and S3 is positioned in the last
column of the table. We had already seen this when we were viewing the
axis of the detailed graph. With this in mind, it is not difficult to see
that T3 is interpreted as 500 IU and T1 as 222.222 IU, which are of course
only temporarily assigned values, based on the assumed potency of the test
preparation. The horizontal distance between the parallel lines will be a
measure of how much this temporarily assigned value has to be adjusted.

Modify the doses as shown in figure B.18 so as to represent volumes.
Note that the last pre-dilution in the example is specified in ml, so only
doses in ml can be interpreted as volume units. The dose with 0.6 ml of the
standard is interpreted by CombiStats as % X 231—(')2 x 0.6 = 300.564 IU. The
doses are now interpreted as if you applied the specified volumes of the stock
solution to the experimental units, thus taking into account the pre-dilution
steps. Check this in the detailed graph if you want to convince yourself about
this. Perform the calculations and compare the outcome with the printout
we made earlier. There should be no difference. Although the doses are not
the same in the calculations, they still lead to the same outcome because
they have changed by the same proportion for both preparations.

Now modify the doses to represent ratios as shown in figure B.19. Ratios
are dimensionless and are interpreted relative to the stock solutions. So, a
dose of 1/45 of the standard is interpreted as @ X % X % = 11.132
1U. Perform the calculations and compare the results with the previous
results. Again there should be no difference because proportionally nothing
has changed, although the doses are not at all the same in the calculations
as you can see by viewing the doses in the detailed graph. Dilutions can
also be given as logarithm, e.g. a series of 1/1, 1/10, 1/100 is equivalent
with 0logl0, -1log10,-2log10 or with Olog, -1log, -2log. A series of 1/4, 1/8,
1/16 is equivalent with -2log2, -3log2, -4log2. Refer to the manual for more
details.

Modify the doses once again as shown in figure B.20. They are now writ-
ten as content units because U is the unit used for the Standard. This time,
you will notice a difference in the calculation of the potency estimate. Why?
In the previous examples, CombiStats had to calculate the contents in IU
on the basis of the assumed potency, the pre-dilution steps and the notation
used for the doses. The doses for the sample under test were not exactly
equipotent to the doses of the standard. In this case, however, CombiStats
will use the doses “as is” (in IU) and we pretend that the contents are the
same for both preparations. The software will assume that we prepared the
doses in such a manner that the units are correct on the basis of the as-
signed or assumed potencies, ignoring any pre-dilution step that we might
have specified. So, be careful when you specify doses in content units be-
cause you have to calculate them accurately on the basis of the assigned
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Standard Sample 1

Origin Ph. Eur. CRS Manufacturer | Fantazy Pharm Lid.

Batch number |Batch 1 Batch number | 34656

Agz. potb, 103510 ¢ mg Agz. pot. 28000 1U ¢ wial

Pre-dil. 1 24.2mg /50 ml Pre-dil. 1 1 wial / 50 ml

Dozes 04ml|0Eml| 0.9ml Dozes Odml|0Eml| 0.9ml
1] 162 | 184 | 203 1] 168 | 194 | 204
[2] 164 | 194 | 208 [2] 174 | 192 | 210
[3] 178 | 192 | 208 [3] 162 | 190 | 206
[4] 162 | 186 | 214 4] 175 | 194 | 204
5] 168 | 196 | 20B 5] 172 | 186 | 212
[E] 168 | 186 | 206 [E] 168 | 192 | 208
[7] 170 | 190 | 202 [7] 164 | 188 | 210
(8] 168 | 185 | 20B 5] 174 | 194 | 208

Figure B.18: The notation of the doses is now in volume units

Standard Sample 1

Origin Ph. Eur. CRS b anufacturer | Fantasy Pharm Lid.

Batch number |Batch 1 Batch number | 34656

Ags. pot. 103510 # mg Ags. pot. 280001 4 wvial

Pre-dil. 1 24.2 mg ¢ 50 ml Pre-dil. 1 1 wial / 50 ml

Dozes 1/45 | 1/30 | 1/20 Doszes 1445 1/30| 1/20
(1] 162 | 184 | 208 1] 168 | 194 | 204
[2] 164 | 194 | 208 [2] 174 [ 192 | 210
[3] 178 | 192 | 208 [3] 162 | 190 | 206
(4] 162 | 186 | 214 4] 175 | 194 | 204
[5] 168 | 196 | 206 (5] 172 | 186 | 212
[E] 168 | 186 | 206 [E] 168 | 192 | 208
[7] 170 | 190 | 202 [7] 164 | 188 | 210
(2] 168 | 185 | 206 [2] 174 | 194 | 206

Figure B.19: The notation of the doses is now in dilution ratios

Standard Sample 1

Origin Ph. Eur. CRS Manufacturer | Fantasy Pharm Lid.

Batch number | Batch 1 Batch number | 34656

Azs potb. 103510 4 mg Azs potb. 280001 4 wvial

Pre-dil. 1 24.2 mg /50 ml Pre-dil. 1 1 wial / 50 ml

Dozes 4000 60N | 901U Dozes 4000 60N | 901U
1] 162 | 184 | 208 1] 168 [ 194 | 204
[2] 164 | 194 | 208 [2] 174 [ 192 [ 210
[3] 178 | 192 | 208 [3] 162 | 190 [ 208
4] 162 | 186 [ 214 4] 175 | 194 | 204
5] 168 [ 196 | 206 5] 172 | 186 | 212
[E] 162 | 186 | 206 [E] 168 [ 192 | 208
[7] 170 [ 190 | 202 [7] 164 | 183 [ 210
5] 168 [ 185 [ 206 5] 174 | 194 | 206

Figure B.20: The notation of the doses is now in content units
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and assumed potency. In practice, you will probably only specify doses as
contents if the standard and test preparations are of equal composition and
are in all respects treated identically.

3.7 Unknown assumed potency

But what if you don’t know the assumed potency? Well, in that case you
normally carry out a preliminary assay to get a rough idea of the potency.
Or you might take a nominal potency or specified potency from relevant
documentation. After all, how can you reasonably prepare dilutions if you
have no idea about the potency? However, there is a way to perform the
calculations without specifying an assumed potency. Although not recom-
mended, you can use a question mark followed by the units in which you
want the software to calculate the potency. Try it as shown in figure B.21.

Perform the calculations and look what happens. You get an error mes-
sage. Of course: How would you know that this dilution contains 40 IU if
you do not know the assumed potency? That would make no sense. But
it would make sense to use the volume or dilutions of the stock solution
applied. Modify the doses so as to express dilution ratios as shown in figure
B.22. and try again to calculate. It works! The only difference with the
other examples is that the estimated potency can no longer be expressed as
a relative percentage of the assumed potency. If you give question marks,
you get question marks in return. It is therefore recommended to specify
the assumed potency whenever possible.

Here are some explanations to make you understand how CombiStats
deals internally with unknown potencies. CombiStats calculates an implic-
itly assumed potency on the basis of the pre-dilutions you specify, on the
assumption that the stock solutions of the standard and test preparations
are prepared to be equipotent. So, in our example the implicitly assumed
potency is % X 254—(')2 X ? x 1 = 25047 IU/vial. Indeed, you can see in the
detailed graph that the doses of the standard and test do now exactly co-
incide whereas they were slightly shifted in the earlier examples. Also note
that if you had used an assumed potency of 25047 IU/vial in the example
where we used contents for the doses, we would have found exactly the same
potency estimate.

3.8 Which residual variance?

Restore all the options to their original settings or simply close the sheet and
open the file that we saved earlier (provided that you have not overwritten
it with the modifications). Exclude blocks 2 to 8 as shown in figure B.23.
The quickest way to achieve this is to double click first on “Doses” and then
on (1). Let CombiStats perform the calculations and look what happens.
You get the following error message in red: “The residual error cannot be
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Figure B.21: This will not work! You cannot use

APPENDIX B. TUTORIAL
Standard Sample 1

Origin Ph. Eur. CRS Manufacturer | Fantazy Pharm Lid.

Batch number | Batch 1 Batch number | 34656

HAzs pot. 103510 / mg HAzs pot. T/ vial

Pre-dil. 1 24.2 ma /50 ml Pre-dil. 1 1 wial / 50 ml

Diozes 400U [ BONJ | 9010 Diozes 400U [ BONJ | 9010
11 162 | 184 | 208 11 168 | 194 | 204
[2] 164 | 194 | 208 [2] 174 | 192 | 210
[3] 178 | 192 | 208 [3] 162 | 190 | 208
(4] 162 | 186 | 214 (4] 175 | 194 | 204
(5] 168 | 196 | 206 (5] 172 | 186 | 212
[E] 168 | 186 | 206 [E] 168 | 192 | 208
[71 170 | 190 | 202 [71 164 | 183 | 210
(3] 168 | 185 | 206 (3] 174 | 194 | 206

don’t specify an assumed potency

content notation if you

Standard Sample 1

Origin Ph. Eur. CRS Manufacturer | Fantazy Pharm Lid.

Batch number |Batch 1 Batch number | 34656

Agz. pot. 103510 4 mg Agz. pot. T A vial

Pre-dil. 1 24.2mg /50 ml Pre-dil. 1 1 wial / 50 ml

Doses 1/45 | 1/30 | 1/20 Dozes 1/45] 1/30| 1/20
1] 162 | 184 | 208 1] 162 [ 194 | 204
[2] 164 | 194 | 208 [2] 174 | 192 | 210
[3] 178 | 192 | 208 [3] 162 | 190 | 206
[4] 162 | 186 | 214 4] 175 | 194 | 204
5] 168 | 196 | 206 5] 172 | 186 | 212
[E] 168 | 186 | 206 [E] 168 | 192 | 208
[7] 170 [ 190 | 202 [7] 164 [ 188 | 210
(8] 168 | 185 | 206 5] 174 | 194 | 206

Figure B.22: This will work! We do not need to know an assumed potency
to know which dilution ratios we have used

Standard Sample 1

Origin Ph. Eur. CRS Manufacturer | Fantazy Pharm Ltd.

Batch number | Batch 1 Batch number | 34G56

Azs. pot. 103510 / mg Azz. pot. 2800010 /4 wvial

Pre-dil. 1 24.2mg /B0 ml Pre-dil. 1 1 wial # B0 ml

Dozes (1| (21 ) (31 (41) (51| (B]] [71] (8] Dozes OF [ (2] ) (30| (40| [8)) (6] | [F]] [8)
51 162|164 | 38| 162 | 168 | 38| 170 1E8 T1 168 124 (362 | 25| 122 [ 368 | 164 | 14
52 184|394 (192|186 196 | 126 ( 190 125 T2 194 3192390 184|186 192 | 122 194
53 208 208 | 208|244 | 208 | 206 | 202 | 208 T3 204 40( 2065|204 | 2| 208 20| 208

Figure B.23: The residual error cannot be estimated with only 1 observation

per dose
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estimated from the observed data”. Indeed, you need at least 2 replicates
per dose in order to estimate the residual error from the observed data. The
residual error is needed for the validity checks in the analysis of variance
and the calculation of the confidence limits. However, let us suppose that
you know from historical data that the residual error is on average 20. In
this case, you might decide to substitute the estimated residual error by this
theoretical residual error. Open the options wizard and go to Variance. Se-
lect Theoretical variance, enter 20, and click on OK. Perform the calculations
and examine the analysis of variance and the width of the confidence limits.
Note that the theoretical variance has no degrees of freedom. In fact, it has
oo degrees of freedom. Note also that the confidence limits are much wider
than when all data were included. That makes sense: The more data you
have, the more precise the estimated potency will be.

There are two other ways to treat data with only one replicate per dose.
Open the options wizard and go to Variance. Try both of the other possi-
bilities. If you select deviations from model you can no longer do a validity
check. It can therefore only be used for assays that are strictly controlled,
and where no doubt about the validity exists. You will also notice that
the confidence limits are even wider than in the last example. This is be-
cause the residual error had to be estimated from very few observations.
If you select deviations from linearity you can check for non-parallelism, but
the confidence limits will again become wider. These options are therefore
only useful if you have a reasonable range of doses, say at least 6 doses per
preparation.

For assays described in monographs, you usually only need to specify
observed residuals and make sure that you include enough independent repli-
cates in the assay for a reliable estimate of the residual variance.
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Standard Sample 1

Origin Ph. Eur. CRS Manufacturer | Fantasy Pharm Ltd.

Batch number | Batch 1 Batch number | 34G56

Ags. pot. 103510 4 ma Agz. pot. 2800010 4 wial

Pre-dil. 1 24.2mg /B0 ml Pre-dil. 1 1 wial # B0 ol

Dozes @[ B[ 0E || E Dozes O3 [ (2 | (3 [ 40| (5| (B]] [F]] (8]
51 162 [ 164 [ 173 162 | 168 | 168 170 168 T1 168 [ 174 [ 162 | 175 172 168 164 | 174
52 324 (384 | 192|126 96| 86| 90| 485 T2 384 (382390 194 | 126 | J92 | dee | 104
53 208 [ 208 | 208 24 | 206 | 206 | 202 | 205 T3 204 [ 230 [ 208 | 204 | 2| 208 | 40| 206

Figure B.24: It is not possible to fit a line with only one dose per preparation.
Instead, a limit test is performed

Source of varigtion | Degrees of freedom | Sum of squares | Mean square F-ratio Probability
Freparations 1 18.0625 18.0625 0.707 0.415
Treatments 1 18.0625 18.0625 0.707 0.415
Fesidual eror 14 357 875 25,5625
Total 15 375.938 25.0625

Sample 1
Manufacturer | Fantazy Pharm Lid,
Limit tested 28047.01U / vial
Frobability 0157
All samples Standard Sample 1
Fh. Eur. CRS Fantazy Pharm Ltd
— *
| SE— —t *

Figure B.25: No significant difference between the preparations

3.9 Single dose model

Set the variance back to Observed residuals. Now exclude the middle and the
high doses as shown in figure B.24. Let CombiStats calculate this. Since you
have only one dose of each preparation, it is not possible to calculate parallel
lines. However, it is still possible to perform a limit test. A limit test allows
you to check if a sample contains significantly more than a specific potency.
Unfortunately, it is not possible to perform a limit test on designs that are
not completely randomised. For this example, however, we will assume that
the effect of the individual Petri dishes is negligible and that we can treat
the data as if they were obtained in a completely randomised design.

How should we interpret the output in figure B.257 The analysis of
variance shows that there is no significant difference (p = 0.415) between
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Source of vanation | Degrees of freedom | Sum of squares | Mean square F-ratio Probability
Preparations 1 2256.25 228625 124.508 0000 =
Treatments 1 2256.25 2256.25 124.608 0000 [
Residual errar 14 253.500 18.1071
Tatal 15 2809.75 167.317

Sample 1

b anufacturer | Fantasy Pharm Lid.
Limnit bested 16638.01U 4 vial

Probability 0.000 (==
Al zamples Standard Sample 1
Fh. Eur. CRS Fantasy Pharm Ltd

. .
—_— —_—
.

.
. .
. .

Figure B.26: A highly significant difference between the preparations

the preparations if the two-sided ¢-test is used. That would lead to the
conclusion that the potency of Sample 1 is not significantly different from
25047 TU / vial. The probability of 0.197 is obtained with another statis-
tical test often more powerful and therefore preferable (one-sided test of
Wilcoxon-Mann-Whitney). In this case, the conclusion of both tests is the
same, but, in particular cases, one test may be significant whereas the other
is not. The test must be chosen before running the assay. In general, the
Wilcoxon-Mann-Whitney test is preferred.

Now try to compare S1 with T2 in a limit test. This time you will find
a highly significant difference (see figure B.26). This means that Sample
1 induces a significantly higher response than the standard. Since higher
responses in the diffusion assay are related to higher potencies, we can con-
clude that Sample 1 contains significantly more than 16698 IU/vial. Be
careful with the interpretation: some types of assay give lower responses
with higher doses, leading to exactly the opposite conclusion. Knowledge
of the dose-response behaviour (positive or negative slope) is necessary to
draw the correct conclusion.
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SIS Version 7.0. Fiiday, 15 October 2021, 12:00:00 [+01:00 (BEESIES Version 7.01. Friday. 15 October 2021, 12:00:00 [+01:00 EEEST Version 7.0. Fiidey. 15 Ootober 2021, 12:00.00 [+(1:00

[Froject [Enthromyein | | [Project [Erthomyein | [ fProject | T

[ERE Assay |2 Assay |1

tandard ample 1 Standard Sample 1 Standard Sample 1

Ao, Pol | 9201U /m fss Fot [10001U / mg Ass. Pot. [ 92010/ mg Ass. Pot [ 100010/ mg Ass. Pol. | 92010 /ma Ass. Po 100010/ mg

Pre-dil. 1 |21 5ma/20ml Predil. 1 [26ma/ 25 ml Predi. 1 |21.1 mg / 20 ml Pre-dil 1 [265 mg / 25 ml Pre-dil. 1 |21.3 mg / 20 ml Pre-dil 1 | 264 mg /25 ml

Doses | 61 52 53| |[Doses | T1]72] T3 Doses | 6152 53| |Doser | T1]7T2] 73 Dases | 1] 52] 53| |Doses |T1[T2] 713
i) 199 ] 206 | 222 ] 185|207 | 21@ n 176 205 | 211 Il 188|192 | 218 Il 185 | 1592 | 210 ] 172) 201 | 214 |
@ 9| a07 |20 ENIEESES @ |17t 213] EEAEAER EREEEED [ENEEEHEH
] 190 ] 208 [ 222 [E]] 188 207 | 224 13) 184 | 200 [ 222 3 182 | 204 | 222 3 174 | 200 | 211 3] 185 [ 196 | 216
[ KEA T @ |190] 0] 222 [ERE KEE] O HEEED {4 | 175 198|216 (4) | 164|196 | 208
] 191 202 226 | ] 166 | 208 | 218 (5] 174198 [ 212 (5] 179|201 | 216 (5] 185 | 201 | 211 @] 175201 | 218
()| 184|215 227 B1 | 194] 208 228 6173|198 213 (6] |188] 138|215 (5] | 180 194] 211 (5] | 178|197 ] 214

Model y=[i] where =c.+biridose] Model: y={x] whers #=c. +b7lr{dose] Model: y={x) where x=c.+bin[dose)

Design: Randomised block Design: Randorised block Design Randomised block.

wieight function; w=1 \weight function: w=1 Weight funclion: w=1

Variance: Observed esidusks Variance: Observed residuals Variance: Observed residuals

Dilldion step (Increasingl: 1.5 Diltion step (Increasing): 1.5 Dilution step (Increasing]. 1.5

Sample 1 Sample 1 Sample 1

(IU/mgl Lower limit | Estimate | Upper limit [1Uma] Lower limit | Estimate | Upper limit (I0/mg) Lower limit | Estimate | Upper imi

Fotency | 888530 | 923102 | 958.767 Potsncy | 919.331 | 570.838 | 102605 Folency | 674648 | 935639 | 1003.23

Rel to s, 898.9% 92.3% 95.9% Rel todss 91.59% IR ES 102.6% Rel to Ass. B7.5% 937 100.3%

Rel Est | 95.3% | 1000% | 1039% ReltoEst | S47% | 1000% | 1057% FleltoEst | 934% | 1000% | 107.1%
Al samples Standard Samplz 1 Al samples Standard Sample 1 Al samples Standard Sample 1

Figure B.27: The 3 data sheets appear next to each other

3.10 Combination of assays

CombiStats came with more examples of different types of assays. These files
are automatically copied to the hard disk of your computer when installed.
Close all data sheets and open the three files with the names “Erythromycin
Assay x”7. As you will notice, they will appear in separate windows next to
each other (see figure B.27). Click on ™, &, and [T, and look what happens.
We will now try to combine the three assays into one single potency
estimate. To achieve this, click on . A summary of the three assays is
automatically generated and three types of combination are carried out:

o A weighted combination, which assumes homogeneous potency esti-
mates (homogeneity increases with the overlapping of confidence in-
tervals). Weights applied to individual estimates are then based on
intra-assay variations only.

e A semi-weighted combination used in case of heterogeneous potency es-
timates (reflected by lower overlapping of confidence intervals). Weights
applied to potency estimates are then based on intra-assay variations
and inter-assay variation.

e An unweighted combination, which consists in calculating a simple
mean and confidence interval (the quantile of the t-Student distribu-
tion is calculated for the number of assays minus one).
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Azsap | Sample | Info]|  Lower limit E stimate Upper limit | df
1 1 874.648 936.639 1003.23 |25
2 1 91939 o970 838 102608 25
3 1 858.590 923102 958.767 |25

Figure B.28: Double click on a result to exclude it from the combination

—e—
————
————

Figure B.29: The excluded result is shown with an empty dot

A test for homogeneity of the potency estimates is also performed. There
are no strict rules as to which of the three should be used, but the following
rule of thumb can be of use:

o If the p-value for homogeneity is more than 0.10, the potency estimates
are sufficiently homogeneous to use the weighted combination.

o Ifthe p-value is less than 0.10, the potency estimates tend to be hetero-
geneous and it would be better to use the semi-weighted combination.

e The unweighted combination should only be used if there are enough
assays, say, at least 6.

It is not possible to edit the combination sheet. It is automatically gener-
ated from the open data sheets. However, you can exclude assays from the
combination by double clicking on them. The assay will then still be visible,
but barred out (see figure B.28). The assay is also still presented in the
graphic, but with an empty dot (see figure B.29).You can hide a column by
moving the cursor over the right part of the cells of the first interval and
select Hide from the drop down box. In this example, the columns Sample
and Info appear pretty useless, so hide them. This way you can also filter
out samples that meet a certain criterion. To recover hidden columns, use
Edit> Unhide from the menu. You can sort the table by double clicking on
the top row of the column that you want to sort. Try to sort the assays
by increasing estimates by double clicking on Estimate. Restore the original
order by double clicking on Assay.

Click on B to save the combined potencies. The file extension for com-
bination sheets is *.epc. The printout should look like shown in figure B.30.

You have now seen most of the basics of CombiStats. More detailed
information on other features can be found in the online help and in the
user manual by clicking on ? or on the website clicking on @. All examples
included with CombiStats can be accessed by clicking on .
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[EESIEIS Version 7.0, Friday, 15 October 2021, 12:00:00 [+07:00). Page 1 of 1

Froject | Ergthromycin |F|emarks:

Agz, pot, 10000010 /mg

Azzay | Sample | Info | Lower limit E stimate Upper limit | df
1 1 a74.64a 936.639 100323 |25
2 1 919,331 970,838 1026.05 |25
3 1 288,590 923,102 958,767 | 25

Geometnc combination
Haomogeneity: p = 0.298

WWeighted combination Semi-weighted combination
[ /ma) Lawer limit | Estimate | Upper limit (1 /ma) Lawer limit | Estimate | Upper limit
Potency N2664 | 932014 | 964174 Potency 12465 | 938.014 | 964.279
Rel toAss. 91 3% 93 8% 96 4% Rel ta s 91 2% 93 8% 96 4%
Rel to Est q7.3% 100.0% 102.8% Rel to Est. 97 3% 100.0% 102.8%

|Jrweighted combination
[IU/ma) Lawer limit | Estimate | Upper limit
Patency 484 424 | 943314 | 100612
Fel toAss. a0 4% 94, 3% 100.6%
Rel to Est 93 8% 100.0% 106.7%

Figure B.30: A printout of the combination sheet
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cos, 59

cosine, 59

covariance matrix, 50, 62
cross-over designs, 17
cross-product, 62
curvature, 36

d, 56

data sheet, 25
decimal separator, 28
design, 17, 18, 152
design matrix, 50, 61

deviations from linearity, 22, 169

deviations from model, 21, 169
digital signatures, 68

dilution, 30

dilution notation, 163

dilution step, 19

division, 20

doses, 14, 18

e, b6

ED10, 16

ED30, 17

ED90, 16

EDxx determination, 16
effective dose (ED), 57
electronic signatures, 68
epm, 13, 26

equipotent, 165
equivalence testing, 24, 40, 64
estimable parameter, 63
examples, 71

excluded observations, 61
excluding assays, 173
excluding intervals, 42, 173
excluding observations, 31, 163
exp, 59

expected response, 55, 56
explicit notation, 18
exponentiation, 20
exporting data, 43
exporting matrices, 50
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INDEX

extended ANOVA, 23

Fieller’s theorem, 62

file name, 67

file size, 67

filter, 42

first derivative, 53, 55, 61
fixed intercept, 15, 17
fixed slope, 15, 17

flags of significance, 36
force percentages, 40, 42
frequency, 56

functions, 20, 58

general linear model, 62
generalized inverse, 62
generalized linear models, 53
geometric combination, 42
gmp, 59

gmpder, 59

gmpinv, 59

gompertz distribution, 59
gompit, 21, 59

graphics, 37, 159

group size, 56

h, 56

hash code, 67
hat-matrix, 50, 63

" 58

header, 27

help, 173

heterogeneity factor, 22

heterogeneous potency estimates, 172

hiding columns, 42, 173
historical data, 22, 37
homogeneity, 173

homogeneous potency estimates, 172

homoscedastic data, 55
hypothesis matrix, 63

i, 55, 56

implicitly assumed potency, 167
importing data, 43

information lines, 14, 27



INDEX

input files (*.epa), 44
internet address, 66
interpretation, 35
intersection, 37

inverse link-function, 53, 55
iteration, 56

iterations, 58, 61

keying errors, 37

labrary of templates, 26
lack of quadratic fit, 23, 36
Latin square, 18, 61

level of significance, 36
leverage, 38

lgt, 59

lgtder, 59

lgtinv, 59

library, 24, 25, 65, 155, 156
licence authorisation file, 65
limit test, 170

limit testing, 40

linear hypothesis, 62

linear predictor, 55, 56
linear predictors, 50, 61
linear structure matrix, 50
linearised observations, 50
linearised weights, 50
linearity, 36, 37

linearized responses, 61
link-function, 53, 55, 61
In, 59

log, 59

logarithm, 59

logistic distribution, 59
logit, 20, 59

logit analysis, 16

logo, 7

m, 56

mean response, 35, 161
menu bar, 8

meta-axis, 38

missing observations, 61

model, 15, 152

Hy 28
multiplication, 20
multiplication (non-linear), 53

n, 54, 56

natural logarithm, 59
natural mortality, 57

no ANOVA, 23

non-linear addition, 56
non-linear multiplication, 56
non-linear parameters, 56, 61
non-linear predictors, 50
non-linearised weights, 50
non-linearity, 36, 37
non-parallelism, 36

normal ANOVA, 23

normal distribution, 59
normit, 20, 60

notation of doses, 152, 163

observation vector, 61
observations, 31, 50
observed residuals, 21, 169
OMCL, 7

online help, 173

operators, 20, 58

options wizard, 13, 150
orientation, 14, 150
outliers, 37

output files (*.txt), 50

parallel lines, 15
parallelism, 36
parameter estimates, 50, 62
passwords, 65

PFU calculations, 17
phi, 59

phider, 59

phiinv, 60

pi, 20

7, 58

plaque forming units, 17
plate layout, 18

point of inflexion, 57
Poisson-distribution, 55
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potency estimate, 39 sin, 60
power-transformation, 53, 54 sine, 60

pre-dilutions, 14, 28 single dose assay, 15, 17, 23, 40
predicted observations, 50 single dose model, 170
predictors, 50 size, 13

preferences, 65 slope ratio, 16

printing, 11 slope-factor, 16

priority rules, 20, 58 sorting intervals, 42, 173
probit, 20, 60 Spearman-Kérber, 21
probit analysis, 16 sqrt, 60

protecting data, 43, 51 square root, 60

standardised residuals, 38, 50
stars of significance, 36

stock solutions, 14
studentised residuals, 38

quadratic curvature, 23, 36
quantal responses, 16
question mark, 28, 167

r. 54 subtraction, 20
r;ndomised blocks. 17. 61 symbolic notation, 18, 19, 163
raw g((ﬁ)Slduals, 38, 50 tan, 60
rec
’ t t, 60
recder, 60 angett

template, 10, 13, 24, 25, 149

test of homogeneity, 173
theoretical variance, 21, 22, 37, 169
Title 21 CFR Part 11, 68

toolbar, 8

transformation, 19, 36, 61, 152
transformation doses, 54
transformation responses, 54
tutorial, 149

recinv, 60

reconstitution volume, 28
rectangular, 21

rectangular distribution, 60
reduced ANOVA, 23
regression, 36

relative potency, 62
remarks, 32

replicates, 14, 30

residual error, 37 unbiased estimates, 55

residual plot, 38 unit conversion, 28

residual variance, 167 unknown potency, 167
RIPEMD-160, 67 unweighted combination, 41, 172

routine assays, 10, 37, 39
validity criteria, 36

s, b6 variance, 21, 152
sample related information, 14, 27 vertical location, 16
scaling by dose, 38 vertical scale, 16

scaling by notation, 38

scaling by x, 38

semi-weighted combination, 41, 172
sigmoid curves, 16 w, 62

signatures, 33 website, 66, 173
significance, 36 weight function, 53, 55, 62

volume, 29
volume unit notation, 163
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weighted combination, 41, 172

Wilcoxon-Mann-Whitney test, 23, 40,
171

wizard, 13

x, 55, 56
v, 20, 31, 54, 56

z, 20, 31, 54
zoom, 42
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